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AMMS TRAINING SCRIPT 

Add a line to a Oracle Sales Order 
  

 

 

Purpose 

The purpose of this training script is to show you how to add a line to an existing open 

sales order. 
 

The item that you want to be added to the sales order must be on the Price List.  Please 

follow adding items to Price List script for this step. 

 

Audience 

Material Coordinators and Supply Technician Team Leads 

 

 

 

Prepared By Theresa Coulson 

Creation Date: 01/11/2005 

Document Name Add a line to an Oracle Sales 
Order.doc 

Version 5 

Last Updated: 11/23/2008 

The most current version of this training script can be found at 
GSFC-FileSRVC\270Public\279 IT\Training\AMMS Customer Training 
Docs\Published\Order Management. 

     

Step Description:  Sign onto Oracle and select OM User AMMS responsibility 

 

Expected Results:  You will be at the OM User AMMS main menu 
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Step Description:  Open Order Returns > Order Organizer 

 

Expected Results:  You will be at the Find Orders window 
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Step Description:  Enter the sales order number that you want to add a line to, click on 

the Find button. 

 

Expected Results:  Order Organizer window will appear 
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Step Description:  Click on the Open button and open the sales order 

 

Expected Results:  Sales Order window will appear 
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Step Description:  Verify that the Sales Order information is correct, Customer Name, 

then click on the Line Item tab 

 

Expected Results:  Window view will change, Availability window will appear 
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Step Description:  Close the Availability window 

 

Expected Results:  Window will go away, you will be at the Line Items tab 
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Step Description:  Go to the last line on the sales order, hit your Down Arrow on your 

keyboard, and a blank line will appear. 

 

Expected Results:  A blank line will appear 
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Step Description:  In the Ordered Item field enter the stock number for the item that you 

want to add. 

 

Expected Results:  Field will be populated 
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Step Description:  Tab to the quantity field and enter the quantity 

 

Expected Results:  Field will be populated 
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Step Description:  Hit the Tab button. The price should default.  If you need to change the 

cost now is the time to do so.   

 

Expected Results:  Price field will be populated 
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Step Description:  Tab to the Request Date field, this field will already be populated with 

the original sales order date, click on the LOV and select the date that you are adding the 

sales order line 
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Expected Results:  Date will change 

 

 

 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Step Description:  Tab to the Scheduled Ship Date field and update this field with the 

date that the sales order line is being added. 

 

Expected Results:  Field will be populated with date 
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Step Description:  Use the scroll bar and move to the end of the Main tab.  Go to the field 

with [ ].  Click in this box.   

 

Expected Results:  Additional Line Attribute window will open 
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Step Description:  Click in the Object Class field and enter the CORRECT Object Class 

for the item.  The Object Class is determined by the first 2 digits of the item number.  See 

list provided.  Click Ok to the Additional Line Attribute Information window. 
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Expected Results:  You will return to the Sales Order window 

 

 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Step Description:  Move to the Pricing Tab, move to the Calculate Price Flag field and 

click on the List of Values and change to Freeze Price 

 

Expected Results:  Field will be updated 
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Step Description:  Save Your work 

 

Expected Results:  Transactions applied and saved message 
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Step Description:  Click on the Main tab at the Sales Order screen, use the scroll bar and 

move to see the Line Type and Status.  The Line Type should be DTO and the status 

should be Booked.  Once the order goes through “workflow” the status will change from 

Booked to Awaiting Receipt.   
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Expected Results:  Field will have data 

 

 
 

 

 

Step Description:  If a purchasing requisition is needed immediately contact Theresa 

Coulson.  As soon as Requisition Import runs you will have a requisition for this line on 

the sales order. 
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AMMS TRAINING SCRIPT 

ADDING ITEM TO PRICE LIST 
  

 

 

 

Purpose 

The purpose of this training script is to show users how to add new items to the Price 

Lists for Goddard and Wallops. 

 

Audience 

Material Coordinators and Supply Technician Leads 

 

 

 

Prepared By Theresa Coulson 

Creation Date: 11/09/2004 

Document Name Adding Items to Price Lists.doc 

Version x 

Last Updated: 11/23/2008 

The most current version of this training script can be found at 
GSFC-FileSRVC\270Public\279 IT\Training\AMMS Customer Training 
Docs\Published\Order Management. 
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Step Description:  Sign onto Oracle and select the OM User responsibility 

 

Expected Results/Actions:  The OM User main menu will appear 

 

Step Description:  Select Price Lists > Price Lists from the menu click on Open 

 

Expected Results/Actions:  A blank Price List will appear. 
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Step Description:  Query up the Price List hit the F11 button on your keyboard, then hold 

down the Ctrl button and hit F11 again to end the query. 

 

Expected Results/Actions:  The Goddard Price List will appear 
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Step Description:  At the bottom of the Goddard Price List, in the List Line section, click 

on an occupied line then click on the green plus sign (+) on the tool bar to add a  new 

line, make sure you are at the bottom of the screen. 

 

Expected Results/Actions:  A blank line will appear and the Item field will be yellow 
 

 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



Page: 26 of 1264  

 

 

Step Description:  In the Item field click on the LOV and select Item from the list, tab to 

the Product Attribute field and click on the LOV and select Item Number from the list.  In 

the Product Value field enter the Item number you just loaded. 

 

Expected Results/ Actions:  All fields will be populated 
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Step Description:  Tab over to the value field and enter the cost for the item.  Example:  

1.55 

 

Expected Results/ Actions:  Field will be populated with cost. 
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Step Description:  Save your work and close all forms,  Repeat the same process for the 

Wallops Price List. 

 

Expected Results/Actions:  Transactions Complete and Applies message at the bottom of 

screen, and will return to OM USER main menu. 

 

 

This stock number is now loaded and on the Price List.  

 

 

 

Notes:  Expense item are not Inventory items, they can not be transacted against like 

other item numbers.   

 

All Expense items must be added to both Price Lists.  The sales order can not be created 

until the items are on the price lists.   
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AMMS TRAINING SCRIPT 

Approval Hold on Item 
  

 

 

 

Purpose 

The purpose of this training script is to show how to process an approval hold on 
a specific line item. 

 

Audience 

Material Coordinator and Supply Technician Leads 

 

 

 

Prepared By Theresa Coulson 

Creation Date: 04/18/2006 

Document Name Approval Holds on Items.doc 

Version 2 

Last Updated: 11/23/2008 

The most current version of this training script can be found at 
GSFC-FileSRVC\270Public\279 IT\Training\AMMS Customer Training 
Docs\Published\Order Management. 
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This process is for Approval Hold on specific item number.  Currently in AMMS there are 2 Approval 

Hold Types, Furniture Approval, and Security Approval.  To add items to one of these hold types go to 

your Order Management Responsibility, go to the Order Organizer screen, with a blank screen, from the 

toolbar select Tools, Create Hold Source. 
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In the Hold Name field, click on the List of Values (LOV) and select the hold type that you are adding item 

to. 
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In the first Hold Criteria field , select Item from the drop down menu, then in the Criteria Value, enter the 

item number that you want the hold applied to.  Click on the Apply Holds button and this item has been 

applied for that hold. 
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To see what items are assigned to the Hold Type, go to your Order Organizer screen, go to the Hold 

Information Tab. 
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In the Hold Name field enter the name of the Hold that you want to see.  Then click on the Hold Sources 

button, this will show all items that are assigned to this hold. 
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This is the screen with all of the items that are on hold.  From this screen you can also, release a hold on an 

item number, make sure you are on the line with the item you want to release, then click on the Release 

button, you will have to select a reason for the release, and you can also put in comments.  You will get a 

message that tells you the update was successful. 
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To be able to see all the sales order that are on hold.  Go to your Order Organizer screen, go to the Hold 

Information Tab, in the Hold Name select your hold type, then click on the Find button, this will find any 

sales order for any items that are on hold for your hold type.   
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To be able to release a particular sales order from a hold, open the sales order, click on the Line Item tab 
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The status for all items on hold will be Booked.  You can see the item is on hold, just past the status field in 

the line is a check mark in the On Hold.   
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To remove a sales order from hold, select the line that you want removed, click on the Actions button, 

select Release Hold, click OK 
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Another screen will appear, you need to enter the reason for the removal of the hold, then click on the 

Release button.   
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You will get a message saying the hold has been released.   
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The status on the order still says Booked, you now need to send the sales order through Workflow. 
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Click on the Actions Button, select Progress Order, click OK. 
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A window will pop up that tells you that your order is Purchase Release Eligible.  Click OK.  If you some 

reason you don‟t get this message, please let Theresa know, there could be a problem. 
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The status now on the order is Awaiting Receipt.  Now the next time that Requisition Import run a 

purchasing requisition will generate to buy this material.   
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There is also a report that will be distributed daily with the Min Max, this will show every day any sales 

order that are on hold.  To run this report, in your Order Management responsibility select Reports, Run 

Reports, the name of the report is Outstanding Hold Report.  In the parameters window enter your Hold 

Type in the Hold name field, and in the Item display field click on the LOV and select Item and 

Description.  This will show all sales order that are on hold. 
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AMMS TRAINING SCRIPT 

Cancel Sales Order Line 
  

 

 

 

Purpose 

The purpose of this training script is to give instructions on how to cancel a sales order 

line, and check to make sure there is not an open Purchase Order, or Purchase 

Requisitions for the sales order line. 

 

Audience 

Material Coordinators and Supply Team Lead 

 

 

 

Prepared By Theresa Coulson 

Creation Date: 04/25/2006 

Document Name Cancel Sales Order Line.doc 

Version 2 

Last Updated: 11/23/2008 

The most current version of this training script can be found at 
GSFC-FileSRVC\270Public\279 IT\Training\AMMS Customer Training 
Docs\Published\Order Management. 
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AMMS Training Script:  This will give instructions on how to cancel a sales 

order line, and check to make sure there is not an open Purchase Order, or 

Purchase Requisitions for the sales order line. 

 

Note:  If you are cancelling a Sales Order and the Line Type is DTO but 

Requisitions have not yet generated, even if you cancel the sales order 

Oracle will still generate purchase requisitions for the lines cancelled. 

Be sure to also go back and  cancel all purchase requisitions  

 

 

 

Step Description:  Sign onto Oracle and select OM User AMMS 

responsibility 

 

Expected Results:  OM User AMMS main menu will appear 
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Step Description:  From the OM User AMMS main menu select Orders, 

Return > Order Organizer, click on the Open button 

 

Expected Results:  Find Orders window will appear 
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Step Description:  In the Order Number field enter the sales order number 

that you want to cancel a line on, click on the Find button 

 

Expected Results:  Field will be populated and Order Organizer window will 

appear 
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Step Description:  Click on the Open Order button 

 

Expected Results:  Sales Order window will appear 
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Step Description:  Click on the Line Items tab 

 

Expected Results:  Window view will change to Line Item information 
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Step Description:  Close the Availability window 

 

Expected Results:  Window will go away 
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Step Description:  Select the line that you want to cancel by clicking on the 

line and the purple line indicator will be next to the line selected 

 

Expected Results:  Line will be selected 
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Step Description:  Use the scroll bar at the bottom of the window, move to 

the right and look at the Line Type field 

 

Expected Results:  Window view will change 
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Step Description:  If the Line Type is “DTO Line Type GSF” or “DTO Line 

Type WFF‟  STOP!!   

 

When you want to cancel a sales order line that has a Line Type of DTO you 

MUST first check to make sure there is not an existing Purchase Order or 

Purchase Requisition associated with the sales order line. 

 

 
 

 

 

NOTE: EVEN IF THE LINE TYPE IS NOT DTO, IT IS POSSIBLE THAT 

ORACEL HAS GENERATED A REQUISITION TO BUY THIS 

MATERIAL.  IF THE STATUS IS “PICKED” THERE IS AN EXSISTING 

OPEN PICK SLIP FOR THIS ITEM AND THE SALES ORDER LINE 

CAN NOT BE CANCELLED UNTIL THE PICK SLIP IS 

BACKORDERED.   
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Step Description:  For GSF Line Type, you will need to go to Purchasing 

Requisition Summary and match the data and quantity to cancel the 

requisition. 
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Step Description:  For DTO Line Type: To check for an existing PO or 

Requisitions click on the Actions button at the bottom left of the window 

 

Expected Results:  Action window will appear 
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Step Description:  From the Action window select Additional Line 

Information, click OK 

 

Expected Results:  Additional Line Information window will appear 
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Step Description:  At the Additional Line Information window click on the 

Dropship tab 

 

Expected Results:  Window view will change 
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Step Description:  The data in the Dropship tab will tell you us there is a 

purchase requisitions, a purchase order or a blanket release associated with 

the sales order.   

 

Expected Results:  Data will appear 
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Step Description:  If there is an existing Purchase Order or Blanket Release 

associated the Sales order cannot be cancelled until the Material 

Coordinator and the Buyer have received confirmation from the 

supplier that the associated purchase order has been cancelled.  

Cancellation of a sales order without this confirmation must be 

approved by a Team Lead or Branch Head before the transaction is 

processed in AMMS.  If this item is on the JIT BPA, this must be 

coordinated through Kim Wedemeyer to cancel the shipment from Office 

Depot.  If this it is being purchased from GSA or DLA, cancellation must 

first be submitted through DAMES and confirmation of cancellation must be 

received from GSA or DLA before Sales Order can be cancelled. 
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Step Description:  Once the Material Coordinator has ensured that the sales 

order can be cancelled, close the Additional Line Information window 

 

Expected Results:  Return to Sales Order window 
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Step Description:  Make sure that you are on the line that you want to cancel 

by clicking on the item you want to cancel.   

 

Expected Results:  Purple indicator will be at the beginning of the line to be 

cancelled 
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Step Description:  Click on the Action button at the bottom left of the 

window 

 

Expected Results:  Action window will appear 
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Step Description:  Select from the options Cancel, click OK to the Actions 

window 

 

Expected Results:  Cancel Lines window will appear 
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Step Description:  At the Reason field click on the List of Values (LOV) and 

select the appropriate reason for the cancellation, also you can enter a brief 

description for the cancellation in the Comments window  

 

Expected Results:  Fields will be populated 
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Step Description:  Click OK to the Cancel Lines window 

 

Expected Results:  Note window will appear 
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Step Description:  The Note lets you know that there is an existing Purchase 

Requisition and Purchase Order that is associated with the sales order and 

they are in APPROVED status, click OK to the Note 

 

Expected Results:  Window will go away 
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Step Description:  Use the scroll bar and move to the right you will see the 

status on the line is now Cancelled. 

 

Expected Results: Data changed 

 

 
 

 

 

 

PLEASE BE SURE TO ALSO CANCEL PURCHASE ORDER AND 

PURCHASE REQUISITIONS ASSOCIATED WITH SALES ORDER. 
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AMMS TRAINING SCRIPT 

Cancel Sales Order 
  

 

 

 

Purpose 

The purpose of this training script is to give instructions on how to cancel a sales order, 

and check to make sure there is not an open Purchase Order, or Purchase Requisitions for 

the sales order line. 

 

Audience 

Material Coordinator and Supply Team Lead 

 

 

 

Prepared By Theresa Coulson 

Creation Date: 04/26/2006 

Document Name Cancel Sales Order.doc 

Version 2 

Last Updated: 11/23/2008 

The most current version of this training script can be found at 
GSFC-FileSRVC\270Public\279 IT\Training\AMMS Customer Training 
Docs\Published\Order Management. 
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AMMS Training Script:  This will give instructions on how to cancel a sales 

order, and check to make sure there is not an open Purchase Order, or 

Purchase Requisitions for the sales order line. 

 

YOU CAN ONLY CANCEL AN ENTIRE SALES ORDER IF NONE 

OF THE LINES ARE CLOSED.  ALL LINES ON THE SALES 

ORDER MUST BE OPEN TO CANCEL ENTIRE SALES ORDER. 

 

Note:  If you are cancelling a Sales Order and the Order Type is DTO 

but Requisitions have yet generated, even if you cancel the sales order 

Oracle will still generate purchase requisitions for the order/lines 

cancelled. Be sure to also go back and  cancel all purchase requisitions  
 

 

 

 



Page: 73 of 1264  

Step Description:  Sign onto Oracle and select OM User AMMS 

responsibility 

 

Expected Results:  OM User AMMS main menu will appear 
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Step Description:  From the OM User AMMS main menu select 

Orders, Return > Order Organizer, click on the Open button 

 

Expected Results:  Find Orders window will appear 
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Step Description:  In the Order Number field enter the sales order 

number that you want to cancel a line on, click on the Find button 

 

Expected Results:  Field will be populated and Order Organizer 

window will appear 
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Step Description:  Take note of the Status, you can not cancel a 

sales order that is Closed, the Status should be Booked.  Use the 

scroll bar and move to the right to the Order Type.  If the Order 

type is DTO, STOP!! 

 

When you want to cancel a sales order that is DTO you MUST 

first check to make sure there is not an existing Purchase Order or 

Purchase Requisition associated with the sales order line. 
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Step Description:  Click on the Open Order button 

 

Expected Results:  Sales Order window will appear 
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Step Description:  Click on the Line Items tab 

 

Expected Results:  Window view will change to Line Item 

information 
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Step Description:  Close the Availability window 

 

Expected Results:  Window will go away 
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Step Description:  Check every line that has a status of Awaiting 

Receipt that is to be cancelled by clicking on the line and the 

purple line indicator will be next to the line selected.  If  the status 

on the line is Awaiting Shipping you also need to check for an 

open Purchase order or Requisitions.  If the status is Picked or 

Partial Picked you there is an existing open pick slip for this 

material and the pick slip must be backordered before sales order 

can be cancelled 

 

Expected Results:  Line will be selected 
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Step Description:  To check for an existing PO or Requisitions 

click on the Actions button at the bottom left of the window 

 

Expected Results:  Action window will appear 
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Step Description:  From the Action window select Additional Line 

Information, click OK 

 

Expected Results:  Additional Line Information window will 

appear 
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Step Description:  At the Additional Line Information window 

click on the Dropship tab 

 

Expected Results:  Window view will change 
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Step Description:  The data in the Dropship tab will tell you us 

there is a purchase requisitions, a purchase order or a blanket 

release associated with the sales order.   

 

Expected Results:  Data will appear 
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Step Description:  If there is an existing Purchase Order or Blanket 

Release associated with the Sales order cannot be cancelled until 

the MC and the Buyer have received confirmation from the 

supplier that the associated purchase order has been 

cancelled.  Cancellation of a sales order without this 

confirmation must be approved by a Team Lead or Branch 

Head before the transaction is processed in AMMS. If this item 

is on the JIT BPA, this must be coordinated through Kim 

Wedemeyer to cancel the shipment from Office Depot.  If this it is 

being purchased from GSA or DLA, cancellation must first be 

submitted through DAMES and confirmation of cancellation must 

be received from GSA or DLA before Sales Order can be 

cancelled. 
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Step Description:  Once the Material Coordinator has ensured that 

the sales order can be cancelled, close the Additional Line 

Information window 

 

Expected Results:  Return to Sales Order window 
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Step Description:  Close the Sales Order window 

 

Expected Results:  Return to the Order Organizer window 
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Step Description:  Only if you want to/can cancel all of the lines on 

a sales order, click on the Action button 

 

Expected Results:  Action window will appear 
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Step Description:  From the Action window select Cancel, click 

OK to the Action window 

 

Expected Results:  Cancel Order window will appear 
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Step Description:  At the Reason field click on the List of Values 

(LOV) and select the appropriate reason for the cancellation, also 

you can enter a brief description for the cancellation in the 

Comments window  

 

Expected Results:  Fields will be populated 
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Step Description:  Click OK to the Cancel Order window 

 

Expected Results:  Note window will appear 
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Step Description:  Note window will tell you order has 

successfully been cancelled, click OK to the Note 

 

Expected Results:  Window will go away  
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Step Description: Re-Query order to see cancelled status 

 

 
 

 

 

 

 

 

 

PLEASE BE SURE TO ALSO CANCEL PURCHASE 

ORDER AND PURCHASE REQUISITIONS ASSOCIATED 

WITH SALES ORDER. 
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AMMS TRAINING SCRIPT 

CREATE EXPENSE SALES ORDER 
  

 

 

 

Purpose 

The purpose of this training script is to show users how to create a sales order for 
an “expense” item.  This will only charge the customer there are no inventory 
transactions to be updated. 

 

Audience 

Material Coordinators and Supply Technician Leads 

 

 

 

Prepared By Theresa Coulson 

Creation Date: 11/04/2004 

Document Name Create Expense Sales Orders.doc 

Version 5 

Last Updated: 11/23/2008 

The most current version of this training script can be found at 
GSFC-FileSRVC\270Public\279 IT\Training\AMMS Customer Training 
Docs\Published\Order Management. 
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Step Description:  Sign onto Oracle and Select the OM User responsibility.   

Expected Results/Action:  OM User Menu displayed 

 

Step Description:  Select Order Returns, Order Organizer and click on Open 

 

Expected Results/Action:  The Find Orders screen will appear 
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Step Description:  Either enter a sales order number  in the Order Number 

field or in the Customer Number field enter the unique customer number that 

is assigned to all WBS‟s.  Click on the Find Button 

 

Expected Results/Action:  A list of sales order for this Customer Number 

will appear 
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Step Description:  Select a sales order and click on the Open Button 

 

Expected Results/Action:  The sales order will open with all of the customer 

information 
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Step Description:  At the Order Information tab verify the customer name as 

the customer that you are entering the new sales order.  If this is not the 

correct customer information select a new sales order until you have the 

correct customer information, as there can be several ship to addresses for 

one WBS. 

 

Expected Results/Actions:  The correct customer will be displayed 

 

Step Description:  Click on the Action Button at the bottom left of the page 

 

Expected Results/Action:  A menu will appear of Actions to choose from 
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Step Description:  From the list of Actions select Copy and click OK 

 

Expected Results/Action:  A Copy window will appear 
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Step Description:  At the Quick Copy Tab make sure the Create New Order 

bubble is marked, click in the Change Order Type to Field and click on the 

List of Values (LOV) 

 

Expected Results/Actions:  A list of Order Types window will appear 
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Step Description:  Select the appropriate Bill Only (Expense) order type and 

click OK 

 

Expected Results/Actions:  You will return to the Copy window and go to 

the Copy Header Tab 
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Step Description:  Click on the Copy Line tab and under the Include field 

un-check the Lines. 

 

Expected Results/Actions:  All of the check marks will go away and become 

gray 

 

 

 

 

 

 

 

 

 

 



Page: 103 of 1264  

Step Description:  Click the OK on the Copy Window 

 

Expected Results/Actions:  A Process Message Window will appear 
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Step Description:  This window tells you the new Sales Order Number that 

has been assigned to your Bill only order, write down this number.  It will 

tell you that the order was created successfully, and it was unable to copy 

lines.  This is fine; we didn‟t want the lines copied.  Click on the Continue 

Button at the bottom left of the Process Message Window. 

 

Expected Results/Actions:  You go back to the original Order Information 

Screen 
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Step Description:  Click on the Flashlight on the toolbar to refresh your 

screen.   

 

Expected Results: The Find Order Screen will appear 
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Step Description:  Click on the Clear Button at the bottom left of your 

screen.  Enter the new Sales Order number that was created when you 

copied to the Bill Only type, click on the Find Button. 

Expected Results/Actions:  The order Organizer screen will appear 
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Step Description:  Click on the Open Button at the bottom right of the screen 

Expected Results/Actions:  The Sales Order will open at the Order 

Information Tab 
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Step Description:  Verify that this is the correct Bill Only Sales Order, verify 

all of the information.  Click in the Descriptive Flex Field at the bottom right 

of the window, [ ]. 

 

Expected Results/Actions:  Additional Header Information window will 

appear 
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Step Description:  In the Requested For field enter who the order is for.  You 

can also enter informatin in the WFF Workorder field and the Order Creator 

field.  Click OK 

 

Expected Results: Name will change in Order Creator, window will close 
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Step Description: Click on the Line Items Tab 

 

Expected Results:  Order Line Item Information will appear 
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Step Description:  Close the Availabilities Window 

 

Expected Results/Actions:  The Availabilities window will go away 
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Step Description:  In the Ordered Item Field enter the Item Number (stock 

number), tab to the Qty field, for Expense order we enter the cost as the qty, 

so if the cost is $10.11 the qty will be entered as 10.11, tab to the Unit 

Selling Price, this field will be 1.00.   

 

Expected Results:  All of the fields will have data 
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Step Description:  Use the Scroll bar at the bottom of the window and go all 

the way to the end of the Main Tab until you see [ ].  This is a Descriptive 

Flex Field (DFF), click in that gray blank field 

Expected Results/Actions:  The Additional Line Attribute Information 

window will appear 
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Step Description:  Select the Object Class field and click in there.  Enter the 

correct Object Class.  The first 2 numbers of the Item Number determine the 

Object Class.  If you are unsure of what the Object Class is please ask 

Theresa Coulson or Kathy Schultz.  Once you enter the object class click the 

OK Button 

  

Expected Results/Actions:  You will go back to the Line Items window at 

the Pricing Tab 
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Step Description:  Click on the Other tab, scroll to the right until you see the 

Customer Job field.  This is a free form field, enter the Project Name and the 

PO number 

 

Expected Results: Field will be populated 

 

 

 

 

 

 

 

 

 



Page: 116 of 1264  

Step Description:  Once you verify that all of the information is correct Save 

your work.  DO NOT BOOK THE ORDER 

 

Expected Results/Actions:  A Note will appear telling you Transactions 

Saved and Applied 
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Step Description:  The Order Status will remain Entered, until Accounting 

notifies you that the invoice is received. 

 

Expected Results:  Order status will be Entered. 
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Step Description:  When Accounting gets the invoice for the item you can 

make changes to the “cost”, then you MUST change the Date Ordered, to do 

this click in the Date Ordered field and either enter that days date or click on 

the LOV and select the date from the calendar.  Book the order.  If in the 

case of Furniture, where we are invoiced several times for the items and 

installation, you change the cost Book the order, then enter another Expense 

Sales Order for the cost difference.   

 

Expected Results:  Date Ordered will change and Order Status will change 

to Booked 
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Step Description:  Order is now complete. 
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AMMS TRAINING SCRIPT 

Processing a “Walk Thru” 
  

 

 

 

Purpose 

The purpose of this training script is to provide instructions to process a 
customers order that is Urgent 

 

Audience 

Material Coordinators and Supply Technician Leads 

 

 

 

Prepared By Theresa Coulson 

Creation Date: 04/07/2005 

Document Name EEE Urgent Order Process.doc 

Version 2 

Last Updated: 11/23/2008 

The most current version of this training script can be found at 
GSFC-FileSRVC\270Public\279 IT\Training\AMMS Customer Training 
Docs\Published\Order Management. 
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Step Description:  Sign onto Oracle and select the IM Inventory AMMS Responsibility 

 

Expected Results/Actions:  The IM Inventory Main Menu will appear 

 

 

 

Step Description:  Select On Hand Availability > On Hand Quantities, and select the 

appropriate Organization (GSF or WFF) 

 

Expected Results:  The Query Material form will appear 
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Step Description:  Enter the Item Number (stock number ) in the Item / Revision field and 

click on the Find Button. 

 

Expected Results/Actions:  The field is populated and the Material Workbench form 

opens   
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Step Description:  Click on the Availability Button at the bottom right of the screen 

 

Expected Results:  The Availability Window will appear 
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Step Description:  Look at the Availability Window this will tell you how many you have 

On Hand, Available to Reserve, and Available to Transact.   

 

Expected Results/Actions:  You are verifying that the qty that is needed by the customer 

is available 
 

 
 

 

 

If you have qty available you can continue and process the Walk Thu. 

 

 

Step Description:  Close all windows and change responsibilities to AMMS Order Entry 

 

Expected Results/Actions:  The AMMS Order Entry main menu will appear 
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Step Description:  From the AMMS Order Entry main menu select Orders and click on 

the Open button 

 

Expected Results/Actions:  The AMMS Order Entry Screen will appear 
 

 
 

 

 

 

 

 

 

 

 

 

 

 

Step Description:  Enter the customer WBS/JON information, follow all steps for 

entering the customers order and save the transactions. 



Page: 126 of 1264  

 

Expected Results/Actions:  You will receive an OE Save Alert with your Order Number, 

write this order number on the walk thru paperwork, you will needed if for future 

reference. 
 

 
 

 

Once you have saved the order contact Theresa Coulson, Order Import 

needs to be run, and NO ONE other than a system person should run 

this job.  Theresa Coulson will run Order Import and tell you when it 

has completed.   
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Step Description:  Once Order Import has completed change responsibilities to EEE OM 

User AMMS, this is the responsibility to use ONLY when processing a Urgent Order for 

Project Parts   

 

Expected Results/Actions:  The OM User AMMS main menu will appear 
 

 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Step Description:  Open up Order Returns > Order Organizer 
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Expected Results/Actions:  The Find Orders screen will appear 
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Step Description:  In the Customer PO field enter the Order Number that you received 

when you saved entering the customers order, click on the Find button. 

 

Expected Results/Actions:  The Order Organizer screen will appear 
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Step Description:  Write Down the Order Number you will need this for future 

transactions.  Click on the Lines Tab at the bottom of the screen and see if the order 

status is Awaiting Shipping, this means that the order is ready to be pick released. 

 

Expected Results/Actions:  You will see a screen with the order number, the item number 

the item status, and the qty.  This tells you that your order is ready for pick release. 

 

IF THE STATUS IS ANYTHING OTHER THAN AWAITING SHIPPING, CONTACT 

THERESA COULSON ASAP! 
 

 
 

 

 

 

 

Close all forms and return to the EEE OM User AMMS main menu. 
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Step Description:  From the EEE OM User AMMMS main menu, select Shipping > Pick 

Release. 

 

Expected Results/Actions:  The Release Sales Order for Picking screen will appear. 
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Step Description:  In the Based on Rules field click on the List of Values (LOV) and 

select the appropriate release (GSFC for Goddard and WFF for Wallops), click on and 

the field will be populated 

 

Expected Results/Actions:   Document Set field and Based on Rules fields are populated. 
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Step Description:  Go to the Order Number field and enter the Sales Order Number, 

THIS MUST BE ENTERED BEFORE CONTINUEING ON.  Once the Sales Order 

Number is entered click on the Concurrent button 

 

Expected Results/Actions:  The field is populated, you get a Batch number and a NOTE 

with the Concurrent Request ID information   
 

 
 

 

 

Click OK to the NOTE.  You have completed the pick release process.  You will now 

need to make sure the concurrent job processes to print the pick slip on the printer in the 

Fastener room. 
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Step Description:  From the Oracle Tool Bar select View and then select Requests. 

 

Expected Results:  The Find Request window will open 
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Step Description:  Click FIND to see all requests that you have submitted. 

 

Expected Results/Actions:  The Request screen will appear 
 

 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



Page: 136 of 1264  

 

 

 

 

 

Step Description:  You are looking for 2 concurrent jobs to complete, Pick Selection List 

Generation and AMMS Pick Slip Report.  The Pick Selection List Generation will 

complete first then the AMMS Pick Slip Report will run.   

 

Expected Results/Actions:  All jobs will say Completed Normal 
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Step Description:  Once the AMMS Pick Slip Report has completed click on the View 

Output button to see the output from the report.  This will let you see if a pick slip 

generated.   

 

Expected Results/Actions:  The AMMS Pick Slip Report will appear 
 

 
 

 

If  for some reason there is NO DATA found contact your Lead to trouble shoot the 

process.  If needed contact Theresa Coulson also. 

 

If all is well. Contact the Fastener warehousemen and advise of order to be pulled from 

locator.   

 

 

Process is Complete.   
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Notes: 

 

Walk Thru can be processed for partial qty‟s, just follow the same directions, the order 

will only pick release for the qty that is available.  The remaining qty will go on 

backorder, alert the appropriate Supply Team of the backorder so that they can get 

material procured. 
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AMMS TRAINING SCRIPT 

Expense Sales Order Credit Only 
  

 

 

 

Purpose 

The purpose of this training script is to show users though giving credit for an 
expense only sales order. 

 

Audience 

Buyers 

 

 

 

Prepared By Theresa Coulson 

Creation Date: 05/24/2005 

Document Name Expense Sales Order Credit.doc 

Version 2 

Last Updated: 11/23/2008 

The most current version of this training script can be found at 
GSFC-FileSRVC\270Public\279 IT\Training\AMMS Customer Training 
Docs\Published\Order Management. 
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Step Description:  Sign onto Oracle and select the OM User responsibility 

 

Expected Results:  OM User main menu will appear 
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Step Description:  From the OM User main menu select Orders, Returns > Order 

Organizer click on the Open button 

 

Expected Results:  Find Order Screen will appear 
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Step Description:  Enter the original sales order that credit is needed against in the Order 

Number field click on the Find button 

 

Expected Results:  Order Organizer window will appear 
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Step Description:  Click on the Open button 

 

Expected Results:  Sales Order information window will appear 
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Step Description:  Verify that all of the customer information is correct, click on the Line 

Items Tab 

 

Expected Results:  Window view will change 
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Step Description:  Close the Availability window 

 

Expected Results:  Window will go away 
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Step Description:  Select the line that you want to give credit to, this click on the Action 

Button at the bottom left of the screen 

 

Expected Results:  Actions window will appear 
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Step Description:  From the Actions window select Copy, click Ok 

 

Expected Results:  Copy window will appear 
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Step Description:  In the Copy window at the Quick Copy tab select Create New Order, 

then click in the field and click on the LOV and select GSF RMA CREDIT ONLY.  Then 

in the Get Order Level Information from field, enter the original sales order number, this 

MUST be done, or credit will not process through.   Go to the Copy Lines tab. 

 

Expected Results:  Quick Copy tab will have information, and window view will change 
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Step Description:  In the Return Reason field click on the LOV and select the best reason 

that applies to the return. 

 

Expected Results:  Field will be populated 

 

 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



Page: 150 of 1264  

Step Description:  Still in the Copy window click on the OK button 

 

Expected Results:  Process Message window will appear 
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Step Description:  Write down the new GSF RMA Credit Only order number for your 

records, then click on the continue button 

 

Expected Results:  Process Message window will go away 
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Step Description:  From the Tool bar use the flashlight to refresh your screen 

 

Expected Results:  Find Orders window will appear 
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Step Description:  In the Order Number field enter the new GSF RMA Credit Only order 

number and click on the Find button 

 

Expected Results:  Order Organizer window will appear 
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Step Description:  Click on the Open Button 

 

Expected Results:  Sales Order window will appear 
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Step Description:  Verify all of the information, click on the Line Items tab 

 

Expected Results:  Window view will change 
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Step Description:  You will now see the line information, and notice that the qty is a light 

purple color this indicated that this is a credit.  Use the scroll bar and move all the way to 

the end of the Main tab until you see a field with [ ] click in this field. 

 

Expected Results:  Additional Line Attribute Information window will appear 
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Step Description:  In the Object Class field enter the appropriate Object Class for the 

item, see attached list, click OK 

 

Expected Results:  Field will be populated and window will close 
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Step Description:  At the Pricing Tab, scroll to the Calculate Price Field, change this field 

to Freeze Price, Save your work 

 

Expected Results:  Field view will change, Transactions Saved and Applied message 
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Step Description:  Go back to the Main tab and verify the cost that you are giving credit 

for, you can only credit the amount that was originally charged.  If the credit price is 

different click in the Unit Selling Price field and change the cost.  Save your work 

 

Expected Results:  Transactions Saved and Applied message 
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Step Description:  Click on the Book Order button at the bottom right of the window 

 

Expected Results:  Note window will appear 
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Step Description:  Click OK to the Note 

 

Expected Results:  Return to the Sales Order information window, status now Booked 
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Step Description:  Order now Booked 

 

 
 

 

 

 

 

Notes:  You can only give credit to an order that is closed.  You can only credit up to 

the original amount charged, and original qty charged.   
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AMMS TRAINING SCRIPT 

Review Oracle Sales Orders 
  

 

 

 

Purpose 

The purpose of this training script is to show how to look up status on Oracle 
sales orders. 

 

Audience 

Material Coordinators and Supply Technicians 

 

 

 

Prepared By Theresa Coulson 

Creation Date: 01/05/2004 

Document Name Inquiry on Oracle Sales Orders.doc 

Version 2 

Last Updated: 11/23/2008 

The most current version of this training script can be found at 
GSFC-FileSRVC\270Public\279 IT\Training\AMMS Customer Training 
Docs\Published\Order Management. 
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Step Description:  Sign onto Oracle and select the OM User AMMS responsibility 

 

Expected Results:  The OM User AMMS main menu will appear 
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Step Description:  Select Order Returns > Order Organizer and click on the Open button. 

 

Expected Results:  The Find Orders window will appear 
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Step Description:  If you know the sales order number enter that in the Order Number 

field.  If you know the Customer PO number enter that in the Customer PO field.  If you 

only know the stock number click on the Line Information tab and enter the stock number 

in the Internal Item field.  Click on the Find button. 

 

Expected Results:  The Order Organizer window will appear. 
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Step Description:  Select the order number that you want to look at and click on the Open 

Order button 

 

Expected Results:  The Sales Order window will appear 
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Step Description:  The Sales Order window tell you who placed the order what the order 

type is what the status of the order is.  To view specific line items on the order click on 

the Line Items tab. 

 

Expected Results:  You will be at the Line Items window with the Availability window 

open 
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Step Description:  Close the Availabilities window 

 

Expected Results:  You will be at the Line Items tab 
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Step Description:  Use the scroll bar and you will see detailed information about each 

line.  You will see the quantity, unit of measure, price and status.  Lines with a status of 

Awaiting Receipt have a purchase requisition associated.   

 

Expected Results:  You will see all available information 
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Step Description:  For items with status of Awaiting Receipt to see the associated 

purchasing information click on the Actions button at the bottom left of the screen. 

 

Expected Results:  A list of Action will appear 
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Step Description:  Select Additional Line Information from the list and click OK 

 

Expected Results:  The Additional Lines Information window will appear 
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Step Description:  Click on the Dropship tab 

 

Expected Results:  The Dropship tab will appear 
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Step Description:  The Dropship tab will give you multiple information.  In the 

Document Type it will tell you if it is a Purchasing Requisition, a Purchase Order, or a 

Blanket Release.   
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Step Description:  The Number field will tell you the Purchasing Requisition number, the 

Purchase Order Number or the BPA Number.   
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Step Description:  If the type is BPA you will see the Release number.  You will also see 

the Supplier, the status of the PO and who the Buyer is. 
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Notes: 

 

Here are the statuses that you may see of sales order lines and there meanings: 

 

Awaiting Shipping- there is stock in the warehouse and the item will be picked and 

shipped 

 

Awaiting Receipt- this is a DTO order and there is a purchasing requisition or purchase 

order associated 

 

Picked:  Pick slip has generated in the warehouse for material to be pulled 

 

Partial Pick:  Pick slip for partial qty has generated in the warehouse for material to be 

pulled 

 

Cancelled: Sales Order line has been cancelled 

 

Closed:  Sales order line has been closed, material shipped to customer 
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AMMS TRAINING SCRIPT 

Processing a “Walk Thru” 
  

 

 

 

Purpose 

The purpose of this training script is to provide instruction to process a customer 
who wants to “walk thru” material to take with them 

 

Audience 

Material Coordinators and Supply Technician Leads 

 

 

 

Prepared By Theresa Coulson 

Creation Date: 11/15/2004 

Document Name Processing a Walk Thru.doc 

Version 2 

Last Updated: 11/23/2008 

The most current version of this training script can be found at 
GSFC-FileSRVC\270Public\279 IT\Training\AMMS Customer Training 
Docs\Published\Order Management. 
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Step Description:  Sign onto Oracle and select the IM Inventory Responsibility 

 

Expected Results/Actions:  The IM Inventory Main Menu will appear 

 

 

 

Step Description:  Select On Hand Availability > On Hand Quantities, and select the 

appropriate Organization (GSF or WFF) 

 

Expected Results:  The Query Material form will appear 
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Step Description:  Enter the Item Number (stock number ) in the Item / Revision field and 

click on the Find Button. 

 

Expected Results/Actions:  The field is populated and the Material Workbench form 

opens.   
 

 
 

 

 

You are checking to make sure that there is stock on hand before processing the Walk 

Thru.   
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Step Description:  Click on the Availability Button at the bottom right of the screen 

 

Expected Results:  The Availability Window will appear. 
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Step Description:  Look at the Availability Window this will tell you how many you have 

On Hand, Available to Reserve, and Available to Transact.   

 

Expected Results/Actions:  You are verifying that the qty that is needed by the customer 

is available. 
 

 
 

 

 

If you have qty available you can continue and process the Walk Thu. 

 

 

Step Description:  Close all windows and change responsibilities to AMMS Order Entry 

 

Expected Results/Actions:  The AMMS Order Entry main menu will appear. 
 

 

 

 

 



Page: 183 of 1264  

 

 

 

 

 

 

 

 

 

Step Description:  From the AMMS Order Entry main menu select Orders and click on 

the Open button 

 

Expected Results/Actions:  The AMMS Order Entry Screen will appear. 
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Step Description:  Enter the customer WBS/JON information, follow all steps for 

entering the customers order and save the transactions. 

 

Expected Results/Actions:  You will receive an OE Save Alert with your Order Number, 

write this order number on the walk thru paperwork, you will needed if for future 

reference. 
 

 
 

 

Once you have saved the order contact Theresa Coulson, Order Import 

needs to be run, and NO ONE other than a system person should run 

this job.  Theresa Coulson will run Order Import and tell you when it 

has completed.   
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Step Description:  Once Order Import has completed change responsibilities to IM Order 

Mgmt- AMMS, this is the responsibility to use ONLY when processing a walk thru.   

 

Expected Results/Actions:  The IM Order Mgmt-AMMS main menu will appear. 
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Step Description:  Open up Order Returns > Order Organizer 

 

Expected Results/Actions:  The Find Orders screen will appear. 
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Step Description:  In the Customer PO field enter the Order Number that you received 

when you saved entering the customers order, click on the Find button. 

 

Expected Results/Actions:  The Order Organizer screen will appear 
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Step Description:  Write Down the Order Number you will need this for future 

transactions.  Click on the Lines Tab at the bottom of the screen and see if the order 

status is Awaiting Shipping, this means that the order is ready to be pick released. 

 

Expected Results/Actions:  You will see a screen with the order number, the item number 

the item status, and the qty.  This tells you that your walk thru order is ready for pick 

release. 

 

IF THE STATUS IS ANYTHING OTHER THAN AWAITING SHIPPING, CONTACT 

THERESA COULSON ASAP! 
 

 
 

 

 

 

 

Close all forms and return to the IM Order Mgmt-AMMS main menu. 
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Step Description:  From the IM Order Mgmt-AMMS main menu, select Shipping > Pick 

Release. 

 

Expected Results/Actions:  The Release Sales Order for Picking screen will appear. 
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Step Description:  In the Based on Rules field click on the List of Values (LOV) and 

select the appropriate release (GSFC for Goddard and WFF for Wallops), click on and 

the field will be populated 

 

Expected Results/Actions:   Document Set field and Based on Rules fields are populated. 
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Step Description:  Go to the Order Number field and enter the Sales Order Number, THIS 

MUST BE ENTERED BEFORE CONTINUEING ON.  Once the Sales Order Number is 

entered click on the Concurrent button 

 

Expected Results/Actions:  The field is populated, you get a Batch number and a NOTE 

with the Concurrent Request ID information.   
 

 
 

 

 

Click OK to the NOTE.  You have completed the Walk Thru process.  You will now 

need to make sure the concurrent job processes to print the pick slip on the printer in the 

upperwarehouse. 
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Step Description:  From the Oracle Tool Bar select View and then select Requests. 

 

Expected Results:  The Find Request window will open 
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Step Description:  Click FIND to see all requests that you have submitted. 

 

Expected Results/Actions:  The Request screen will appear. 
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Step Description:  You are looking for 2 concurrent jobs to complete, Pick Selection List 

Generation and AMMS Pick Slip Report.  The Pick Selection List Generation will 

complete first then the AMMS Pick Slip Report will run.   

 

Expected Results/Actions:  All jobs will say Completed Normal 
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Step Description:  Once the AMMS Pick Slip Report has completed click on the View 

Output button to see the output from the report.  This will let you see if a pick slip 

generated.   

 

Expected Results/Actions:  The AMMS Pick Slip Report will appear. 
 

 
 

 

If  for some reason there is NO DATA found contact your Lead to trouble shoot the 

process.  If needed contact Theresa Coulson also. 

 

If all is well. Send the customer to the upperwarehouse for pick up of material.  You 

should alert the upperwarehouse of the customer coming up to make sure the customer 

received quick service. 

 

 

Process is Complete.   
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Notes: 

 

Walk Thru can be processed for partial qty‟s, just follow the same directions, the order 

will only pick release for the qty that is available.  The remaining qty will go on 

backorder, alert the appropriate Supply Team of the backorder so that they can get 

material procured. 
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AMMS TRAINING SCRIPT 

Query on Price List 
  

 

 

 

Purpose 

The purpose of this training script is to will provide instruction on how to query 
on the Price List to see if an item already exists on the Price List 

 

Audience 

Material Coordinators and Supply Technician Leads 

 

 

 

Prepared By Theresa Coulson 

Creation Date: 11/17/2004 

Document Name Query on Price List.doc 

Version 2 

Last Updated: 11/23/2008 

The most current version of this training script can be found at 
GSFC-FileSRVC\270Public\279 IT\Training\AMMS Customer Training 
Docs\Published\Order Management. 
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Step Description:  Sign onto Oracle  and Select OM User responsibility. 

 

Expected Results/Actions:  The OM User main menu will appear. 
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Step Description:  Select from the main menu Price Lists > Price Lists and click on the 

Open button. 

 

Expected Results/Actions:  A blank Price List will appear. 
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Step Description:  Query up the existing Price Lists, on your keyboard press the F11 

button. 

 

Expected Results/Actions:  This will send the Price List screen into a query mode and 

turn all fields blue.   
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Step Description:  End the query by holding down the Ctrl button and pressing the F11 

button again. 

 

Expected Results/Actions:  The Goddard Price List will appear 
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Step Description:  At the bottom of the Goddard Price List screen place your cursor in the 

Product Value field,  and again send the Goddard Price List into a query mode by 

pressing down the F11 button 

 

Expected Results/Actions:  All of the items will disappear from the List Lines tab 

 

 
 

 

YOU MUST CLICK IN THE PRODUCT VALUE FIELD BEFORE 

YOU START YOUR QUERY. 
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Step Description:  In the Product Value field enter the item number (stock number) 

 

Expected Results/Actions:  Field will be populated 
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Step Description:  End the query again by holding down the Ctrl button and pressing the 

F11 button 

 

Step Description:  If the item exists already on the price list the information will be 

populated 

 

 
 

 

 

HOWEVER………………………. 
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Step Description:  End the query by holding down the Ctrl button and pressing the F11 

button 

 

Expected Results/Actions:  NO DATA is returned, and you receive a message at the 

bottom of the screen Query caused no records to be retrieved.  This means the item is 

NOT on the Price List and can be added.   

 

 
 

 

 

 

Process completed. 

 

 

 

 

 

 

 

Notes:  To add items that are not on the Price List, see AMMS Training Script, Adding 

Items to Price Lists. 
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AMMS TRAINING SCRIPT 

Requested For Field 
Copy Order 

  

 

 

 

Purpose 

The purpose of this training script is to sho how to copy an order 

 

Audience 

Name1, name2, name3 

 

 

 

Prepared By Theresa Coulson 

Creation Date: 12/3/2007 

Document Name Requested For Field Copy Order.doc 

Version 2 

Last Updated: 11/23/2008 

The most current version of this training script can be found at 
GSFC-FileSRVC\270Public\279 IT\Training\AMMS Customer Training 
Docs\Published\Order Management. 
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AMMS PURCHASING 

TRAINING SCRIPTS 
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AMMS TRAINING SCRIPT 

Project Parts Create an Attachment to 
a Purchase Order 

  

 

Purpose 

The purpose of this training script is to show Buyers how to create an attachment to a 

Purchase Order.  Attachments are added after any change to a purchase order. 

 

Audience 

Buyers 

 

 

 

Prepared By Theresa Coulson 

Creation Date: 04/26/2005 

Document Name Adding Attachment to PO.doc 

Version 4 

Last Updated: 11/23/2008 

The most current version of this training script can be found at 
GSFC-FileSRVC\270Public\279 IT\Training\AMMS Customer Training 
Docs\Published\Purchasing. 
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Step Description:  Sign onto Oracle and select Purchasing AMMS 

responsibility 

 

Expected Results:  Purchasing AMMS main menu will appear 
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Step Description:  From the Purchasing AMMS main menu select Purchase 

Order > Purchase Order Summary click Open 

 

Expected Results:  The Find Purchase Order window will appear 
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Step Description:  Enter the PO number you want to create the attachment 

for, click on the Find button 

 

Expected Results:  Purchase Orders Header window will appear 
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Step Description:  Click on the Open Button to Open the Purchase Order 

 

Expected Results:  Purchase Order Summary to Purchase Order window will 

appear 
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NOTE: TO PUT ATTACHMENT AT THE HEADER LEVEL CLICK IN A 

FIELD AT THE TOP OF THE FORM.  TO PUT AN ATTACHMENT AT 

THE LINE LEVEL CLICK ON A LINE ON THE PURCHASE ORDER. 

 

Step Description:  From the Tool Bar select the icon that looks like a Paper 

clip 

 

Expected Results: Attachments window will appear 

 

 
 

 

 

 

 

 

 

 

 

 

 



Page: 218 of 1264  

Step Description:  If you are using an Attachment format click on the 

Document Catalog button at the bottom right of the window 

 

Expected Results:  Document Catalog window will appear 
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Step Description:  At the Document Catalog window, in the Description 

field enter part of the attachment name, example %TENN%, click on the 

Find button 

 

Expected Results:  Attachment will appear at bottom of window 
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Step Description:  Select the attachment, by clicking in the field, then click 

on the Attach 1 button 

 

Expected Results:  Attachment will be added to PO 
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Step Description:  To add multiple attachments to a PO click in the next line 

in the Attachment window 

 

Expected Results:  Field will be ready to populate 
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Step Description:  If you are typing an attachment, click on the Category 

field click on the LOV and in the Find window enter a % sign and a list of 

choices will appear, select the appropriate category.  To Supplier is the one 

to be used.   

 

Expected Results:  Field will be populated 
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Step Description:  In the Data Type field click on the LOV and select Short 

Text, this will allow you to type more information 

 

Expected Results:  Field will be populated 
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Step Description:  Notice the bottom field is yellow start typing you required 

information 

 

Expected Results:  Field will be populated 
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Step Description:  Follow this format for putting attachments on purchase 

orders.  Please note: changes to purchase orders are not to be put in 

attachments, they are to be put in the Note to Supplier field: 

 

1.  Change information to supplier, if applicable – address in the Notes to 

Supplier use this field for changes to PO only.    

 

Change 2, April 10, 2006 (list the change number to the supplier 

along with the date, do not abbreviate) 

 

Added Line 12, PN 788978 

Deleted Line 3, PN 245895  

Added Line 16, Pre-cap Inspection, PN 78985  

Increased Quantity on Line 4, PN 898574, from 10 each to 15 

each. 

Decreased Quantity on Line 6, PN4568, from 12 each to 9 each 

 

2.  Buyer Contact Information 

 

3.  Notes 

 

4.  Verification of Services 

 

5. Quote Reference Information 

 

6. Quality Assurance and Shipping  information (ie:see below) 

 

Single Date Lot Code Required 

 

Manufacturer‟s C of C Required 

 

Special Packaging Requirements 

 

Chemical and Physical Analysis Required 

 

Multiple date codes acceptable (if non flight and customer has 

indicated such) 

 

Pre-cap Inspection information (ie:  Pre-Cap Source Inspection 

appplicable to Line 3 also any Technical POC give, name, and 
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telephone number along with verification information, if 

applicable) 

 

Other testing/data requirements information. (ie: Lot Charge 

and Screening and Group A Test Data applicable to Line 4) 

 

7.    Physical, Chemical & Proof Test Required ( IF Applicable).  

 

 

 

 

 

 

 

 

 

Attachments are to be put on the Purchase Orders in this order.  Again any 

changes to purchase order there is NOT to be an Attachment, use the Note to 

Supplier field, see the Project Parts Change Established Purchase Order 

script. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



Page: 227 of 1264  

Step Description:  Once you have entered all required information click on 

the Save button 

 

Expected Results:  Transaction Saved and Applied message 
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Step Description:  Close the Attachment window. 

 

Expected Results:  Attached added to PO, will return to Purchase Order to 

Purchase Order Summary window. 
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Step Description:  Close all forms Transaction Complete. 

 

 

 

 

NOTE:  If you want to put an Attachement on the PO Header click in one of 

the fields at the top of the Purchase Order Summary to Purchase Order 

window.  If you want to put an Attachment at the line level for a specific 

item, click on the specific item, and then create the attachment. 
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AMMS TRAINING SCRIPT 

Approving Purchase Order 
  

 

 

 

Purpose 

The purpose of this training script is to show how to approve a purchase order 

 

Audience 

Purchasing Managers 

 

 

 

Prepared By Theresa Coulson 

Creation Date: 11/16/2006 

Document Name Approve Purchase Order.doc 

Version 2 

Last Updated: 11/23/2008 

The most current version of this training script can be found at 
GSFC-FileSRVC\270Public\279 IT\Training\AMMS Customer Training 
Docs\Published\Purchasing. 
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Step Description:  Sign onto Oracle and select Purchasing Super User 

responsibility 

 

Expected Results:  Purchasing Super User main menu will appear 
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Step Description:  From the Purchasing Super User main menu select 

Purchase Orders > Purchase Order Summary click on the Open button 

 

Expected Results:  Find Purchase Orders window will appear 
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Step Description:  In the Number field enter the Purchase Order that needs to 

be approved, click on the Find button 

 

Expected Results:  Purchase Order Header window will appear 
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Step Description:  Click on the Open button at the bottom right of the 

Purchase Order Header window 

 

Expected Results:  Purchase Order Summary to Purchase Order window will 

open 
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Step Description:  Click the Approve button at the bottom right of the 

window 

 

Expected Results:  Approval Document window will appear 

 

 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



Page: 236 of 1264  

Step Description:  Remove the check mark in the Email field, then click OK 

 

Expected Results:  Note window will appear 
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Step Description:  Note window indicated PO has been approved, click OK 

to Note window 

 

Expected Results:  Status on PO changes  
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Results:  PO status is now approved 
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AMMS TRAINING SCRIPT 

Manage Buyer Workload 
  

 

 

 

Purpose 

The purpose of this training script is to show how to assign requisitions to a 
specific buyer 

 

Audience 

Procurement Manager and Supply Technicians 

 

 

 

Prepared By Theresa Coulson 

Creation Date: 08/24/2005 

Document Name Assign Requisitions.doc 

Version 2 

Last Updated: 11/23/2008 

The most current version of this training script can be found at 
GSFC-FileSRVC\270Public\279 IT\Training\AMMS Customer Training 
Docs\Published\Purchasing. 
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Step Description:  Sign onto Oracle and select your Purchasing Super User 

responsibility 

 

Expected Results:  Purchasing Super User main menu will appear 
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Step Description:  From the Purchasing Super User main menu select 

Management > Manage Buyer Workload, click on the Open button 

 

Expected Results:  Find Requisition Lines window will appear 
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Step Description:  To find all of the requisitions that need to be assigned, do 

not change any parameters, click on the Find button 

 

Expected Results:  Assign Requisition Lines window will appear 
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Step Description:  Scroll over until you see the requisition number, this is 

you indicator, to assign requisitions place a check mark in the box at the 

beginning of the line, the line will turn blue, you can select multiple lines, 

once you have selected all of the requisitions, in the New Buyer field enter 

the name of the buyer who you want to assign the requisitions to.   

 

Expected Results:  Lines will be selected and New Buyer field will be 

populated 
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Step Description:  Save your work 

 

Expected Results:  Lines that were selected will go away 
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AMMS TRAINING SCRIPT 

Auto Create Blanket Release 
  

 

 

 

Purpose 

The purpose of this training script is to show Buyers and Material Coordinators 
how to auto create purchase release in Oracle 

 

Audience 

Buyers and Material Coordinators 

 

 

 

Prepared By Theresa Coulson 

Creation Date: 01/03/2004 

Document Name Auto Create Blanket Release.doc 

Version 3 

Last Updated: 11/23/2008 

The most current version of this training script can be found at 
GSFC-FileSRVC\270Public\279 IT\Training\AMMS Customer Training 
Docs\Published\Purchasing. 
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Step Description:  Sign onto Oracle and select the Purchasing AMMS 

responsibility 

 

Expected Results:  The Purchasing AMMS main menu will appear 
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Step Description:  Select from the Purchasing AMMS main menu Auto 

Create and click on the Open button 

 

Expected Results:  The Find Requisition Lines window will appear 
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Step Description:  Make sure the Approved field is set to Yes.  In the 

Buyer field enter the name of the buyer who requisitions you want to 

access.  Click on the Find Button 

 

Expected Results:  The Auto Create Documents window will open 
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Step Description:  Select the requisitions you want to put onto a 

Purchase Order by placing a check mark in the box to the left, the line 

will turn blue, you can select multiple lines 

 

Expected Results:  All lines selected will be blue 

 

 
 

 

Note:  This screen will give you detailed information, requisition 

number, item number, quantity, and the Destination Organization. 

Goddard and Wallops requisitions are not (normally) to be placed on 

the same purchase orders.  So please take not of the Destination 

Organization when creating your purchase orders. 
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Step Description:  At the bottom of the Auto Create Documents 

window, make sure that the Action is set to Create, the Document Type 

is set to Blanket Release and the Grouping is Default.  Now click on the 

Automatic button. 

 

Expected Results:  The New Documents window will appear 
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Step Description:  At the New Documents window in the Document field 

enter the Blanket Purchase Order Number that exists in Oracle  Once 

you have populated the Document field, the release number will default, 

along with the Supplier information.   Click on the Create Button. 

 

Expected Results:  A Note window will appear 
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Step Description:  At the Note window you will see your Oracle 

Purchase Order number, the Release Number and how many 

requisitions are on the Blanket Release.  Please take note of this 

information.  Click OK to the Note window. 

 

Expected Results:  The Auto Create to Purchase Order window will 

appear 
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Step Description:   At the Autocreate Release window scroll over to the 

Promised By date and click on the LOV and select a date, tab to the 

Need by field enter the Estimated Delivery Date. 

 

Expected Results:  Fields will be populated with dates 
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Step Description:   Scroll over to the Note to Receiver and put any 

special notes for the inspectors.  

 

Expected Results:  Field will be populated 
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Step Description:  Use the scroll bar to move to the Price field update 

this cost if necessary.   

 

Expected Results:  Fields will be populated 

 

 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



Page: 256 of 1264  

Step Description:  At the end of the line click in the [ ] field  

 

Expected Results: PO Lines Location window will appear 
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Step Description: From the AMMS Project field click on the LOV and 

select the appropriate GL number for the release you are creating, click 

OK 

 

Expected Results:  AMMS Project field will be populated 

 

 
 

 

 

 

Note:  Enter a GL project number for each line on the release. 
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Step Description:  Click OK to the PO Lines Location window 

 

Expected Results:  Return to Autocreate to Release window 

 

 
 

 

 

 

 

 

Note: Enter a GL project number for each line on the release.   
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Step Description:  Once you have entered a GL project number for each 

line on the release, Save your work 

 

Expected Results:  Transactions Saved and Applied  
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Step Description:  Click on the Approve button. 

 

Expected Results:  The Approval Documents window will open 
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Step Description:  Remove the Check Mark from the Email box and 

click on the OK button. 

 

Expected Results:  A Note window will appear 
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Step Description:  The Note window tells you that the “document has 

been submitted for approval”  click OK to the Note window. 

 

Expected Results:  You will return to the Purchase Order Summary to 

Purchase Order window 
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Step Description:  Take note that the Status on the Release is now 

Approved 

 

 
 

 

You are complete.  You have created your purchase order release. 
 

 

 

 



Page: 264 of 1264  

 

 

AMMS TRAINING SCRIPT 

Auto Create EEE Blanket Release 
  

 

 

 

Purpose 

The purpose of this training script is to how to create a release against a blanket purchase 

order set up for Project Parts. 

 

Audience 

Project Parts Buyers 

 

 

 

Prepared By Theresa Coulson 

Creation Date: 08/23/2005 

Document Name Auto Create EEE Blanket Release.doc 

Version 4 

Last Updated: 11/23/2008 

The most current version of this training script can be found at 
GSFC-FileSRVC\270Public\279 IT\Training\AMMS Customer Training 
Docs\Published\Purchasing. 
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Step Description:  Sign onto Oracle and select the Purchasing AMMS responsibility 

 

Expected Results:  The Purchasing AMMS main menu will appear 
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Step Description:  Select from the Purchasing AMMS main menu Auto Create and click 

on the Open button 

 

Expected Results:  The Find Requisition Lines window will appear 
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Step Description:  Make sure the Approved field is set to Yes.  In the Buyer field enter 

the name of the buyer who requisitions you want to access.  Click on the Find Button 

 

Expected Results:  The Auto Create Documents window will open 
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Step Description:  Select the requisitions you want to put onto the Purchase Order 

Release by placing a check mark in the box to the left, the line will turn blue, you can 

select multiple lines 

 

Expected Results:  All lines selected will be blue 

 

 
 

 

Note:  This screen will give you detailed information , requisition number, item number, 

quantity, and the Destination Organization. Goddard and Wallops requisitions are not 

(normally) to be placed on the same purchase orders.  So please take not of the 

Destination Organization when creating your purchase orders. 
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Step Description:  At the bottom of the Auto Create Documents window, make sure that 

the Action is set to Create, the Document Type is set to Blanket Release and the 

Grouping is Default.  Now click on the Automatic button. 

 

Expected Results:  The New Documents window will appear 
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Step Description:  At the New Documents window in the Document field enter the 

Blanket Purchase Order Number that exists in Oracle  Once you have populated the 

Document field, the release number will default, along with the Supplier information.   

Click on the Create Button. 

 

Expected Results:  A Note window will appear 
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Step Description:  At the Note window you will see your Oracle Purchase Order number, 

the Release Number and how many requisitions are on the Blanket Release.  Please take 

note of this information.  Click OK to the Note window. 

 

Expected Results:  The Auto Create to Purchase Order window will appear 
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Step Description:   At the Auto create Release window scroll over to field with the 

Promised By date and click on the LOV and select a date, tab to the Need by Date, enter 

the Estimated Delivery date.   

 

Expected Results:  Field will be populated with a date 
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Step Description:   Scroll over to the Note to Receiver and put the following information 

in this order: Project Name, Requisition Number, Order Number, Release Number, Part 

Number, and Customer Name.  This information must be updated for each line on the 

Release.   

 

Expected Results:  Field will be populated 
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Step Description:  Use the scroll bar to move to the Price field update this cost if 

necessary.   

 

Expected Results:  Fields will be populated 
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Step Description:  Go to the field at the end of the line with the [ ], this is the Descriptive 

Flex Field, this is where you will put the GL for each individual project.  Click in this 

space 

 

Expected Results:  PO Line Locations window will appear 
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Step Description:  At the PO Lines Location window click on the List of Values (LOV) 

and select the appropriate GL number for the project.  You must enter a GL number for 

each line on the Purchase Release.   

 

Expected Results:  Fields will be populated 
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Step Description:  Once you have entered all of the GL‟s for each line Save your work. 

 

Expected Results:  Fields will be populated and Transactions Saved message 
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Step Description:  Click on the Approve button. 

 

Expected Results:  The Approval Documents window will open 
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Step Description:  Remove the Check Mark from the Email box and click on the OK 

button. 

 

Expected Results:  A Note window will appear 
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Step Description:  The Note window tells you that the “document has been submitted for 

approval”  click OK to the Note window. 

 

Expected Results:  You will return to the Purchase Order Summary to Purchase Order 

window. 
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Step Description:  Take note that the Status on the PO is now Approved. 

 

 
 

 

 

You are complete.  You have created your purchase order. 
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AMMS TRAINING SCRIPT 

Auto Create Project Parts  

Purchase Orders  

 

 

 

Purpose 

The purpose of this training script is to show Buyers and Material Coordinators how to 

auto create purchase order in Oracle. 

 

Audience 

Buyers and Material Coordinators 

 

 

 

Prepared By Theresa Coulson 

Creation Date: 01/03/2004 

Document Name Auto Create Project Parts Purchase 
Order.doc 

Version 4 

Last Updated: 11/23/2008 

The most current version of this training script can be found at 
GSFC-FileSRVC\270Public\279 IT\Training\AMMS Customer Training 
Docs\Published\Purchasing. 
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Step Description:  Sign onto Oracle and select the Purchasing AMMS responsibility 

 

Expected Results:  The Purchasing AMMS main menu will appear 
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Step Description:  Select from the Purchasing AMMS main menu Auto Create and click 

on the Open button 

 

Expected Results:  The Find Requisition Lines window will appear 
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Step Description:  Make sure the Approved field is set to Yes.  In the Buyer field your 

buyer name will default, if you need to change, click in the Buyer field, enter the name of 

the buyer who requisitions you want to access.  Click on the Find Button 

 

Expected Results:  The Auto Create Documents window will open 

 

 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



Page: 286 of 1264  

Step Description:  Select the requisitions you want to put onto a Purchase Order by 

placing a check mark in the box to the left, the line will turn blue, you can select multiple 

lines 

 

Expected Results:  All lines selected will be blue 

 

 
 

Note:  This screen will give you detailed information, requisition number, item 

number, quantity, and the Destination Organization. Goddard and Wallops 

requisitions are not (normally) to be placed on the same purchase orders.  So please 

take not of the Destination Organization when creating your purchase orders. 
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Step Description:  At the bottom of the Auto Create Documents window, make sure that 

the Action is set to Create, the Document Type is set to Standard PO and the Grouping is 

Default.  Click on the Automatic button. 

 

Expected Results:  The New Documents window will appear 
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Step Description:  At the New Documents window in the Supplier field click on the LOV 

and select the correct Supplier that the material is being bought from.  Once you have 

populated the Supplier field click on the Create Button. 

 

Expected Results:  A Note window will appear. 

 

 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



Page: 289 of 1264  

Step Description:  At the Note window you will see your Oracle Purchase Order number 

and how many requisitions are on the purchase order.  Please take note of this 

information.  Click OK to the Note window. 

 

Expected Results:  The Auto Create to Purchase Order window will appear. 
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Step Description:  Click in the Descriptive Flex Field, the field with the [ ] around them.  

This is where you will assign the GL number. 

 

Expected Results:  PO Header window will open. 
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Step Description:  At the PO header window enter the Suffix for this PO Examples: EEE.  

Click in the AMMS Project field and click on the LOV. 

 

Expected Results:  AMMS Project window will appear with a list of GL numbers. 
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Step Description:  Select the appropriate GL number from the list provided.  Click on the 

OK button. 

 

Expected Results:  You will return to the PO Header window and the AMMS Project 

field will be populated with a GL number. 
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Step Description:  Click OK to the PO Header window. 

 

Expected Results:  You will return to the Auto Create to Purchase Order window 
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Step Description:  At this time assign any Attachments to the header as necessary.  Do 

this by clicking to the paper clip on the tool bar, and following the create attachments 

script. 

 

Expected Results:  Attachment will be on Purchase Order 
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Step Description:  Go to the bottom of the screen to the Line Items on the Purchase 

Order.  Use the scroll bar to move to the Price field update this cost if necessary.  At the 

Promised field click on the LOV and select the Promised date. At The Need-By date field 

enter the Estimated Delivery Date.  Do this for each line on the purchase order.   

 

Expected Results:  Fields will be populated 
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Step Description:  Scroll over to the Supplier Item field.  This is where you will enter a 

Part Number for the item.  Do this for each line on the purchase order.     

 

Expected Results:  Field will be populated 
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Step Description:  For each line click on the Shipments button at the bottom of the 

screen.   

 

Expected Results:  Shipments window will appear 
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Step Description:  Use the scroll bar and move to the right until you see the Note to 

Receiver field.  Enter any special notes required information into this field.  Do this for 

each line on the purchase order.   

 

Expected Results:  Field will be populated 

 

 
 

NOTE: Repeat this step for each line on the purchase order 
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Step Description:  Save you work at the Shipments Window 

 

Expected Results:  Transactions Saved and Applied Message 

 

 
 

NOTE: Repeat this step for each line on the purchase order. 
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Step Description:  At the bottom of the screen click on the Terms button. 

 

Expected Results:  Terms and Condition window will appear 
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Step Description:  In the Supplier Note field enter any information that the Supplier needs 

 

Expected Results:  Field will be populated 
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Step Description:  Save your work 

 

Expected Results:  Transactions Saved and Applied  
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Step Description:  Click on the Approve button. 

 

Expected Results:  The Approval Documents window will open 
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Step Description:  Remove the Check Mark from the Email box and click on the OK 

button. 

 

Expected Results:  A Note window will appear 
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Step Description:  The Note window tells you that the “document has been submitted for 

approval” click OK to the Note window. 

 

Expected Results:  You will return to the Purchase Order Summary to Purchase Order 

window 
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Step Description:  Take note that the Status on the PO is now Approved 

 

 
 

 

 

You are complete.  You have created your purchase order. 
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AMMS TRAINING SCRIPT 

Auto-Create Purchase Orders 
  

 

 

 

Purpose 

The purpose of this training script is to show how to auto-create Purchase Orders 

 

Audience 

Buyers, and Material Coordinators 

 

 

 

Prepared By Theresa Coulson 

Creation Date: 01/03/2004 

Document Name Auto Create Purchase Orders.doc 

Version 3 

Last Updated: 11/23/2008 

The most current version of this training script can be found at 
GSFC-FileSRVC\270Public\279 IT\Training\AMMS Customer Training 
Docs\Published\Purchasing. 
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Step Description:  Sign onto Oracle and select the Purchasing AMMS responsibility 

 

Expected Results:  The Purchasing AMMS main menu will appear 
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Step Description:  Select from the Purchasing AMMS main menu Auto Create and 

click on the Open button 

 

Expected Results:  The Find Requisition Lines window will appear 
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Step Description:  Make sure the Approved field is set to Yes.  In the Buyer field 

enter the name of the buyer who’s requisitions you want to access.  Click on the 

Find Button 

 

Expected Results:  The Auto Create Documents window will open 
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Step Description:  Select the requisitions you want to put onto a Purchase Order by 

placing a check mark in the box to the left, the line will turn blue, you can select 

multiple lines 

 

Expected Results:  All lines selected will be blue 

 

 
 

 

Note:  This screen will give you detailed information, requisition number, item 

number, quantity, and the Destination Organization. Goddard and Wallops 

requisitions are not (normally) to be placed on the same purchase orders.  So please 

take not of the Destination Organization when creating your purchase orders. 
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Step Description:  At the bottom of the Auto Create Documents window, make sure 

that the Action is set to Create, the Document Type is set to Standard PO and the 

Grouping is Default.  Now click on the Automatic button. 

 

Expected Results:  The New Documents window will appear 
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Step Description:  At the New Documents window in the Supplier field click on the 

LOV and select the correct Supplier that the material is being bought from.  Once 

you have populated the Supplier field click on the Create Button. 

 

Expected Results:  A Note window will appear 

 

 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



Page: 314 of 1264  

Step Description:  At the Note window you will see your Oracle Purchase Order 

number and how many requisitions are on the purchase order.  Please take note of 

this information.  Click OK to the Note window. 

 

Expected Results:  The Auto Create to Purchase Order window will appear 
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Step Description:  Click in the Descriptive Flex Field, the field with the [ ] around 

them.  This is where you will assign the GL number. 

 

Expected Results:  PO Header window will open 
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Step Description:  At the PO header window if there is a Suffix for this PO please 

enter it here.  Examples: EEE.  Click in the AMMS Project field and click on the 

LOV. 

 

Expected Results:  AMMS Project window will appear with a list of GL numbers 

 

 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



Page: 317 of 1264  

Step Description:  Select the appropriate GL number from the list provided.  Click 

on the OK button. 

 

Expected Results:  You will return to the PO Header window and the AMMS 

Project field will be populated with a GL number 
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Step Description:  Click OK to the PO Header window. 

 

Expected Results:  You will return to the Auto Create to Purchase Order window 
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Step Description:  Use the scroll bar to move to the Price field update this cost if 

necessary.  At the Promised field click on the LOV and select the Promised date.  

Click in the Need by field, enter the same date as the Promised field. 

 

Expected Results:  Fields will be populated 
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Step Description:  Scroll over to the Supplier Item field.  This is where you will 

enter a Part Number for local purchases.  For Govt Purchases you will enter the 

document number the item will be submitted with.  The document number consists 

of the Julian Date and sequential number.  Example: 50050001………5005 is the 

Julian date, 5 is the year and 005 is the day………..0001 is the first number in the 

sequence.  You will need to number these sequential for Goddard and Wallops.  So 

if Goddard stops at 0010, Wallops will start at 0011.   

 

Expected Results:  Field will be populated 
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Step Description:  Save your work 

 

Expected Results:  Transactions Saved and Applied  
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Step Description:  Click on the Approve button. 

 

Expected Results:  The Approval Documents window will open. 
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Step Description:  Remove the Check Mark from the Email box and click on the OK 

button. 

 

Expected Results:  A Note window will appear 
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Step Description:  The Note window tells you that the “document has been 

submitted for approval”  click OK to the Note window. 

 

Expected Results:  You will return to the Purchase Order Summary to Purchase 

Order window 
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Step Description:  Take note that the Status on the PO is now Approved 

 

 
 

 

 

You are complete.  You have created your purchase order. 
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AMMS TRAINING SCRIPT 

Auto Create Requisition onto Existing 
Purchase Order 

  

 

 

Purpose 

The purpose of this training script is to show Buyers how to auto create a requisition onto 

an existing purchase order in Oracle. 

 

Audience 

Buyers 

 

 

 

Prepared By Theresa Coulson 

Creation Date: 08/05/2005 

Document Name AutoCreate Requisition to Existing 
Purchase Order.doc 

Version 3 

Last Updated: 11/23/2008 

The most current version of this training script can be found at 
GSFC-FileSRVC\270Public\279 IT\Training\AMMS Customer Training 
Docs\Published\Purchasing. 
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Step Description:  Sign onto Oracle and select the Purchasing AMMS responsibility 

 

Expected Results:  The Purchasing AMMS main menu will appear 
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Step Description:  Select from the Purchasing AMMS main menu Auto Create and click 

on the Open button 

 

Expected Results:  The Find Requisition Lines window will appear 
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Step Description:  Make sure the Approved field is set to Yes.  In the requisition field 

enter the requisition number you want to add to the existing purchase order.  Click on the 

Find Button 

 

Expected Results:  The Auto Create Documents window will open 
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Step Description:  Select the requisitions you want to put onto a Purchase Order by 

placing a check mark in the box to the left, the line will turn blue. 

 

Expected Results:  Line selected will be blue 

 

 

 

 
 

Note:  This screen will give you detailed information, requisition number, item 

number, quantity, and the Destination Organization. Goddard and Wallops 

requisitions are not (normally) to be placed on the same purchase orders.  So please 

take not of the Destination Organization when creating your purchase orders. 
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Step Description:  At the bottom of the Auto Create Documents window, in the Action 

field, change this to ADD TO, the Document Type is set to Standard PO and the 

Grouping is Default.  Now click on the Automatic button. 

 

Expected Results:  The New Documents window will appear 
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Step Description:  At the Add to Document window in the Document Number field enter 

the Purchase Order number you are adding this requisitions to, click the OK button. 

 

Expected Results:  Note window will appear 
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Step Description:  The Note window will tell you how many requisitions you have added 

to the purchase order and reference the purchase order number.  Click OK to the Note. 

 

Expected Results:  Another Note window will appear 
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Step Description:  Another Note window will appear, No more requisitions exist to 

autocreate, click OK 

 

Expected Results:  Autocreate to Purchase Order window will appear 
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Step Description:  The last line on the PO is the line that you added.  Make sure all 

required data is filled in, Promised Date, Need By Date, part number in Supplier Item 

field, update the cost 

 

Expected Results:  Fields will be populated 
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Step Description:  Click on the Shipments button at the bottom of the screen.   

 

Expected Results:  Window view will change 
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Step Description:   At the Shipments window, scroll to the right until you see the Note to 

Receiver field, enter required information in this field. 

 

Expected Results:  Field will be populated 

 

 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



Page: 338 of 1264  

Step Description:  Save your work 

 

Expected Results:  Transactions Saved and Applied  
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Step Description: Close the Shipments window 

   

Expected Results:  Return to the Autocreate to Purchase Order window 
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Step Description:  Note that the Status says “Requires Re-Approval”, you now need to 

Approve the Purchase Order.  Click on the Approve Button 

 

Expected Results:  Approval document window will appear 

 

 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



Page: 341 of 1264  

Step Description:  At the Approval Documents window, make sure the Submit for 

Approval button is checked, remove the check mark from the Email field, click on the Ok 

Button 

 

Expected Results:  Note window will appear 
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Step Description:  The Note window tells you that the “document has been submitted for 

approval” click OK to the Note window. 

 

Expected Results:  You will return to the Purchase Order Summary to Purchase Order 

window 
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Step Description:  Take note that the Status on the PO is now Approved. 

 

 
 

 

 

You are complete.  You have added a requisition to an existing purchase order. 
 

 



Page: 344 of 1264  

 

 

AMMS TRAINING SCRIPT 

Cancel Purchase Order Line 
  

 

 

 

Purpose 

The purpose of this training script is to show how to cancel a purchase order libe 
and the associated requisitions. 

 

Audience 

Buyers, Material Coordinators 

 

 

 

Prepared By Theresa Coulson 

Creation Date: 08/05/2005 

Document Name Cancel PO Shipment Line.doc 

Version 4 

Last Updated: 11/23/2008 

The most current version of this training script can be found at 
GSFC-FileSRVC\270Public\279 IT\Training\AMMS Customer Training 
Docs\Published\Purchasing. 
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Step Description:  Sign onto Oracle and select the Purchasing 

AMMS responsibility. 

 

Expected Results:  Purchasing AMMS main menu will appear 
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Step Description:  From the Purchasing AMMS main menu select 

Purchase Order > Purchase Order Summary, click on Open 

 

Expected Results:  Find Purchase Order window will appear 
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Step Description:  In the Number field enter the Purchase Order 

number, click on the Find button 

 

Expected Results:  Purchase Order Header window will appear 

 

 
 

 

 

 

 

 

 

 

 

 

 

 



Page: 348 of 1264  

Step Description:  At the Purchase Order Header window click on 

the Lines button 

 

Expected Results:  Purchase Order Lines window will appear 
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Step Description:  Select the line that you want to cancel by 

placing the blue box at the beginning of the line, then click on the 

Shipments button 

 

Expected Results:  Purchase Order Shipments window will appear 
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Step Description:  Use the scroll bar move to the right, make sure 

there is still a quantity due for the material, make sure that the 

shipment line has not been billed (if the qty due field is zero you 

can not cancel the line, if the qty billed field greater then zero 

you can not cancel the shipment line) if everything looks to be 

fine from the tool bar select Control 

 

Expected Results:  Control Documents window will appear 
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Step Description:  From the Control Documents window, make 

sure the Cancel PO Shipment action is blue, place a check mark in 

the Cancel Requisition box; this will also cancel the requisition.  In 

the Reason field enter a brief description as to why you are 

canceling this PO Shipment Line.  Click Ok 

 

Expected Results:  Caution window will appear 
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Step Description:  Click OK to the Caution window, “Once this 

document is Cancelled, it can not be undone. Do you want to 

proceed?” 

 

Expected Results:  Note window will appear 
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Step Description:  Click OK to the Note window, “Control Action 

is completed successfully, Please re-query to see changes” 

 

Expected Results:  Return to the Purchase Order Shipment window 

 

 
 

 

 

 

 

You have completed the cancellation of the PO line.  Close all 

forms. 
 

 



Page: 354 of 1264  

 

 

AMMS TRAINING SCRIPT 

Cancel Purchase Requisitions 
  

 

 

 

Purpose 

The purpose of this training script is to show how to cancel purchase requisitions 

 

Audience 

Material Coordinators, Team Leads 

 

 

 

Prepared By Theresa Coulson 

Creation Date: 05/04/2006 

Document Name Cancel Requisition.doc 

Version x 

Last Updated: 11/23/2008 

The most current version of this training script can be found at 
GSFC-FileSRVC\270Public\279 IT\Training\AMMS Customer Training 
Docs\Published\Purchasing. 
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Step Description:  Sign onto Oracle and select IM Purchasing 

AMMS responsibility 

 

Expected Results:  IM Purchasing AMMS main menu will appear 
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Step Description:  From the IM Purchasing AMMS main menu 

select Requisitions > Requisition Summary, click on the open 

button 

 

Expected Results:  Find Requisitions window will appear 
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Step Description:  You can either enter the requisition number or 

the item number.  Enter the requisition number in the Requisition 

Number field, or the item in the Item,Rev field.  At the results area, 

select Lines.  Click on the find button 

 

Expected Results:  Requisition Lines Summary window will 

appear 
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Step Description:  From the tool bar select Tools > Control 

 

Expected Results:  Control Document window will appear 
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Step Description:  At the Control Document window select Cancel 

Requisition Line, click OK 

 

Expected Results:  Caution window will appear 
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Step Description:  Click OK to the Caution window 

 

Expected Results:  Note window will appear 
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Step Description:  Click OK to Note window 

 

Expected Results:  Return to Requisition Lines Summary window 

 

 
 

 

 

 

Cancellation of Requisitions is completed. 
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AMMS TRAINING SCRIPT 

Create Blanket Purchase Order 
  

 

 

 

Purpose 

The purpose of this training script is to show how to create a Blanket Purchase 
Agreement. 

 

Audience 

Buyers 

 

 

 

Prepared By Theresa Coulson 

Creation Date: 03/28/2005 

Document Name Create Blanket Purchase 
Agreement.doc 

Version 3 

Last Updated: 11/23/2008 

The most current version of this training script can be found at 
GSFC-FileSRVC\270Public\279 IT\Training\AMMS Customer Training 
Docs\Published\Purchasing. 
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Step Description:  Sign onto Oracle and select the Purchasing AMMS 

Responsibility 

 

Expected Results:  Purchasing AMMS main menu will appear 
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Step Description:  From the Purchasing AMMS main menu select Purchase 

Orders > Purchase Orders click on the open button 

 

Expected Results:  Blank Purchase Order screen will appear 
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Step Description:  At the blank purchase order window, in the Type field 

change this to Blanket Purchase Agreement 

 

Expected Results:  Field will be populated with Blanket Purchase 

Agreement 
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Step Description:  In the Supplier field either, enter the supplier name or 

click on the LOV and select the supplier for this BPA. 

 

Expected Results:  Supplier field will be populated 
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Step Description:  Click in the  [ ] this will open the PO Headers Descriptive 

Flex Field.  In the Descriptive Flex Field enter the GL account number for 

the BPA and any suffix for the BPA, click Ok 

 

Expected Results:  Field will be populated, return to Purchase Order window 
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Step Description:  In the Amount Agreed field enter the total dollar value for 

the BPA 

 

Expected Results:  Field will be populated with dollar figure 
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Step Description:  At the Line level, Item tab, enter the item number for the 

BPA 

 

Expected Results:  Item, Description, and UOM fields will be populated 
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Step Description:  Scroll over to the Price field and enter the cost for this 

Item, this is usually $1.00 

 

Expected Results:  Field will be populated 
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Step Description:  Scroll over to the Supplier Item field and enter the part 

number for this item 

 

Expected Results:  Field will be populated 
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Step Description:  Save your work, click on the Save button on the toolbar 

 

Expected Results:  PO number assigned, Transaction Saved and Applied 

message 
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Step Description:  Click on the Term button at the bottom of the window 

 

Expected Results:  Terms and Conditions window will appear 
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Step Description:  Enter the Effective Date, in both fields and the Amount 

Limit, Save your work 

 

Expected Results:  Field will be populated and Transaction Saved and 

Applied message 
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Step Description:  Close the Terms and Conditions window 

 

Expected Results:  Return to Purchase Order Summary to Purchase Order 

window 
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Step Description:  Approve the BPA, click on the Approve button 

 

Expected Results:  Approval Document window will appear 
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Step Description:  Remove the check mark from the email box, and click 

OK 

 

Expected Results:  Note window will appear 
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Step Description:  Click OK to the Note 

 

Expected Results: Window will go away, status on BPA will be Approved 
 

 
 

 

 

 

 

 

You have created a Blanket Purchase Agreement 
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AMMS TRAINING SCRIPT 

Create Expense BPA Release 
  

 

 

 

Purpose 

The purpose of this training script is to show how to create an Expense BPA 
Release 

 

Audience 

Buyers 

 

 

 

Prepared By Theresa Coulson 

Creation Date: 12/14/2004 

Document Name Create Expense BPA Release.doc 

Version 4 

Last Updated: 11/23/2008 

The most current version of this training script can be found at 
GSFC-FileSRVC\270Public\279 IT\Training\AMMS Customer Training 
Docs\Published\Purchasing. 
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Step Description:  Sign onto Oracle and select the Purchasing AMMS 

responsibility 

 

Expected Results:  The Purchasing AMMS main menu will appear 
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Step Description:  From the Purchasing AMMS main menu select Purchase 

Orders > Releases, click on Open 

 

Expected Results:  The Release window will open 
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Step Description:  In the PO,Rev field enter the BPA number, then tab 

 

Expected Results:  BPA information will populate 
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Step Description:  Go to the Release field, you can create any release 

number that you want, or you can let Oracle default the release number, if 

you want to change the number click in the field and enter the new release 

number 

 

Expected Results:  Release number will change if new number entered 
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Step Description:  At the bottom of the screen at the Shipments tab click in 

the Number field, the number will default, if you would like you can change 

this number to any other number.   

 

Expected Results: Number field will be populated 
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Step Description:  Tab to Line field and enter the line number   

 

Expected Results:  Field will be populated 
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Step Description:  You will see that the Organization and Ship to will 

Default 

 

Expected Results:  Fields will be populated 
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Step Description:  Tab to the Quantity field and enter the COST of the 

release.  Example 21.21  

 

Expected Results:  Quantity field will have cost  
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Step Description:  Tab to the Promise Date field and click on the LOV enter 

the date the material is scheduled to arrive. Tab to the Need By date field 

and click on the LOV also select the date the material is scheduled to arrive. 

 

 

Expected Results:  Fields will be populated 
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Step Description:  Click on the Distributions button at the bottom of the 

screen 

 

Expected Results:  The Distributions window will open 
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Step Description:  Use the scroll bar and move to the Charge Account field  

 

Expected Results:  You will see Charge account field 
 

 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



Page: 391 of 1264  

Step Description:  Click on the LOV and enter the Expense GL number (GL 

number will always start with GD for Goddard or WF for Wallops) 

 

Expected Results:  Fields will be populated 
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Step Description:  Click OK to the Charge Account window and the Charge 

Account field will be populated 

 

Expected Results:  Charge Account window will close and Charge Account 

field will be populated 
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Step Description:  Close the Distributions window 

 

Expected Results:  You will return to the Purchase Order Summary to 

Release window 
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Step Description:  Click on the More tab 

 

Expected Results:  Window view will change 
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Step Description:  Go to the Match Approval Level field and change to 2 

Way Match, THIS MUST BE DONE FOR ALL EXPENSE RELEASES 

 

Expected Results:  Field data will change 
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Step Description:  At the end of the line click in the [ ] field  

 

Expected Results: PO Lines Location window will appear 
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Step Description: From the AMMS Project field click on the LOV and 

select the appropriate GL number for the release you are creating, click 

OK 

 

Expected Results:  AMMS Project field will be populated 
 

 
 

 

 

 

Note:  Enter a GL project number for each line on the release. 
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Step Description:  Click OK to the PO Lines Location window 

 

Expected Results:  Return to Autocreate to Release window 
 

 
 

 

Note: Enter a GL project number for each line on the release.   
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Step Description:  Once you have entered a GL project number for each 

line on the release, Save your work 

 

Expected Results:  Transactions Saved and Applied  
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Step Description:  Save your work 

 

Expected Results:  Transactions completed and Saved message 
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Step Description:  Click on the Approve button at the bottom right of the 

screen 

 

Expected Results:  The Approval Documents window will open 
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Step Description:  Un-check the Email box, make sure that the Submit for 

Approval box is checked and click OK 

 

Expected Results:  A Note window will appear 
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Step Description:  Click OK to the Note, Document has been submitted for 

Approval 

 

Expected Results:  Status on Release will say Approved 
 

 
 

 

 

 

 

You have completed this process. 
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AMMS TRAINING SCRIPT 

Create Expense BPA 

  
Prepared by  Theresa Coulson  

       Author:                 Theresa Coulson 
                                                            Creation Date           12/14/04         

                                                            Last Updated:           8/6/2009 

                                                             Version:    3             

     

 

   

 

   

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

   Buyers 
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Step Description:  Sign onto Oracle and select the Purchasing AMMS 

responsibility 

 

Expected Results:  Purchasing AMMS main menu will appear 
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Step Description:  From the Purchasing AMMS main menu select Purchase 

Orders > Purchase Orders click on Open 

 

Expected Results:  The Purchase Order AMMS window will open 
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Step Description:  In the Type field click on the LOV and select Blanket 

Purchase Agreement from the menu 

 

Expected Results:  Field will be populated with Blanket Purchase 

Agreement 
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Step Description:  At the Supplier field click on the LOV and select the 

Supplier for this BPA 

 

Expected Results:  Supplier field will be populated with vendor name 
 

 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



Page: 409 of 1264  

Step Description:  In the Descriptive Flex Field for the GL number, field has 

[ ], click in this field to open PO Headers window 

 

Expected Results:  PO Headers window will open 
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Step Description:  In the PO Headers window if the PO has a Suffix enter 

that information.  In the AMMS Project field click on the LOV. 

 

Expected Results:  A list of GL account numbers will appear 
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Step Description:  From the GL menu select the appropriate GL number 

 

Expected Results:  The AMMS project field will be populated 
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Step Description:  Click OK to the PO Headers window 

 

Expected Results:  Will return to the Purchase Order window 
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Step Description:  At the Items tab at the bottom of the screen in the Type 

field click on the LOV  

 

Expected Results:  Line Type menu will appear 
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Step Description:  From the Line Type menu select Expense Items 

 

Expected Results:  Line Type will change from Goods to Expense 
 

 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



Page: 415 of 1264  

Step Description:  Tab to the Item field and enter the item number.  If this is 

an “Across the Contract” purchase no Item Number is needed, the Category 

should say None-None 

 

Expected Results:  Field will be populated 
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Step Description:  Save your work 

 

Expected Results:  Transaction Complete message 
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Step Description:  Click on the Terms button 

 

Expected Results:  Terms and Conditions window will appear 
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Step Description:  In the Terms and Conditions window enter your Effective 

Dates, and your Amount Limit.  Save your work 

 

Expected Results:  Field populated, Transaction Saved and Applied message 
 

 
 

 

 

 

 

 

 

 

 

 

 

 

 

 



Page: 419 of 1264  

 

 

 

 

Step Description:  Close the Terms and Conditions window 

 

Expected Results: Return to Purchase Order Summary window 
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Step Description:  Click on the Approve button at the bottom right of the 

screen 

 

Expected Results:  The Approve Documents window will open 
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Step Description:  Remove the check mark from the Email box, make sure 

the Submit for Approval box is checked, then click OK 

 

Expected Results:  A note window will appear 
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Step Description:  Click OK to the Note window telling you Document has 

been submitted for Approval 

 

Expected Results:  Window will close and status on Purchase order will 

change from Incomplete to Approved 
 

 
 

 

 

Expense BPA is created. 
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AMMS TRAINING SCRIPT 

Generate Manual Requisitions 
  

 

 

 

Purpose 

The purpose of this training script is to show how to create a purchasing 
requsition 

 

Audience 

Material Coordinators, Supply Technician Leads 

 

 

 

Prepared By Theresa Coulson 

Creation Date: 01/10/2005 

Document Name Create Manual Requisitions.doc 

Version 2 

Last Updated: 11/23/2008 

The most current version of this training script can be found at 
GSFC-FileSRVC\270Public\279 IT\Training\AMMS Customer Training 
Docs\Published\Purchasing. 
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Step Description:  Sign onto Oracle and select the IM Purchasing AMMS responsibility 

 

Expected Results:  IM Purchasing AMMS main menu will appear 
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Step Description:  From the IM Purchasing AMMS main menu select Requisitions > 

Requisitions, click on the Open button 

 

Expected Results:  The Requisition AMMS New window will appear 
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Step Description:  Click in the Item field and enter the stock number 

 

Expected Results:  Field will be populated 
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Step Description:  Tab to the quantity field, Category, Description and UOM will default.  

In the quantity field enter your quantity.   

 

Expected Results:  Field will be populated 
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Step Description:  Tab to the Need By field, click on the LOV and select a date from the 

calendar, this date will populate the Need by field 

 

Expected Results:  Field is populated. 
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Step Description:  Click on the Source Details tab. 

 

Expected Results:  Window view will change 
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Step Description:  If you need to put Notes to the buyer, type in the Note to Buyer field.  

This is a free form field. 

 

Expected Results:  Field will be populated. 
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Step Description:  Tab to the Buyer field, if a default buyer already exists for this item 

this field will be populated.  If the field is blank, click on the LOV and select the buyer to 

assign to this requisition. 

 

Expected Results:  Field will be populated with buyer name. 
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Step Description:  Click on the Details tab. 

 

Expected Results:  Window view will change 
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Step Description:  If the requisition is Urgent, place a check mark in the Urgent box.   

 

Expected Results:  Box will be checked 
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Step Description:  Save your work and write down your requisition number. 

 

Expected Results:  Transactions Applies and Saved and you will get an assigned 

Requisition Number. 
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Step Description:  Click on the Approve button 

 

Expected Results:  Approval Document s window will open 
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Step Description:  Click OK to the Approval Documents window, the Submit for 

Approval box should already be checked. 

 

Expected Results:  Note window appears 
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Step Description:  Click on to the Note window, Document has been submitted for 

approval.   

 

Expected Results:  Window disappears and screen has no data. 
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AMMS TRAINING SCRIPT 

Create Standard Expense Purchase 
Order 

  
 

    Prepared by  Theresa Coulson 

                                                             Author:  Theresa Coulson 

                                                             Creation Date:                      10/16/08         

                                                             Version:  1 

                                                             Last Updated:                    8/6/2009     

     

 

   

 

   

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

  Gives Instruction to the Buyers on how to create a standard 

expense purchase order 
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Step Description: Sign onto Oracle and select the Purchasing AMMS responsibility 

 

Expected Results:  Purchasing AMMS Main Menu will appear 
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Step Description:  From the Purchasing AMMS Main Menu select Purchase Orders > 

Purchase Orders and click on the Open button 

 

Expected Results:  Purchase Orders AMMS (New) window will appear 
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Step Description:  In the Purchase Order AMMS (new) form enter the supplier that you 

are placing the purchase order with, you can click on the List of Values (LOV) or enter 

part of the supplier name.  After you enter supplier hit the Tab button  

 

Expected Results:  Supplier field and other fields will be populated.   
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Step Description:  Click in the Descriptive Flex Field (DFF) and enter the appropriate GL 

number and any suffix for the PO click OK to close the DFF window 

 

Expected Results:  Field will be populated 
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Step Description:  Save your work, a Purchase Order number will be assigned 

 

Expected Results:  Fields populated 
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Step Description:  Click on the Paper Clip on the tool bar and add your standard 

attachment and any other attachments that are needed for this purchase order 

 

Expected Results:  Attachments will be assigned 
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Step Description:  At the line level of the PO click in the Type field click on the List of 

Values (LOV) and select Expense Items 

 

Expected Results:  Field data will update 
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Step Description:  In the Item field enter the Expense Item Number, tab to the next field 

If this is an “Across the Contract” purchase no stock number is required but the Category 

needs to say None-None. 

 

Expected Results:  Fields will be populated 
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Step Description: In the Description field enter the actual name of what you are ordering, 

this does not have to be a proper noun 

 

Expected Results:  Description of items will change 
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Step Description:  In the Quantity field enter the quantity for this purchase order 

 

Expected Results: Field will be populated 
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Step Description:  Tab to the Price field and enter the cost for this expense item 

 

Expected Results:  Data will update 
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Step Description:  Tab to the Promised field and enter Estimated Delivery Date for the 

material, enter the same date in the Need by field 

 

Expected Results:  Fields will be populated 
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Step Description:  Tab to the Supplier Item field and enter the part number for the 

expense item 

 

Expected Results:  Field will be populated 
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Step Description:  Click on the Shipments button at the bottom of the window 

 

Expected Results:  Shipments window will appear 
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Step Description:  Click on the Distribution Lines at the bottom of the Shipments window 

 

Expected Results:  Distributions window will open 
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Step Description: Slide over to the Charge Account field and change the account number 

to reflect the appropriate account 

 

Expected Results:  Data will change 
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Step Description:  Save your work and close the Distributions window 

 

Expected Results: Return to Shipments window 
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Step Description:  In the Shipments window click on the More tab 

 

Expected Results:  Window view will change 
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Step Description: At the More tab change the Match Approval level to 2 Way 

 

Expected Results:  Data will be updated 
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Step Description: Save your work and close the Shipments window 

 

Expected Results:  Return to Purchase Order window 
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Step Description:  Repeat all of these steps for each line on the Purchase Order 

 

Expected Results:  Purchase Order will be updated 
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Step Description:  Click on the Approve button at the bottom of the window 

 

Expected Results:  Approve Documents window will appear 

 

 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



Page: 461 of 1264  

 

Step Description:  Remove the check mark from the Email back and click OK 

 

Expected Results:  Notice window will appear 
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Step Description: Click OK to the NOTE window 

 

Expected Results:  Status on PO goes from Incomplete to Approved 
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Step Description:  Now Print your Purchase Order using your How to Print a PO script 

 

Expected Results:  PO will print 
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AMMS TRAINING SCRIPT 

Create Purchase Order Attachment 
  

 

 

 

Purpose 

The purpose of this training script is to explain how to create an Purchase Order 
attachment. 

 

Audience 

Buyers 

 

 

 

Prepared By Theresa Coulson 

Creation Date: 08/11/2005 

Document Name Creating a Purchase Order 
Attachment.doc 

Version 2 

Last Updated: 11/23/2008 

The most current version of this training script can be found at 
GSFC-FileSRVC\270Public\279 IT\Training\AMMS Customer Training 
Docs\Published\Purchasing. 
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Step Description:  When you have created your purchase order, and you want the 

attachment at the header level, click on the paperclip on the tool bar 

 

Expected Results:  Attachment window will open 
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Step Description:  In the Category field click on the LOV and then find who you want the 

attachment to go to, usually this is To Supplier, in the Data Type field, select Long or 

Short Text 

 

Expected Results:  Field will be populated, bottom portion of screen will be yellow. 
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Step Description:  At the bottom of the screen, hit the enter button once to move down 

one line, then type in any important information that the Supplier must know about the 

purchase order.   

 

Expected Results:  Field will have data 
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Step Description:  If you have a standard attachment for every purchase order, with the 

curser in the Category field, click on the Document Catalog button at the bottom of the 

window.   

 

Expected Results:  Document Catalog window will appear 
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Step Description:  In the Description field type in the name of the standard attachment 

then click on the Find button 

 

Expected Results:  Name of standard attachment will appear at the bottom of the screen 

 

 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



Page: 470 of 1264  

 

Step Description:  Select the attachment that is to go onto the purchase order, and then 

click the Attach 1 button 

 

Expected Results:  Return to Attachment window 
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Step Description:  You can add as many attachments at needed to a purchase order.  

When you have added all of your attachments, click on the Save icon, then close the 

attachment window 

 

Expected Results:  Return to Autocreate Purchase Order window. 
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AMMS TRAINING SCRIPT 

JIT Expiration Date 
  

 

 

 

Purpose 

The purpose of this training script is to show how to reset the JIT expiration date. 

 

Audience 

Purchasing Manager 

 

 

 

Prepared By Theresa Coulson 

Creation Date: 02/03/2006 

Document Name JIT Expiration Date.doc 

Version 2 

Last Updated: 11/23/2008 

The most current version of this training script can be found at 
GSFC-FileSRVC\270Public\279 IT\Training\AMMS Customer Training 
Docs\Published\Purchasing. 
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Click on the Agreement Tab, scroll to the right, in the Expiration Date field, click on the LOV and select a 

date, or enter a date.  Save and Approve the PO. 
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AMMS TRAINING SCRIPT 

Manual Closure of Purchase Order, 
Blanket Purchase Order, and Blanket 

Purchase Order Release 
 

 

Purpose 

The purpose of this training script is to explain how to manually close a purchase order, 

blanket purchase order, or blanket purchase order release. 

 

Audience 

Buyers 

 

 

 

Prepared By Theresa Coulson 

Creation Date: 11/17/2005 

Document Name Manually Close Purchase Orders.doc 

Version 2 

Last Updated: 11/23/2008 

The most current version of this training script can be found at 
GSFC-FileSRVC\270Public\279 IT\Training\AMMS Customer Training 
Docs\Published\Purchasing. 
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Step Description:  Sign onto Oracle and select Purchasing AMMS 

responsibility 

 

Expected Results:  Purchasing AMMS main menu will appear 
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Step Description:  From the Purchasing AMMS main menu select, Purchase 

Orders > Purchase Order Summary click on the Open button 

 

Expected Results: Find Purchase Order window will appear 
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Step Description:  In the Number field enter the Purchase Order (PO) 

number, if you are doing a Blanket Purchase Order (BPA) also enter the 

Release number in the Release field.  Click on the Find button.   

 

Expected Results:  Purchase Order Header window will appear 
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Step Description:  From the tool-bar select, Tools > Control 

 

Expected Results:  Control Documents window will appear 
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Step Description:  From the list of Actions select CLOSE, highlight so that 

the line is blue.  BE SURE THAT YOU ARE ON CLOSE, DO NOT EVER 

SELECT FINALLY CLOSE.   

 

Expected Results:  Close will be highlighted 
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Step Description:  After you have selected Close, click OK 

 

Expected Results:  Note window will appear 
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Step Description:  Click OK to the Note window 

 

Expected Results:  Return to the Purchase Order Header window 

 

 
 

 

 

 

Transactions complete, re-query to see results. 

 

 

 

 

 

 



Page: 482 of 1264  

 

 

AMMS TRAINING SCRIPT 

Notification Approval 
  

 

 

 

Purpose 

The purpose of this training script is to explain how to approve purchase orders 
that are forwarded for approval. 

 

Audience 

Buyers 

 

 

 

Prepared By Theresa Coulson 

Creation Date: 07/09/2008 

Document Name Notifications Approval of Purchase 
Orders.doc 

Version 2 

Last Updated: 11/23/2008 

The most current version of this training script can be found at 
GSFC-FileSRVC\270Public\279 IT\Training\AMMS Customer Training 
Docs\Published\Purchasing. 
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Step Description:  Sign onto Oracle and select Purchase Super User Responsibility 

 

Expected Results; Purchasing Super User main menu will appear 
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Step Description:  From the Purchasing Super User Responsibility select Notifications 

Summary, click on open 

 

Expected Results:  Work list will appear 
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Step Description:  Items that are on the Work List are items that are waiting for approval.  

Select the item you want to approve, click on the item name in the subject box. 

 

Expected Results:  Notifications Details box will appear 
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Step Description:  This window give you details about the purchase order. The Approval 

Action box should be defaulted to Approve, click on the Submit Button to Approve the 

PO 

 

Expected Results:  You will return to the Work List 
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Step Description:  If there are multiple Purchase Orders to approve repeat the process for 

each item 

 

Expected Results:  Purchase Orders are approved 
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AMMS TRAINING SCRIPT 

Printed Copy of Purchase Order 

  
    Prepared by  Theresa Coulson 

                                                             Author:  Theresa Coulson 

                                                             Creation Date:                      5/2/05         

                                                             Version:  1 

                                                             Last Updated:                       11/24/2010 

     

 

   

 

   

 

 

 

 

 

 

 

 

 

AMMS Training Script: 

 

This will show how to print out a purchase order 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

   Buyers 
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Step Description:  Sign onto Oracle and select Purchasing AMMS 

responsibility 

 

Expected Results:  Purchasing AMMS main menu will appear 
 

 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



Page: 490 of 1264  

Step Description:  From the Purchasing AMMS main menu select Reports > 

Run, click on the Open button 

 

Expected Results:  Submit a New Request window will appear 
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Step Description:  From the Submit New Request window select Single 

request, click OK 

 

Expected Results:  Submit Request window will open 
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Step Description:  In the Name click on the LOV  

 

Expected Results:  Reports window will appear 
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Step Description:  From the list of reports find Printed Purchase Order 

Report (Portrait Custom Form) 

 

Expected Results:  Parameters window will appear 
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Step Results:  In the Print Selection Field, click on the LOV and select ALL, 

in the Purchase Order Number From field, enter the PO number, in the 

Purchase Order Number To field enter the PO number.  Change any other 

data as required Click OK 

 

Expected Results:  Fields will be populated, Return to Submit Request 

window 
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Step Description:  Click on the Submit button 

 

Expected Results:  A decision window will appear 
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Step Description:  Click No to the Decision 

 

Expected Results: Window will go away, return to Purchasing main menu 
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Step Description:  From the Toolbar select View> Requests 

 

Expected Results:  Find Requests window will appear 
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Step Description:  Click Find on the Find Requests window 

 

Expected Results:  Your list of requests will appear 
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Step Description:  Once the concurrent job has completed normal, click on 

the View Output button 

 

Expected Results:  PO will open in a PDF file 
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Step Description:  Print the PO from the PDF file 

 

Expected Results:  PO will print 
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AMMS TRAINING SCRIPT 

Project Parts Create an Attachment to 
a Purchase Order 

  

 

 

Purpose 

The purpose of this training script is to show Buyers how to create an attachment to a 

Purchase Order.  Attachments are added after any change to a purchase order. 

 

Audience 

Buyers 

 

 

 

Prepared By Theresa Coulson 

Creation Date: 04/26/2005 

Document Name Project Parts Adding Attachment to 
PO.doc 

Version 4 

Last Updated: 11/23/2008 

The most current version of this training script can be found at 
GSFC-FileSRVC\270Public\279 IT\Training\AMMS Customer Training 
Docs\Published\Purchasing. 
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Step Description:  Sign onto Oracle and select Purchasing AMMS 

responsibility 

 

Expected Results:  Purchasing AMMS main menu will appear 
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Step Description:  From the Purchasing AMMS main menu select Purchase 

Order > Purchase Order Summary click Open 

 

Expected Results:  The Find Purchase Order window will appear 
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Step Description:  Enter the PO number you want to create the attachment 

for, click on the Find button 

 

Expected Results:  Purchase Orders Header window will appear 
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Step Description:  Click on the Open Button to Open the Purchase Order 

 

Expected Results:  Purchase Order Summary to Purchase Order window will 

appear 
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NOTE: TO PUT ATTACHMENT AT THE HEADER LEVEL CLICK IN A 

FIELD AT THE TOP OF THE FORM.  TO PUT AN ATTACHMENT AT 

THE LINE LEVEL CLICK ON A LINE ON THE PURCHASE ORDER. 

 

Step Description:  From the Tool Bar select the icon that looks like a Paper 

clip 

 

Expected Results: Attachments window will appear 
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Step Description:  If you are using an Attachment format click on the 

Document Catalog button at the bottom right of the window 

 

Expected Results:  Document Catalog window will appear 
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Step Description:  At the Document Catalog window, in the Description 

field enter part of the attachment name, example %TENN%, click on the 

Find button 

 

Expected Results:  Attachment will appear at bottom of window 
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Step Description:  Select the attachment, by clicking in the field, then click 

on the Attach 1 button 

 

Expected Results:  Attachment will be added to PO 
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Step Description:  To add multiple attachments to a PO click in the next line 

in the Attachment window 

 

Expected Results:  Field will be ready to populate 
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Step Description:  If you are typing an attachment, click on the Category 

field click on the LOV and in the Find window enter a % sign and a list of 

choices will appear, select the appropriate category.  To Supplier is the one 

to be used.   

 

Expected Results:  Field will be populated 
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Step Description:  In the Data Type field click on the LOV and select Short 

Text, this will allow you to type more information 

 

Expected Results:  Field will be populated 
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Step Description:  Notice the bottom field is yellow start typing you required 

information 

 

Expected Results:  Field will be populated 
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Step Description:  Follow this format for putting attachments on purchase 

orders.  Please note: changes to purchase orders are not to be put in 

attachments, they are to be put in the Note to Supplier field: 

 

1.  Change information to supplier, if applicable – address in the Notes to 

Supplier use this field for changes to PO only.    

 

Change 2, April 10, 2006 (list the change number to the supplier 

along with the date, do not abbreviate) 

 

Added Line 12, PN 788978 

Deleted Line 3, PN 245895  

Added Line 16, Pre-cap Inspection, PN 78985  

Increased Quantity on Line 4, PN 898574, from 10 each to 15 

each. 

Decreased Quantity on Line 6, PN4568, from 12 each to 9 each 

 

2.  Buyer Contact Information 

 

3.  Notes 

 

4.  Verification of Services 

 

7. Quote Reference Information 

 

8. Quality Assurance and Shipping  information (ie:see below) 

 

Single Date Lot Code Required 

 

Manufacturer‟s C of C Required 

 

Special Packaging Requirements 

 

Chemical and Physical Analysis Required 

 

Multiple date codes acceptable (if non flight and customer has 

indicated such) 

 

Pre-cap Inspection information (ie:  Pre-Cap Source Inspection 

appplicable to Line 3 also any Technical POC give, name, and 
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telephone number along with verification information, if 

applicable) 

 

Other testing/data requirements information. (ie: Lot Charge 

and Screening and Group A Test Data applicable to Line 4) 

 

7.    Physical, Chemical & Proof Test Required ( IF Applicable).  

 

 

 

 

 

 

 

 

 

Attachments are to be put on the Purchase Orders in this order.  Again any 

changes to purchase order there is NOT to be an Attachment, use the Note to 

Supplier field, see the Project Parts Change Established Purchase Order 

script. 
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Step Description:  Once you have entered all required information click on 

the Save button 

 

Expected Results:  Transaction Saved and Applied message 
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Step Description:  Close the Attachment window. 

 

Expected Results:  Attached added to PO, will return to Purchase Order to 

Purchase Order Summary window. 
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Step Description:  Close all forms Transaction Complete. 

 

 

 

 

NOTE:  If you want to put an Attached on the PO Header click in one of the 

fields at the top of the Purchase Order Summary to Purchase Order window.  

If you want to put an Attachment at the line level for a specific item, click on 

the specific item, and then create the attachment. 
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AMMS TRAINING SCRIPT 

Project Parts Changes to Established 
Purchase Order 

   

 

 

Purpose 

The purpose of this training script is to show the buyers how to make changes to 

established purchase orders. 

 

Audience 

Buyers 

 

 

 

Prepared By Theresa Coulson 

Creation Date: 05/12/2006 

Document Name Project Parts Changes to Established 
Purchase Orders.doc 

Version 2 

Last Updated: 11/23/2008 

The most current version of this training script can be found at 
GSFC-FileSRVC\270Public\279 IT\Training\AMMS Customer Training 
Docs\Published\Purchasing. 
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Step Description:  Sign onto Oracle and select the Purchasing AMMS 

responsibility 

 

Expected Results:  The Purchasing AMMS main menu will appear 
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Step Description:  From the Purchasing AMMS main menu select Purchase 

Orders > Purchase Order Summary, click on the Open button 

 

Expected Results:  The Find Purchase Order screen will appear 
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Step Description:  In the Number field enter the purchase order number you 

want to view.  Click on the Find button 

 

Expected Results:  The Purchase Order Header window will appear 
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Step Description:  To make changes to an item on the purchase order click 

on the Open button.    

 

Expected Results:  The Purchase Order Summary to Purchase Order screen 

will appear 
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Step Description:  Update the any necessary information if you need to 

change the cost, click on the price field and update the cost.  If you need to 

change any other information select the field and make the appropriate 

changed.   

 

Expected Results:  Information will change 
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Step Description:  After you have made the changes to the purchase order, 

you MUST put the changes in the Note to Supplier field.  Click on the 

Terms button at the bottom of the screen. 

 

Expected Results:  Terms and Conditions window will appear 
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Step Description:  In the Note to Supplier field enter what was changed in 

this format:   

 

Use the Note to Supplier field for changes to PO only.    

 

Example: Change 2, April 10, 2006 (list the change number to the 

supplier along with the date, do not abbreviate) 

 

Added Line 12, PN 788978 

Deleted Line 3, PN 245895  

Added Line 16, Pre-cap Inspection, PN 78985  

Increased Quantity on Line 4, PN 898574, from 10 each to 15 

each. 

Decreased Quantity on Line 6, PN4568, from 12 each to 9 each 

 

Expected Results:  Field will be populated  
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Step Description:  Click on the Save button 

 

Expected Results:  Note Creating new document revision 

 

 
 

 

 

 

NOTE: YOU MUST PUT INFORMATION IN THE NOTE TO SUPPLIER 

FIELD FOR EVERY CHANGE THAT IS MADE TO A PO.  IF 

INFORMATION ALREADY EXISTS IN THE FIELD, GO TO THE END 

OF THAT STATEMENT AND START A NEW STATEMENT. 
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Step Description:  Once you have made desired changes, Save your work. 

 

Expected Results:  A note window will appear 
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Step Description:  Click Ok to the Note 

 

Expected Results:  Window will go away 
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Step Description:  Take note that Status on the PO is Requires Re-Approval, 

any changes made to a purchase order the purchase order will have to be re-

approved.  Click on the Approve button. 

 

Expected Results:  Approval Documents window will appear 

 

 
 

 

 

 

 

 

 

 

 

 

 

 

 

 



Page: 531 of 1264  

Step Description:  Remove the check mark from the Email box and click on 

the OK button 

 

Expected Results:  A Note window will appear 
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Step Description:  At the Note window, Document has been submitted for 

Approval, click OK 

 

Expected Results:  Return to the Purchase Order Summary Screen 

 

 
 

 

 

Step Description:  Take note that the Status on the Purchase order is now 

Approved. 

 

 

 

NOTE:  Any changes made to a Purchase Order require a new printed 

copy of the Purchase Order. 
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AMMS TRAINING SCRIPT 

Using Purchase Order Summary 
  

 

 

 

Purpose 

The purpose of this training script is to show how to get information on Purchase 
Orders from Purchase Order Summary 

 

Audience 

 

 

 

 

Prepared By Theresa Coulson 

Creation Date: 07/09/2008 

Document Name Purchase Order Summary.doc 

Version 2 

Last Updated: 11/23/2008 

The most current version of this training script can be found at 
GSFC-FileSRVC\270Public\279 IT\Training\AMMS Customer Training 
Docs\Published\Purchasing. 
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Step Description:  Sign onto Oracle and select your Purchasing responsibility 

 

Expected Results:  Purchasing responsibility will appear 
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Step Description:  From the Purchasing responsibility main menu select Purchase Orders 

> Purchase Order Summary click the open button 

 

Expected Results:  Find Purchase Order AMMS window will appear 
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Step Description:  From the Find Purchase Orders AMMS window you can search by 

many different criteria, here are some examples: 

 

You can enter a specific Purchase Order number in the Number field, click on find to see 

different information about the purchase order, lines, shipments, status 
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Step Description:  You can also enter a Buyer name and look for specific purchase orders 

that a specific buyer has done, you can also set a date range 
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Step Description: You can also look for purchase orders by the status, there are two 

different statuses Order Approval Status and Control Status 

 

These are the Order Approval Status 
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These are the Control Status 
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AMMS TRAINING SCRIPT 

Project Parts Changes to Established 
Purchase Order 

 
 

 

Purpose 

The purpose of this training script is to show buyers how to make changes to 
established purchase orders 

 

Audience 

Buyers 

 

 

 

Prepared By Theresa Coulson 

Creation Date: 05/10/2006 

Document Name View or Changes to Established 
Purchase Orders.doc 

Version 2 

Last Updated: 11/23/2008 

The most current version of this training script can be found at 
GSFC-FileSRVC\270Public\279 IT\Training\AMMS Customer Training 
Docs\Published\Purchasing. 
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Step Description:  Sign onto Oracle and select the Purchasing AMMS 

responsibility 

 

Expected Results:  The Purchasing AMMS main menu will appear 
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Step Description:  From the Purchasing AMMS main menu select Purchase 

Orders > Purchase Order Summary, click on the Open button 

 

Expected Results:  The Find Purchase Order screen will appear 
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Step Description:  In the Number field enter the purchase order number you 

want to view.  Click on the Find button 

 

Expected Results:  The Purchase Order Header window will appear 
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Step Description:  To make changes to an item on the purchase order click 

on the Open button.    

 

Expected Results:  The Purchase Order Summary to Purchase Order screen 

will appear 
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Step Description:  Update the any necessary information if you need to 

change the cost, click on the price field and update the cost.  If you need to 

change any other information select the field and make the appropriate 

changed.   

 

Expected Results:  Information will change 
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Step Description:  After you have made the changes to the purchase order, 

you MUST put the changes in the Note to Supplier field.  Click on the 

Terms button at the bottom of the screen. 

 

Expected Results:  Terms and Conditions window will appear 
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Step Description:  In the Note to Supplier field enter what was changed in 

this format:   

 

Use the Note to Supplier field for changes to PO only.    

 

Example: Change 2, April 10, 2006 (list the change number to the 

supplier along with the date, do not abbreviate) 

 

Added Line 12, PN 788978 

Deleted Line 3, PN 245895  

Added Line 16, Pre-cap Inspection, PN 78985  

Increased Quantity on Line 4, PN 898574, from 10 each to 15 

each. 

Decreased Quantity on Line 6, PN4568, from 12 each to 9 each 

 

Expected Results:  Field will be populated  
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Step Description:  Click on the Save button 

 

Expected Results:  Note Creating new document revision 

 

 
 

 

 

 

NOTE: YOU MUST PUT INFORMATION IN THE NOTE TO SUPPLIER 

FIELD FOR EVERY CHANGE THAT IS MADE TO A PO.  IF 

INFORMATION ALREADY EXISTS IN THE FIELD, GO TO THE END 

OF THAT STATEMENT AND START A NEW STATEMENT. 

 

 

 

 

 

 

 



Page: 549 of 1264  

 

 

 

Step Description:  Once you have made desired changes, Save your work. 

 

Expected Results:  A note window will appear 
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Step Description:  Click Ok to the Note 

 

Expected Results:  Window will go away 
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Step Description:  Take note that Status on the PO is Requires Re-Approval, 

any changes made to a purchase order the purchase order will have to be re-

approved.  Click on the Approve button. 

 

Expected Results:  Approval Documents window will appear 
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Step Description:  Remove the check mark from the Email box and click on 

the OK button 

 

Expected Results:  A Note window will appear 
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Step Description:  At the Note window, Document has been submitted for 

Approval, click OK 

 

Expected Results:  Return to the Purchase Order Summary Screen 

 

 
 

 

 

Step Description:  Take note that the Status on the Purchase order is now 

Approved. 

 

 

 

NOTE:  Any changes made to a Purchase Order require a new printed copy 

of the Purchase Order. 
 



Page: 554 of 1264  

 

 

 

AMMS RECEIVING 

TRAINING SCRIPTS 
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AMMS TRAINING SCRIPT 

Accept and Deliver a Standard Receipt 
  

 

 

 

Purpose 

The purpose of this training script is to provide detailed instructions on how to process a 

receipt for an item, receive, accept and deliver 

 

Audience 

Material coordinators, Supply Technicians, and Inspectors 

 

 

 

Prepared By Theresa Coulson 

Creation Date: 08/22/2005 

Document Name Accept and Deliver a Standard 
Receipt.doc 

Version 4 

Last Updated: 11/23/2008 

The most current version of this training script can be found at 
GSFC-FileSRVC\270Public\279 IT\Training\AMMS Customer Training 
Docs\Published\Receiving. 
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Step Description:  Sign onto Oracle and select the Receiving Inventory AMMS 

responsibility 

 

Expected Results:  Receiving Inventory AMMS main menu will appear 
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Step Description:  From the Receiving Inventory AMMS main menu select 

Transactions> Receiving>  Receiving Transactions, click on the Open button 

 

Expected Results:  Find Receiving Transactions window will appear 
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Step Description:  From the Organization window select the appropriate organization.  

GSF for Goddard or WFF for Wallops, click the OK button 

 

Expected Results:  Find Expected Receipts window will appear 
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Step Description:  At the Find Receiving Transactions window in the Purchase Order 

field enter the PO number for the material you are receiving, if known enter the stock 

number in the Item, Rev field click on the Find button 

 

Expected Results:  Receiving Transactions window will appear 
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Step Description:  In the bottom right hand corner, click on the Inspect button 

 

Expected Results:  Inspection Details window will appear 
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Step Description:  At the Inspection Details window click on the OK button 

 

Expected Results: Return to Receiving Transactions window 
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Step Description:  Save your work 

 

Expected Results:  Transactions Complete and Applied Message 
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Step Description:  From the toolbar select the flashlight to “refresh” your window 

 

Expected Results:  Return to the Find Receiving Transactions window 
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Step Description:  The Purchase Order field should be populated with the PO number.  

Click on the Find button 

 

Expected Results:  Receiving Transactions window will appear 
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Step Description:  Use the scroll bar move to the right until you see the Sub Inventory 

field, the Sub Inventory should already be populated, if not click on the List of Values 

(LOV) and select the appropriate Sub Inventory.  NEVER DELIVER MATERIAL TO 

THE STAGING SUB INVENTORY.   

 

Expected Results:  Field will be populated 
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Step Description:  Go to the Locator field, enter the locator that the material is physically 

located in.   

 

Expected Results:  Field will be populated 
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Step Description:  Save your work 

 

Expected Results:  Transactions Saved and Applied message 

 

 
 

 

 

Close all forms transactions complete 
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AMMS TRAINING SCRIPT 

Deliver Material to Inventory 
  

 

 

Purpose 

The purpose of this training script is to explain how to deliver a purchase order to 

inventory, once the material has physically been put into location. 

 

Audience 

Warehousemen, Inspectors, Material Coordinators, and  
Supply Technician Team Leads 

 

 

 

Prepared By Theresa Coulson 

Creation Date: 06/02/2005 

Document Name Deliver Material to Inventory.doc 

Version 3 

Last Updated: 11/23/2008 

The most current version of this training script can be found at 

GSFC-FileSRVC\270Public\279 IT\Training\AMMS Customer Training 

Docs\Published\Receiving. 
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Step Description:  Sign onto Oracle and select the IM Inventory AMMS responsibility 

 

Expected Results:  IM Inventory AMMS main menu will appear 
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Step Description:  From the IM Inventory AMMS main menu select Transactions> 

Receiving > Receiving Transactions, click on the Open button 

 

Expected Results:  Organization window will appear 
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Step Description:  From the Organization window select GSF click OK 

 

Expected Results:  Find Receiving Transactions window will appear 
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Step Description:  In the Find Receiving Transactions window enter the Purchase Order 

number and the Item number, click on the Find button 

 

Expected Results:  Receiving Transactions window will appear 
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Step Description:  Verify that this is the item that was put into location.  If all of the 

material went into one location use the scroll bar move to the right until you see the 

Sub Inventory field, the Sub Inventory should already be populated, if not click on the 

List of Values (LOV) and select the appropriate Sub Inventory.  NEVER DELIVER 

MATERIAL TO THE STAGING SUB INVENTORY.     

 

Expected Results:  Field will be populated 
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Step Description:  Go to the Locator field enter the locator that the material is physically 

located in.   

 

Expected Results:  Field will be populated 
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Step Description:  Save your work 

 

Expected Results:  Transactions Saved and Applied message 

 

 
 

 

 

Close all forms transactions complete 
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AMMS TRAINING SCRIPT 

Deliver Material to Inventory, 
Multiple Locators 

  

 

 

Purpose 

The purpose of this training script is to explain how to deliver a Bulk purchase order to 

inventory to multiple locators, once the material has physically been put into location. 

 

Audience 

Warehousemen, Inspectors, Material Coordinators, and  
Supply Technician Team Leads 

 

 

Prepared By Theresa Coulson 

Creation Date: 01/09/2006 

Document Name Deliver Material to Multiple 
Locators.doc 

Version 2 

Last Updated: 11/23/2008 

The most current version of this training script can be found at 
GSFC-FileSRVC\270Public\279 IT\Training\AMMS Customer Training 
Docs\Published\Receiving. 
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Step Description:  Sign onto Oracle and select the IM Inventory AMMS responsibility 

 

Expected Results:  IM Inventory AMMS main menu will appear 
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Step Description:  From the IM Inventory AMMS main menu select Transactions> 

Receiving > Receiving Transactions, click on the Open button 

 

Expected Results:  Organization window will appear 
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Step Description:  From the Organization window select GSF click OK 

 

Expected Results:  Find Receiving Transactions window will appear 
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Step Description:  In the Find Receiving Transactions window enter the Purchase Order 

number and the Item number, click on the Find button 

 

Expected Results:  Receiving Transactions window will appear 
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Step Description:  Verify that this is the item that was put into location.  If the material 

was put in to multiple locations, click in the Quantity field and change the qty that is 

being delivered, use the scroll bar move to the right until you see the Sub Inventory field, 

the Sub Inventory should already be populated, if not click on the List of Values (LOV) 

and select the appropriate Sub Inventory.  NEVER DELIVER MATERIAL TO THE 

STAGING SUB INVENTORY.     

 

Expected Results:  Qty field will change and field will be populated 

 

 

 
 

 

 

 

 

 

 

 

 

 

 

Step Description:  Go to the Locator field enter the locator that the material is physically 

located in.   
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Expected Results:  Field will be populated 

 

 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Step Description:  From the Tool Bar select your flashlight to re-fresh your screen 
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Expected Results:  Return to the Find Receiving Transactions window 

 

 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Step Description:  Click on the Find button 
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Expected Results:  Return to Receiving Transactions window 
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Step Description:  Repeat steps, check quantity if needed, scroll over to Sub Inventory, 

enter if necessary, move to Locator field, enter locator.  Repeat all steps the full quantity 

has been delivered to inventory. 

 

Expected Results:  Transactions Saved and applied 
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AMMS TRAINING SCRIPT 

Deliver Shelf Life Material 
To Inventory 

  

 

 

Purpose 

The purpose of this training script is to demonstrate how to deliver material to 
inventory that is shelf life (lot controlled). 

 

Audience 

Warehousemen, Inspectors, Material Coordinators, and Team Leads 

 

 

Prepared By Theresa Coulson 

Creation Date: 02/10/2005 

Document Name Deliver Shelf Life Material to 
Inventory.doc 

Version 3 

Last Updated: 11/23/2008 

The most current version of this training script can be found at 
GSFC-FileSRVC\270Public\279 IT\Training\AMMS Customer Training 
Docs\Published\Receiving. 
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Step Description:  Sign onto Oracle and select your Inventory responsibility. 

 

Expected Results:  Inventory Main Menu will appear 
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Step Description:  From the Inventory main menu select Transactions>Receiving > 

Receiving Transactions 

 

Expected Results:  Organization window will appear 
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Step Description:  Select the appropriate organization, GSF for Goddard or WFF for 

Wallops. 

 

Expected Results:  Find Receiving Transactions window will appear 
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Step Description:  In the Purchase Order field enter the PO that is being delivered to 

inventory.  You can also enter the item number in the Item,Rev field at the bottom of the 

screen.  Click on the Find button 

 

Expected Results: Fields will be populated and you will the Receiving Transactions will 

appear. 
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Step Description:  Click in the box to select the line, a check mark will appear. Tab to the 

Subinventory field, if the field is not populated click on the List of Values and select the 

appropriate Subinventory.  Tab to the Locator field and enter the location the material 

will be in the warehouse.   

 

Expected Results:  Field will be populated. 
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Step Description:  Click on the Lot-Seriel button at the bottom of the screen. 

 

Expected Results:  Lot Entry window will appear. 
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Step Description:  Place the curser in the Lot field and click on the Generate button, this 

will assign an Oracle Lot number to this item. 

 

Expected Results:  Lot number and expiration date will appear. 
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Step Description:  Place the curser in the Quantity field, enter the quantity that is being 

delivered. 

 

Expected Results:  Fields will be populated.   
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Step Description:  After you have generated the Lot and entered the Qty, write the lot 

number on your paperwork and  click on the Done button 

 

Expected Results:  You will return to the Receiving Transactions window. 
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Step Description: Save your work. 

 

Expected Results:  Transactions Saved and Applied message. 

 

 
 

 

 

 

 

Note:  You have just completed delivering a Shelf Life item to inventory.  Please make 

sure to take note of the lot number that Oracle generated and place it on the material.   
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AMMS TRAINING SCRIPT 

Process Direct Receipt 
  

 

 

 

Purpose 

The purpose of this training script is to provide detailed instructions on how to 
process a Direct Receipt. 

 

Audience 

Inspectors, Material Coordinators, and Supply Technicians 

 

 

 

Prepared By Theresa Coulson 

Creation Date: 08/19/2005 

Document Name Process Direct Receipt.doc 

Version 3 

Last Updated: 11/23/2008 

The most current version of this training script can be found at 
GSFC-FileSRVC\270Public\279 IT\Training\AMMS Customer Training 
Docs\Published\Receiving. 
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Step Description:  Sign onto Oracle and select your Receiving Inventory AMMS 

responsibility 

 

Expected Results:  Receiving Inventory main menu will appear 
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Step Description:  From the Receiving  Inventory AMMS main menu select Transactions 

> Receiving > Receipts, click on the open button 

 

Expected Results:  Organization window will appear 
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Step Description:  From the Organization window select the appropriate organization, 

GSF for Goddard, WFF for Wallops, click OK 

 

Expected Results:  Find Expected Receipts window will appear 
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Step Description:  At the Find Expected Receipts window enter the Purchase Order 

number, and if possible the Item number, click on the Find button 

 

Expected Results:  Receipt Header window will appear 
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Step Description:  Close the Receipt Header window 

 

Expected Results:  Receipts window will appear 
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Step Description:  Select the line that you want to receive, place a check mark in the box 

at the beginning of the line.   

 

Expected Results:  Line will be selected 
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Step Description:  Use the scroll bar and move to the right until you see the Sub 

Inventory and Locator fields 

 

Expected Results:  Window view will change 
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Step Description:  The Sub Inventory field should already be populated, if not click on 

the LOV and select the appropriate sub inventory, click in the locator field and enter the 

locator that the material is being delivered to.   

 

Expected Results:  Fields will be populated 

 

 
 

 

 

 

 

 

Note : NEVER choose the Staging sub inventory, if there are no other sub 

inventories, contact the appropriate Material Coordinator. 

 

**Short Cut:  At the locator field enter a % sign hit tab, this will bring up the 

locators assigned to this item  
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Step Description:  Go to the field at the end of the line with the [ ] and click in this field.  

This is a Descriptive Flex Field 

 

Expected Results:  Receiving Transactions window will appear 
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Step Description:  In the Dock Date field enter the date the material was physically 

delivered, example 18-AUG-2005, click OK 

 

Expected Results:  Return to the Receipts window 
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Step Description:  Save your work 

 

Expected Results:  Transactions Completed, Applied and Saved 
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AMMS TRAINING SCRIPT 

Process JIT Receipt 
  

 

 

 

Purpose 

The purpose of this training script is to provide instructions on how to process a 
JIT Receipt. 

 

Audience 

Inspectors, Material Coordinators, and Supply Technicians 

 

 

 

Prepared By Theresa Coulson 

Creation Date: 08/19/2006 

Document Name Process JIT Receipt.doc 

Version 3 

Last Updated: 11/23/2008 

The most current version of this training script can be found at 
GSFC-FileSRVC\270Public\279 IT\Training\AMMS Customer Training 
Docs\Published\Receiving. 
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Step Description:  Sign onto Oracle and select your IM Inventory AMMS responsibility 

 

Expected Results:  IM Inventory main menu will appear 

 

 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



Page: 611 of 1264  

Step Description:  From the IM Inventory AMMS main menu select Transactions > 

Receiving > Receipts, click on the open button 

 

Expected Results:  Organization window will appear 
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Step Description:  From the Organization window select the appropriate organization, 

GSF for Goddard, WFF for Wallops, click OK 

 

Expected Results:  Find Expected Receipts window will appear 
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Step Description:  At the Find Expected Receipts window enter the Purchase Order 

number, release number and Item number, click on the Find button 

 

Expected Results:  Receipt Header window will appear 
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Step Description:  Close the Receipt Header window 

 

Expected Results:  Receipts window will appear 
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Step Description:  Verify that this is the correct order, check the Location field , if the 

customer name matches the JIT receipt this is the correct line.  Select the line that you 

want to receive, place a check mark in the box at the beginning of the line.   

 

Expected Results:  Line will be selected 
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Step Description:  Use the scroll bar and move to the right until you see the Sub 

Inventory and Locator fields 

 

Expected Results:  Window view will change 
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Step Description:  The Sub Inventory field should already be populated, if not click on 

the LOV and select the appropriate sub inventory.   

 

Expected Results:  Fields will be populated 

 

 
 

 

 

 

Note : NEVER choose the Staging sub inventory, if there are no other sub 

inventories, contact the appropriate Material Coordinator. 
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Step Description:  Go to the field at the end of the line with the [ ] and click in this field.  

This is a Descriptive Flex Field 

 

Expected Results:  Receiving Transactions window will appear 
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Step Description:  In the Dock Date field enter the date the material was physically 

delivered, example 18-AUG-2005, click OK 

 

Expected Results:  Return to the Receipts window 
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Step Description:  Save your work 

 

Expected Results:  Transactions Completed, Applied and Saved 
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AMMS TRAINING SCRIPT 

Process Standard Receipt 
  

 

 

 

Purpose 

The purpose of this training script is to provide detailed instructions on how to process a 

receipt for an item, receive, accept and deliver 

 

Audience 

Material Coordinators, Supply Technicians, and Inspectors 

 

 

 

Prepared By Theresa Coulson 

Creation Date: 08/22/2005 

Document Name Process Standard Receipt.doc 

Version 2 

Last Updated: 11/23/2008 

The most current version of this training script can be found at 
GSFC-FileSRVC\270Public\279 IT\Training\AMMS Customer Training 
Docs\Published\Receiving. 
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Step Description:  Sign onto Oracle and select the Receiving Inventory AMMS 

responsibility 

 

Expected Results:  Receiving Inventory AMMS main menu will appear 
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Step Description:  From the Receiving Inventory AMMS main menu select Transactions 

> Receiving > Receipts, click on the Open button 

 

Expected Results:  Organization window will open 
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Step Description:  From the Organization window select the appropriate organization.  

GSF for Goddard or WFF for Wallops, click the OK button 

 

Expected Results:  Find Expected Receipts window will appear 
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Step Description:  In the Purchase Order field enter the PO number for the material that 

you are receiving, in the Item, Rev field enter the stock number for the item if known, 

click on the Find button 

 

Expected Results:  Receipt Header window will appear 
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Step Description:  Close the Receipt Header window 

 

Expected Results:  Receipts window will appear 
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Step Description:  At the Receipts window, place a check mark in the box at the 

beginning of the line, this will select the line that you want to receive.   

 

Expected Results:  Line will be selected 
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Step Description:  Go to the field at the very end of the line with [ ], this is the 

Descriptive Flex Field, click in this field 

 

Expected Results:  Receiving Transactions window will appear 
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Step Description:  In the Dock Date field enter the date the material was physically 

delivered, example 19-AUG-2005, click the OK button 

 

Expected Results:  Field will be populated and return to Receipts window 
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Step Description:  Save your work 

 

Expected Results:  Transaction Completed message 
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Step Description:  Close all forms and return to the Receiving Inventory AMMS main 

menu 

 

Expected Results:  Receiving Inventory Main menu appears 
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Step Description:  From the Receiving Inventory AMMS main menu select Receiving 

Transactions, click on the Open button 

 

Expected Results:  Find Receiving Transactions window will appear 
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Step Description:  At the Find Receiving Transactions window in the Purchase Order 

field enter the PO number for the material you are receiving, if known enter the stock 

number in the Item, Rev field click on the Find button 

 

Expected Results:  Receiving Transactions window will appear 
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Step Description:  In the bottom right hand corner, click on the Inspect button 

 

Expected Results:  Inspection Details window will appear 
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Step Description:  At the Inspection Details window click on the OK button 

 

Expected Results: Return to Receiving Transactions window 
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Step Description:  Save your work 

 

Expected Results:  Transactions Complete and Applied Message 
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Step Description:  From the toolbar select the flashlight to “refresh” your window 

 

Expected Results:  Return to the Find Receiving Transactions window 
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Step Description:  The Purchase Order field should be populated with the PO number.  

Click on the Find button 

 

Expected Results:  Receiving Transactions window will appear 
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Step Description:  Use the scroll bar move to the right until you see the Sub Inventory 

field, the Sub Inventory should already be populated, if not click on the List of Values 

(LOV) and select the appropriate Sub Inventory.  NEVER DELIVER MATERIAL TO 

THE STAGING SUB INVENTORY.   

 

Expected Results:  Field will be populated 
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Step Description:  Go to the Locator field, enter the locator that the material is physically 

located in.   

 

Expected Results:  Field will be populated 
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Step Description:  Save your work 

 

Expected Results:  Transactions Saved and Applied message 

 

 
 

 

 

Close all forms transactions complete 
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AMMS TRAINING SCRIPT 

Rejecting Material 
  

 

 

 

Purpose 

The purpose of this training script is to show how aq Purchase order is rejected 
in AMMS 

 

Audience 

Inspectors, Material Coordinators, and Supply Technician Team Leads 

 

 

 

Prepared By Theresa Coulson 

Creation Date: 06/21/2005 

Document Name Rejecting Material.doc 

Version 2 

Last Updated: 11/23/2008 

The most current version of this training script can be found at 
GSFC-FileSRVC\270Public\279 IT\Training\AMMS Customer Training 
Docs\Published\Receiving. 
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Step Description:  Sign onto Oracle and select the IM Inventory AMMS responsibility 

 

Expected Results:  IM Inventory AMMS main menu will appear 
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Step Description:  From the IM Inventory AMMS main menu select Transactions > 

Receiving > Receiving Transactions click on the open button 

 

Expected Results:  Organization window will appear 
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Step Description:  Choose the appropriate organization GSF for Goddard or WFF for 

Wallops click the OK button 

 

Expected Results:  Find Receiving Transactions window will appear 
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Step Description:  In the Purchase Order field enter the purchase order that you want to 

reject, click on the Find button 

 

Expected Results:  Receiving Transactions window will appear 
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Step Description:  Verify that all of the data is correct, PO number, item number.  Click 

on the Inspect button at the bottom right of the screen 

 

Expected Results: Inspection Details window will appear 
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Step Description:  At the Inspection Details window in the Status field click on the arrow, 

then select Reject from the options 

 

Expected Results:  Status field will have Reject 
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Step Description:  Still in the Inspection Details window go to the Quality Code field and 

click on the List of Values, select the best reason that applies to why you are rejecting 

this material, click Ok 

 

Expected Results:  Field will be populated 
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Step Description:  Click on the OK button at the Inspection Details window 

 

Expected Results:  Return to Receiving Transaction window 
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Step Description:  Save your work 

 

Expected Results:  Transaction Saved and Applied message 

 

 
 

 

 

 

 

Close all forms.   

 

NOTE:  You are still required to write up a Receiving Discrepancy form and forward to 

the appropriate Material Manager for corrective action. 
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AMMS TRAINING SCRIPT 

View Receiving Transactions 
  

 

 

 

Purpose 

The purpose of this training script is to walk you though looking at a Purchase 
Order that has been received 

 

Audience 

Supply Technicians, Supply Team Leads, and Material Coordinators 

 

 

 

Prepared By Theresa Coulson 

Creation Date: 04/07/2005 

Document Name View Receiving Transactions.doc 

Version 2 

Last Updated: 11/23/2008 

The most current version of this training script can be found at 
GSFC-FileSRVC\270Public\279 IT\Training\AMMS Customer Training 
Docs\Published\Receiving. 
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Step Description:  Sign onto Oracle and select the IM Inventory AMMS responsibility 

 

Expected Results:  IM Inventory main menu will appear 
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Step Description:  From the IM Inventory AMMS main menu select Transactions > 

Receiving > View Receiving Transactions, click on the open button 

 

Expected Results: The organization window will appear 
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Step Description:  Select the appropriate organization, GSF for Goddard or WFF for 

Wallops, click OK 

 

Expected Results:  Find Receiving Transactions window will open 
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Step Description:  In the Purchase Order field enter the Purchase Order number for the 

material, then at the bottom of the form, in the Item, Rev field enter the Item Number 

(Stock Number), click on the Find button 

 

Expected Results:  Receiving Headers Summary window will open 
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Step Description:  Click on the Transactions button at the bottom right of the Receiving 

Headers Summary window 

 

Expected Results:  Receiving Transactions Summary window will open 
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Step Description:  The Receiving Transactions Summary window will give you details 

about the receipt that was processed.  It will tell you if all three transactions have been 

processed, the dates the material was received, and the quantity received.   

 

Expected Results:  Window will have data 
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Step Description:  To see who specifically processed the transaction, from the Toolbar 

select Help > Record History 

 

Expected Results:  About this Record window will open 
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Step Description:  The About this Record window will tell you who processed the receipt 

and what time: to close this window click OK 

 

Expected Results:  About this Record window will close: 

 

 
 

 

 

Note: To view another receipt summary use the Flashlight from the Toolbar and the Find 

Receiving Transactions window will appear 
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AMMS TRAINING SCRIPT 

Auto Create and Backorder Item on 
Pick Slip 

  

 

 

Purpose 

The purpose of this training script is to explain how to Auto Create a delivery number, 

and backorder lines on a pick slip. 

 

Audience 

Warehousemen, Material Coordinators, and Supply Technicians 

 

Prepared By Theresa Coulson 

Creation Date: 06/01/2005 

Document Name Auto Create delivery and Backorder 
item on Pick Slip.doc 

Version 2 

Last Updated: 11/23/2008 

The most current version of this training script can be found at 
GSFC-FileSRVC\270Public\279 IT\Training\AMMS Customer Training 
Docs\Published\Warehouse\. 

     



Page: 663 of 1264  

Step Description:  Sign onto Oracle and select OM User AMMS responsibility 

 

Expected Results:  OM User AMMS main menu will appear 
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Step Description:  From the OM User AMMS main menu select Shipping> Shipping 

Transactions, click on the Open button 

 

Expected Results:  Query Manager window will appear 
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Step Description:  In the Order number field enter the sales order number for the pick slip 

you are working with, enter the sales order number in both field, then click on the Find 

button 

 

Expected Results:  Shipping Transactions window will appear 
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Step Description:  You want to transact against the line that does not have a delivery 

number, and the line status is Staged/Pick Confirm, make sure that the blue line indicator 

is next to the appropriate line.  In the Actions field at the bottom of the screen select 

Auto-Create Deliveries, then click the Go button. 

 

Expected Results:  Delivery field will be populated with a number 
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Step Description:  For the line that you want to backorder, make sure the blue line 

indicator is next to the appropriate line, then click on the Delivery tab at the bottom of the 

screen 

 

Expected Results:  Window view will change 
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Step Description:  At the Delivery Tab, in the Action field at the bottom of the screen 

select Ship Confirm, click on the Go button 

 

Expected Results:  Confirm Delivery window will appear 
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Step Description:  In the Ship Options section, select the Backorder All option, then click 

the OK button 

 

Expected Results:  Return to the Shipping Transaction window 
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Step Description:  To verify that the transaction is complete, from the toolbar select the 

Flashlight to re-query the record. Click on the Find button 

 

Expected Results:  Query Manager window will appear 
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Step Description:  Line status is not backordered.  Transaction successful.  Close all 

forms, transactions complete. 

 

Expected Results:  Return to OM User AMMS main menu 
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AMMS TRAINING SCRIPT 

View On Hand Qty 
  

 

 

 

Purpose 

The purpose of this training script is to explain how to ship confirm customer pick slips 

in Oracle, this script is only to be used when shipping a complete order with no quantity 

variances.  

 

Audience 

Warehousemen 

 

 

 

Prepared By Theresa Coulson 

Creation Date: 06/01/2005 

Document Name Ship Confirm Complete Pick Slip.doc 

Version 2x 

Last Updated: 11/23/2008 

The most current version of this training script can be found at 
GSFC-FileSRVC\270Public\279 IT\Training\AMMS Customer Training 
Docs\Published\Warehouse\. 
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Step Description:  Sign onto Oracle and select the OM User responsibility 

 

Expected Results:  OM User AMMS main menu will appear 
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Step Description:  From the OM User AMMS main menu select Shipping > Shipping 

Transactions, click on the Open button 

 

Expected Results:  Query Manager window will appear 
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Step Description:  In the Order Number field enter the sales order number for the pick 

slip that you want to close you need to enter this number in both fields.  Click on the Find 

button 

 

Expected Results:  Shipping Transaction window will appear 
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Step Description:  Verify that this is the order that you want closed, use the scroll bar 

verify the item number and the requested qty.  Once you have done this click on the 

Delivery tab at the bottom of the screen. 

 

Expected Results:  Screen view will change 
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Step Description:  Once you have verified that this is the correct order, in the Actions 

field, select Ship Confirm, click on the Go button 

 

Expected Results:  Confirm Delivery window will appear 
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Step Description:  Make sure that the Ship Entered Quantities button is selected, Click 

Ok 

 

Expected Results:  Return to the Shipping Transactions window 
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Step Description:  To verify that the order is closed, re-query the record.  Select from the 

toolbar the Flashlight, the Query Manger window will appear, click on the Find button, 

the screen should be blank 

 

Expected Results:  Screen will be blank 
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AMMS TRAINING SCRIPT 

Split Line on a Pick Slip  
When Ship Confirming 

  

 

 

Purpose 

The purpose of this training script is to explain how to ship partial quantity when ship 

confirming a pick slip. 

 

Audience 

Warehousemen, Inspectors, and Material Coordinators 

 

 

 

Prepared By Theresa Coulson 

Creation Date: 01/09/2006 

Document Name Split Line on Pick Slip.doc 

Version 2 

Last Updated: 11/23/2008 

The most current version of this training script can be found at 
GSFC-FileSRVC\270Public\279 IT\Training\AMMS Customer Training 
Docs\Published\Warehouse\. 
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Step Description:  Sign onto Oracle and select the OM User AMMS responsibility  

 

Expected Results:  OM User AMMS main menu will appear 
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Step Description:  From the OM User main menu select Shipping > Shipping 

Transactions, click on the Open button 

 

Expected Results:  Query Manager window will appear 
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Step Description:  In the Order Number field enter the sales order that you want to 

transact against, enter the number in both fields, click on the Find button 

 

Expected Results:  Shipping Transaction window will appear 
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Step Description:  If you are only able to full partial quantity for one of the lines you need 

to split the line.  Make sure that the blue cursor is next to the line you are shipping for the 

partial qty.  From the Actions at the bottom of the screen select Split Line 

 

Expected Results:  Action menu will change 
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Step Description:  Click on Go   

 

Expected Results:  Split Delivery Line window will appear 
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Step Description:  In the Quantity to Split field enter the quantity that is NOT being 

shipped, click OK 

 

Expected Results:  Line will split, you will have different detail number, but the same 

item and delivery number 
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Step Description:  If you scroll to the right you will seen the quantities for each line.  If 

you only want to ship one line to MUST Un-Assign the other line from delivery. 

 

Expected Results:  Line Qty will be different 
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AMMS TRAINING SCRIPT 

Un-Assign Item from Delivery  
on Pick Slip 

 

 

 

Purpose 

The purpose of this training script is to explain how to unassign items from a 
pick delivery 

 

Audience 

Warehousemen 

 

 

 

Prepared By Theresa Coulson 

Creation Date: 06/01/2005 

Document Name Un-Assign Item from Delivery on a 
Pick Slip.doc 

Version 2 

Last Updated: 11/23/2008 

The most current version of this training script can be found at 
GSFC-FileSRVC\270Public\279 IT\Training\AMMS Customer Training 
Docs\Published\Warehouse\. 
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Step Description:  Sign onto Oracle and select the OM User AMMS responsibility  

 

Expected Results:  OM User AMMS main menu will appear 
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Step Description:  From the OM User main menu select Shipping > Shipping 

Transactions, click on the Open button 

 

Expected Results:  Query Manager window will appear 
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Step Description:  In the Order Number field enter the sales order that you want to 

transact against, enter the number in both fields, click on the Find button 

 

Expected Results:  Shipping Transaction window will appear 
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Step Description:  If you were unable to fill one of the items on the order you need to  

Un-assign the item from the delivery.  Make sure the blue indicator is next to the item 

you want to us-assign.  In the Actions field at the bottom of the screen select un-assign 

from delivery and then click the Go button.   

 

Expected Results:  This will remove the delivery number from this line on the order 

 

 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



Page: 693 of 1264  

Step Description:  This line has been unassigned from this delivery, the remaining items 

on the order can be ship confirmed. 

 

Expected Results:  One line still open 
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AMMS TRAINING SCRIPT 

Assign Locator to Item at Organization 
Level 

 

 

 

Purpose 

The purpose of this training script is to walk you through how to assign a locator to an 

item at the organization level 

 

Audience 

Warehousemen, Material Coordinator, Inspectors, and  
Supply Technician Team Leads 

 

 

 

Prepared By Theresa Coulson 

Creation Date: 06/02/2005 

Document Name Add locator at Organization 
Level.doc 

Version 2 

Last Updated: 11/23/2008 

The most current version of this training script can be found at 
GSFC-FileSRVC\270Public\279 IT\Training\AMMS Customer Training 
Docs\Published\Inventory. 
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Step Description:  Sign onto Oracle and select the IM Inventory AMMS responsibility 

 

Expected Results:  The IM Inventory AMMS main menu will appear 
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Step Description:  From the IM Inventory AMMS main menu select, Items > 

Organization Items, click on the Open button 

 

Expected Results:  Organization window will appear 
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Step Description:  From the Organization window select GSF, click OK 

 

Expected Results:  Find Organization Items window will appear 
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Step Description:  At the Find Organizations Items window in the Item field enter the 

item number you want to assign the locator to, the click on the Find button 

 

Expected Results:  Field will be populated and Organization Item window will appear 
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Step Description:  From the toolbar select Tools > Item Sub Inventories 

 

Expected Results:  Item Sub Inventory window will appear 
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Step Description:  At the Item Sub Inventory window select the appropriate sub 

inventory, NEVER ASSIGN LOCATORS TO STAGING SUB INVENTORY, you will 

see locators at the bottom of the screen.   

 

Expected Results:  Field will be populated 
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Step Description:  At the bottom of the screen in the next available line enter the locator 

you want to assign to this item 

 

Expected Results:  Field will turn white and will be populated 
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Step Description:  Save your work 

 

Expected Results:  Transaction Saved and Applied message 
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Step Description:  Close Item Sub Inventory window 

 

Expected Results:  Return to Organization Items window 

 

 
 

 

 

 

 

 

 

NOTE:   To add locators to multiple items, once you are at the Organization Item 

window from the keyboard hit the F11 button, screen will go blank and fields will turn 

blue, enter new item number, hold down Ctrl button and hit F11 again, new item number 

information will appear.   



Page: 705 of 1264  

 

 

AMMS TRAINING SCRIPT 

Adding New Manufacturer 
  

 

 

 

Purpose 

The purpose of this training script is to give direction on how to enter a new 
manufacturer and cage code 

 

Audience 

Material Coordinator and Supply Team Leads 

 

 

 

Prepared By Theresa Coulson 

Creation Date: 03/15/2005 

Document Name Add New Manufacturer.doc 

Version 2 

Last Updated: 11/23/2008 

The most current version of this training script can be found at 
GSFC-FileSRVC\270Public\279 IT\Training\AMMS Customer Training 
Docs\Published\Inventory. 
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Step Description:  Sign onto Oracle and select the Inventory responsibility. 

 

Expected Results:  Inventory main menu will appear 
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Step Description:  Select Items > Manufacturers‟ Part Numbers > By Manufacturer 

 

Expected Results: Organizations window will appear 
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Step Description:  Select the appropriate organization.  GSF for Goddard, WFF for 

Wallops. 

 

Expected Results:  Manufacturers window will open with existing list of manufacturers. 
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Step Description:  To add a new manufacturer and cage code place the cursor in a line 

with data, then from the tool bar select the icon with the green + sign. 

 

Expected results:  This will provide a blank line  
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Step Description:  In the blank line in the manufacturer column enter the new 

manufacturers‟ name, then tab to the description field and enter the cage code for the 

manufacturer. 

 

Expected Results:  Fields will be populated. 
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Step Description:  Save your work. 

 

Expected Results:  Transaction complete, record saved and applied message at bottom of 

screen. 

 

 
 

 

 

Transaction complete. 
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AMMS TRAINING SCRIPT 

ADDING A NEW  ITEM  

TO ORACLE 

 
 

 

Purpose 

The purpose of this training script is to demonstrate how a Material Coordinators and 

Supply Technician Lead  add a new  stock number to the Oracle data base.  After the item 

has been added to the system you also have to add it to BOTH Master Price Lists (GSF 

and WFF).  

 

Audience 

Material Coordinator and Supply Technician Leads 

 

 

 

Prepared By Theresa Coulson 

Creation Date: 11/05/2004 

Document Name AMMS Create New Item Number.doc 

Version 3 

Last Updated: 11/23/2008 

The most current version of this training script can be found at 
GSFC-FileSRVC\270Public\279 IT\Training\AMMS Customer Training 
Docs\Published\Inventory. 

 



Page: 713 of 1264  

Step Description:  Sign on to Oracle Applications and Select User Responsibility “IM 

Inventory AMMS” 

 

Expected Results/Actions:  Oracle Displays the Inventory main Menu 

 

 

Step Description:  Select “Items” then “Master Items” 

 

Expected Results/Actions:  Organization form opens. 
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Step Description:  Select “AMS” as the Organization and Click OK 

 

Expected Results/Actions:  Blank Master form opens. 
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Step Description:  Enter the New Item Number 

 

Expected Results/Actions: Field is Populated. 
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Step Description:  Click on the Description Field 

 

Expected Results/Actions:  Cursor moves. 
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Step Description:  Enter an Abbreviated Description (noun) for the item 

 

Expected Results/Actions:  Field is Populated. 
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Step Description:  Click on the Long Description field at the bottom of the screen 

 

Expected Results/Actions:  Cursor moves 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



Page: 719 of 1264  

Step Description:  Enter the Entire Item Description. 

Expected Results/Actions:  Field is Populated. 
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Step Description:  Click on the Primary Unit of Measure field and change if necessary 

from List of Values (LOV) then Click OK  Please remember to select the correct 

Primary UOM as to this field can never be changed. 

 

Expected Results/Actions:  U/I is updated 
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Step Description:  Navigate to the Purchasing Tab, go to the Unit of Issue field and select 

the Unit of Issue from the LOV, this should match the Primary UOM. 

 

Expected Results/Actions:  Purchasing Unit of Issue is changed 
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Step Description:  Save Information Entered 

 

Expected Results/Actions:  Transaction Complete Message at the bottom of the form. 
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Step Description:  Navigate to “Tools” and choose “Categories 

 

Expected Results:  Category form opens. 
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Step Description:  At the Category Set field click on the LOV and  choose “Inventory”  

 

Expected Results/Actions:  Field is Populated. 
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Step Description:  Tab to Category and Enter the Correct Category, NASA 

INVENTORY ACCOUNT CODE (NIAC) for that new item number, SAVE and CLOSE 

form.  A list of NIAC is included.  

 

Expected Results/Actions:  Transaction Complete Message at the bottom of the form. 
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Step Description:  Navigate to “Tools” and choose “Copy From” 

 

Expected Results/Actions:  Copy From form opens 
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Step Description:  Click on the LOV and select item type that you are loading.  To copy 

an Item Template. Click “Apply” then click “Done” 

Expected Results/Actions:  Note Message will appear 
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Step Description:  Note Window will appear with message “The following attributes of 

the Purchased Item Template were not copied: Include in Roll UP.  Click OK to this 

Note. 

 

Expected Results/Actions:  Window will close, Returns to the Master Items form with 

“Template Implemented” message at the bottom of the form. 
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Step Description:  Navigate to the “Purchasing” Tab and verify the  UN code it will 

default to CO3 if different change UN code. 

 

Expected Results/Actions:  Field is Populated. 
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Step Description: At the “Purchasing” Tab enter the “List and Market Price” of the item 

 

Expected Results/Actions:  Fields are Populated 
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Step Description:  Navigate to “Tools” and choose “Manufacturer Part Number” 

 

Expected Results/Actions:  Manufacturer Form is opened 
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Step Description:  Choose the Manufacture from the LOV and enter the part number. 

Click on “Save” then close the form. 

 

Expected Results/Actions:  Manufacture information is populated 
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Step Description:  Navigate to “Tools” and choose “Organization Assignment” 

 

Expected Results/Actions:  Organization Assignment form is opened. 
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Step Description :  Click on the white box next to GSF and WFF, click Save.   

 

Expected Results/Actions:  AMS, GSF and WFF have check marks next to them. 
 

 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



Page: 735 of 1264  

Step Description:  From the Organization Assignments screen click on the GSF and then 

click on the Org Attributes button at the bottom of the screen 

 

Expected Results/Actions:  Organization Item window appears 
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Step Description:  Verify that all of the information at the Organization Level is the same 

as the information you entered at the Master Level.   Navigate to “Tools” and choose 

“Item Sub inventory” 

 

Expected Results/Actions:  Item Sub inventory Form opens 
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Step Description:  Choose the correct primary sub-inventory from the LOV then click 

“OK”. While on the primary sub-inventory, check the box for Min Max Planning.  Click 

on the Locator field at the bottom of the screen and enter Receiving as the Locator.   All 

items MUST also be assigned to the Staging sub-inventory.    

 

Expected Results/Actions:  Sub-inventory and Locator Information is Populated 

 
Close the Item Sub Inventory window. 
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Step Description:  At the Organization Items (GSF) window, select the “Receiving” Tab 

 

Expected Results/Actions:  You will be at the Receiving Tab 
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Step Description:  In the Receiving Sub Inventory field click on the LOV and enter the 

same primary sub inventory as you did for the sub-inventory screen. 

 

Expected Results/Actions:  Field will be populated  

 

 
 

 

 

Step Description:  Click on “Save” and close form 

 

Expected Results/Actions:  Transaction Complete Message. 

 

Note:  Store Stock item will need to add sub-inventories to both Organizations GSF and 

WFF. 
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Step Description:  Close the GSF Organization Item screen and select the WFF Wallops 

Organization assignment click on the Organization Attributes button at the bottom of the 

screen 

 

Expected Results:  The Wallops Organization Item window will appear. 
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Step Description:  Verify all data is the same as the Master Item Record and add the 

appropriate sub inventories following the same steps for the GSF Organization. 

 

Expected Results/Actions:  Sub inventories will be assigned. 

 

 

 

Step Description:  Save your work and close all forms. 

 

Expected Results/Actions:  Will be back at the IM Inventory AMMS Menu 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



Page: 742 of 1264  

Step Description:  Change responsibilities to the OM USER Responsibility 

 

Expected Results/Actions:  The OM USER main menu will appear 
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Step Description:  Select Price Lists> Price List from the menu and click on open 

 

Expected Results/Actions:   A blank Price List screen will appear 
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Step Description:  On your keyboard hit the F11 button to send Oracle into query mode, 

then hold down the Ctrl button and hit F11 again to end the query.   

 

Expected Results/Actions:  The Goddard Price List will appear 
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Step Description:  At the bottom of the Goddard Price List window, in the List Line 

section, click on an occupied line then click on the green plus sign (+) on the tool bar to 

add a new line, make sure you are at the bottom of the screen. 

 

Expected Results/Actions:  A blank line will appear and the Item field will be yellow 
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Step Description:  In the Item field click on the LOV and select Item from the list, tab to 

the Product Attribute field and click on the LOV and select Item Number from the list.  In 

the Product Value field enter the Item number you just loaded. 

 

Expected Results/ Actions:  All fields will be populated 
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Step Description:  Tab over to the value field and enter the cost for the item.  Example:  

1.55 

 

Expected Results/ Actions:  Field will be populated with cost. 
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Step Description:  Save your work and close all forms, Repeat the same process for the 

Wallops Price List. 

 

Expected Results/Actions:  Transactions Complete and Applies message at the bottom of 

screen, and will return to OM USER main menu. 

 

 

This stock number is now loaded and on the Price List.  
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AMMS TRAINING SCRIPT 

Approve Cycle Counts 
  

 

 

 

Purpose 

The purpose of this training script is to give instructions on how to approve 
items that have been cycle counted and required an adjustment 

 

Audience 

Material Coordinators and Supply Technician Leads 

 

 

 

Prepared By Theresa Coulson 

Creation Date: 12/13/2004 

Document Name Approve Cycle Counts.doc 

Version 2 

Last Updated: 11/23/2008 

The most current version of this training script can be found at 
GSFC-FileSRVC\270Public\279 IT\Training\AMMS Customer Training 
Docs\Published\Inventory. 
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Step Description:  Sign onto Oracle and select the IM Inventory AMMS 

responsibility: 

 

Expected Results:  You will be at the IM Inventory Main Menu: 
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Step Description:  From the IM Inventory AMMS main menu select 

Counting > Cycle Counting > Approve Counts 

 

Expected Results:  The Organizations window will appear 
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Step Description:  Choose the appropriate organization GSF for Goddard or 

WFF for Wallops click OK 

 

Expected Results:  The Count Adjustments Approvals Summary window 

will open  
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Step Description:  In the Cycle Count field click on the LOV and select the 

name of the cycle count you are conducting.  Click on the Find button. 

 

Expected Results:  Field will be populated with cycle count name and a 

Decision window will appear 
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Step Description:  At the Decision window answer the questions “Query 

counts pending approval only?” click on Yes. 

 

Expected Results:  Information will be populated at the bottom of the screen 
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Step Description:  Once you have completed your research and are ready to 

adjust the balance, click on the “approve” button and then save your work. 

 

Expected Results:  The “approve” button will be selected 
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Step Description:  Save your work. 

 

Expected Results:  Note window will appear 

 

 
 

 

Step Description:  Click on Ok to the APP-INV note telling you the 

Adjustments have been processed. 

 

Expected Results:  Transaction Complete message at bottom of screen 

 

 

 

 

Notes:  This step must be done before the final inventory reports are ran, 

balances will not adjust until the counts entered are approved. 
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AMMS TRAINING SCRIPT 

ADDING EXPENSE ITEM TO 

ORACLE 
  

 

 

Purpose 

The purpose of this training script is to demonstrate how a Material Coordinators and 

Supply Technician Lead will add a new Expense stock number to the Oracle data base.  

After the item has been added to the system you also have to add it to BOTH Mater Price 

Lists (GSF and WFF).  

 

Audience 

Material Coordinators and Supply Technician Leads 

 

 

 

Prepared By Theresa Coulson 

Creation Date: 11/05/2004 

Document Name Create Expense Item Number.doc 

Version x 

Last Updated: 11/23/2008 

The most current version of this training script can be found at 
GSFC-FileSRVC\270Public\279 IT\Training\AMMS Customer Training 
Docs\Published\Inventory. 
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Step Description:  Sign on to Oracle Applications and Select User Responsibility “IM 

Inventory AMMS” 

 

Expected Results/Actions:  Oracle Displays the Inventory main Menu 

 

 

Step Description:  Select “Items” then “Master Items” 

 

Expected Results/Actions:  Organization form opens. 

 

 

 

 

 

 

 

Step Description:  Select “AMS” as the Organization and Click OK 
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Expected Results/Actions:  Blank Master form opens. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Step Description:  Enter the New Item Number 
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Expected Results/Actions: Field is populated. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Step Description:  Click on the Description Field 
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Expected Results/Actions:  Cursor moves. 
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Step Description:  Enter an Abbreviated Description (noun) for Expense items the Noun 

could possibly be the Vendor Name 

 

Expected Results/Actions:  Field is populated. 
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Step Description:  Click on the Long Description field at the bottom of the screen 

 

Expected Results/Actions:  Cursor moves 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



Page: 764 of 1264  

Step Description:  Enter the Entire Item Description then, if the Noun is the Vendor name 

enter the Vendor information in the Description field 

 

Expected Results/Actions:  Field is populated. 
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Step Description:  Click on the Primary Unit of Measure field and change if necessary 

from List of Values (LOV) then Click OK Please remember to select the correct 

Primary UOM as to this field can never be changed. 

 

Expected Results/Actions:  U/I is updated 
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Step Description:  Navigate to the Purchasing Tab and select the Unit of Issue from the 

LOV; this should match the Primary UOM. 

 

Expected Results/Actions:  Purchasing Unit of Measure is changed 

 

 

 

 

 

 

 

 

 

 

 

 

 



Page: 767 of 1264  

Step Description:  Save Information Entered 

 

Expected Results/Actions:  Transaction Complete Message at the bottom of the form. 
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Step Description:  Navigate to “Tools” and choose “Categories 

 

Expected Results:  Category form opens. 
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Step Description:  At the Category Set field click on the LOV and choose “Inventory”  

 

Expected Results/Actions:  Field is populated. 
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Step Description:  Tab to Category and Enter the Correct Category (NIAC) for that new 

item number, SAVE and CLOSE form. 

 

Expected Results/Actions:  Transaction Complete Message at the bottom of the form. 
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Step Description:  Navigate to “Tools” and choose “Copy From” 

 

Expected Results/Actions:  Copy From form opens 
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Step Description:  Click on the LOV and select “EXPENSE” to copy an Item Template. 

Click “Apply” then click “Done” 

Expected Results/Actions:  Note Message will appear 
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Step Description:  Note Window will appear with message “The following attributes of 

the Purchased Item Template were not copied: Include in Roll UP.  Click OK to this 

Note. 

 

Expected Results/Actions:  Window will close, Returns to the Master Items form with 

“Template Implemented” message at the bottom of the form. 
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Step Description:  Navigate to the “Purchasing” Tab and verify the UN code it will 

default to CO3 if different change UN code. 

 

Expected Results/Actions:  Field is populated. 
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Step Description:  “Purchasing” Tab enter the “List and Market Price” of the item 

 

Expected Results/Actions:  Field is populated 
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Step Description:  At the Purchasing Tab in the Expense Account Field, change the GL 

number to:  

AM.0000.00.0000.00.59050.000 – for Auto Part Expense Items 

AM.0000.00.0000.00.59060.000- for EEE Expense Items 

AM.0000.00.0000.00.59070.000 – for Furniture Expense Items 

AM 0000.00.0000.00.59061.000 – for Special EEE Expense Items 

 

Expected Results:  Account Number will change 
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Step Description:  Navigate to “Tools” and choose “Manufacturer Part Number” 

 

Expected Results/Actions:  Manufacturer Form is opened 
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Step Description:  Choose the Manufacture from the LOV and enter the part number. 

Click on “Save” then close the form. 

 

Expected Results/Actions:  Manufacture information is populated 
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Step Description:  Navigate to the “Inventory” Tab if the Inventory box is already 

unchecked, ok but if not un-check the Inventory box, this will also uncheck the Stockable 

and Transactable boxes, Save your work 

 

Expected Results/Actions:  Check boxes un-checked and Transactions Saved and Applies 
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Step Description:  Navigate to “Tools” and choose “Organization Assignment” 

 

Expected Results/Actions:  Organization Assignment form is opened. 
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Step Description :  Click on the white box next to GSF and WFF 

 

Expected Results/Actions:  All GSF and WFF have check marks next to them. 

 

 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



Page: 782 of 1264  

 

Step Description:  From the Organization Assignments screen click on the GSF and then 

click on the Org Attributes button at the bottom of the screen 

 

Expected Results/Actions:  Organization Item window appears 
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Step Description:  At the Organization level navigate to the Purchasing Tab and update 

the Expense Account number with the appropriate GL #: 

 

GD.0000.00.0000.00.59050.000 – for Auto Parts Expense Items 

 

GD.0000.00.0000.00.59060.000 – for EEE Expense Items 

 

GD.0000.00.0000.00.59070.000 – for Furniture Expense Items 

 

GD 0000.00.0000.00.59061.000 – for Special EEE Expense Items 

 

Expected Results:  Account Number will change 

 

 

 
 

 

 

NOTE: 

The Expense Account Number will need to be changed at both the GSF and the 

WFF Organizations. 
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Step Description:  Verify that all of the other information at the Organization Level is the 

same as the information you entered at the Master Level.  Navigate to “Tools” and 

choose “Item Sub inventory” 

 

Expected Results/Actions:  Item Sub inventory Form opens 
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Step Description:  Choose the correct sub inventory from the LOV then click “OK” For 

Expense items to select the Appropriate Expense sub inventory,  all items MUST be 

assigned to the Staging sub inventory.   There are no Locators required for Expense 

items. 

 

Expected Results/Actions:  Sub inventory Information is Populated 

 

 
 

 

 

Step Description:  Click on “Save” and close form 

 

Expected Results/Actions:  Transaction Complete Message. 

 

Note:  You need to add sub inventories to both Organizations GSF and WFF. 
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Step Description:  Click the GSF Organization Item screen and select the WFF Wallops 

Organization assignment click on the Organization Attributes button at the bottom of the 

screen 

 

Expected Results:  The Wallops Organization Item window will appear. 
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Step Description:  Verify all data is the same as the Master Item Record and add the 

appropriate sub inventories following the same steps for the GSF Organization. 

 

Expected Results/Actions:  Sub inventories will be assigned. 

 

 

 

Step Description:  Save your work and close all forms. 

 

Expected Results/Actions:  Will be back at the IM Inventory AMM Menu 
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Step Description:  Change responsibilities to the OM USER Responsibility 

 

Expected Results/Actions:  The OM USER main menu will appear 
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Step Description:  Select Price Lists> Price List  from the menu and click on open 

 

Expected Results/Actions:   A blank Price List screen will appear 
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Step Description:  On your keyboard hit the F11 button to send Oracle into query mode, 

then hold down the Ctrl button and hit F11 again to initiate the query.   

 

Expected Results/Actions:  The Goddard Price List will appear 
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Step Description:  At the bottom of the Goddard Price List, in the List Line section, click 

on an occupied line then click on the green plus sign (+) on the tool bar to add a  new 

line, make sure you are at the bottom of the screen. 

 

Expected Results/Actions:  A blank line will appear and the Item field will be yellow 
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Step Description:  In the Item field click on the LOV and select Item from the list, tab to 

the Product Attribute field and click on the LOV and select Item Number from the list.  In 

the Product Value field enter the Item number you just loaded. 

 

Expected Results/ Actions:  All fields will be populated 
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Step Description:  Tab over to the value field and enter the cost for the item.  Example:  

1.55 

 

Expected Results/ Actions:  Field will be populated with cost. 
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Step Description:  Save your work and close all forms,  Repeat the same process for the 

Wallops Price List. 

 

Expected Results/Actions:  Transactions Complete and Applies message at the bottom of 

screen, and will return to OM USER main menu. 

 

 

This stock number is now loaded and on the Price List.  

 

 

 

Notes:  Expense item are not Inventory items, they can not be transacted against like 

other item numbers.   

 

All Expense items must be added to both Price Lists.  The sales order can not be created 

until the items are on the price lists.   
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AMMS TRAINING SCRIPT 

ADDING FURNITURE EXPENSE 

ITEM TO ORACLE 
  

 

Purpose 

The purpose of this training script is to demonstrate how a Material Coordinators and 

Supply Technician Lead will add a new Furniture Expense stock number to the Oracle 

data base.  This particular item number is not an inventory and will use the Template of 

Furniture Expense.  After the item has been added to the system you also have to add it to 

BOTH Mater Price Lists (GSF and WFF).  

 

Audience 

Material Coordinator and Supply Technician Lead 

 

 

 

Prepared By Theresa Coulson 

Creation Date: 08/03/2005 

Document Name Create Furniture Expense Item 
Number.doc 

Version 2 

Last Updated: 11/23/2008 

The most current version of this training script can be found at 
GSFC-FileSRVC\270Public\279 IT\Training\AMMS Customer Training 
Docs\Published\Inventory. 
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Step Description:  Sign on to Oracle Applications and Select User Responsibility “IM 

Inventory AMMS” 

 

Expected Results/Actions:  Oracle Displays the Inventory main Menu 

 

 

Step Description:  Select “Items” then “Master Items” 

 

Expected Results/Actions:  Organization form opens. 
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Step Description:  Select “AMS” as the Organization and Click OK 

 

Expected Results/Actions:  Blank Master form opens. 
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Step Description:  Enter the New Item Number 

 

Expected Results/Actions: Field is populated. 
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Step Description:  Click on the Description Field 

 

Expected Results/Actions:  Cursor moves. 
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Step Description:  Enter an Abbreviated Description (noun) for Expense items the Noun 

could possibly be the Vendor Name 

 

Expected Results/Actions:  Field is populated. 
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Step Description:  Click on the Long Description field at the bottom of the screen 

 

Expected Results/Actions:  Cursor moves 
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Step Description:  Enter the Entire Item Description then, if the Noun is the Vendor name 

enter the Vendor information in the Description field 

 

Expected Results/Actions:  Field is populated. 
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Step Description:  Click on the Primary Unit of Measure field and change if necessary 

from List of Values (LOV) then Click OK Please remember to select the correct Primary 

UOM as to this field can never be changed. 

 

Expected Results/Actions:  U/I is updated 
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Step Description:  Navigate to the Purchasing Tab and select the Unit of Issue from the 

LOV; this should match the Primary UOM. 

 

Expected Results/Actions:  Purchasing Unit of Measure is changed 
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Step Description:  Save Information Entered 

 

Expected Results/Actions:  Transaction Complete Message at the bottom of the form. 
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Step Description:  Navigate to “Tools” and choose “Categories 

 

Expected Results:  Category form opens. 
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Step Description:  At the Category Set field click on the LOV and choose “Inventory”  

 

Expected Results/Actions:  Field is populated. 
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Step Description:  Tab to Category and Enter the Correct Category (NIAC) for that new 

item number, SAVE and CLOSE form. 

 

Expected Results/Actions:  Transaction Complete Message at the bottom of the form. 
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Step Description:  Navigate to “Tools” and choose “Copy From” 

 

Expected Results/Actions:  Copy From form opens 
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Step Description:  Click on the LOV and select “Furniture Expense” to copy an Item 

Template. Click “Apply” then click “Done” 

Expected Results/Actions:  Transaction Saved Message will appear 
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Step Description:  Navigate to the “Purchasing” Tab and verify the UN code it will 

default to CO3 if different change UN code. 

 

Expected Results/Actions:  Field is populated. 
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Step Description:  “Purchasing” Tab enter the “List and Market Price” of the item 

 

Expected Results/Actions:  Field is populated 
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Step Description:  At the Purchasing Tab in the Expense Account Field, change the GL 

number to:  

AM.0000.00.0000.00.59070.000 – for Furniture Expense Items 

 

Expected Results:  Account Number will change 
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Step Description:  Navigate to “Tools” and choose “Manufacturer Part Number” 

 

Expected Results/Actions:  Manufacturer Form is opened 
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Step Description:  Choose the Manufacture from the LOV and enter the part number. 

Click on “Save” then close the form. 

 

Expected Results/Actions:  Manufacture information is populated 
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Step Description:  Navigate to “Tools” and choose “Organization Assignment” 

 

Expected Results/Actions:  Organization Assignment form is opened. 
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Step Description :  Click on the white box next to GSF and WFF 

 

Expected Results/Actions:  All GSF and WFF have check marks next to them. 
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Step Description:  From the Organization Assignments screen click on the GSF and then 

click on the Org Attributes button at the bottom of the screen 

 

Expected Results/Actions:  Organization Item window appears 
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Step Description:  At the Organization level navigate to the Purchasing Tab and update 

the Expense Account number with the appropriate GL #: 

 

GD.0000.00.0000.00.59070.000 – for Furniture Expense Items 

 

Expected Results:  Account Number will change 

 

 

 
 

 

 

NOTE: 

The Expense Account Number will need to be changed at both the GSF and the 

WFF Organizations. 
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Step Description:  Verify that all of the other information at the Organization Level is the 

same as the information you entered at the Master Level.  Navigate to “Tools” and 

choose “Item Sub inventory” 

 

Expected Results/Actions:  Item Sub inventory Form opens 
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Step Description:  Choose the correct sub inventory from the LOV then click “OK” For  

Furniture Expense items to select FURN-EXPEN sub inventory,  all items MUST be 

assigned to the Staging sub inventory.   There are no Locators required for Expense 

items. 

 

Expected Results/Actions:  Sub inventory Information is Populated 

 

 
 

 

Step Description:  Click on “Save” and close form 

 

Expected Results/Actions:  Transaction Complete Message. 

 

Note:  You need to add sub inventories to both Organizations GSF and WFF. 
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Step Description:  Click the GSF Organization Item screen and select the WFF Wallops 

Organization assignment click on the Organization Attributes button at the bottom of the 

screen 

 

Expected Results:  The Wallops Organization Item window will appear. 
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Step Description:  Verify all data is the same as the Master Item Record and add the 

appropriate sub inventories following the same steps for the GSF Organization. 

 

Expected Results/Actions:  Sub inventories will be assigned. 

 

 

 

Step Description:  Save your work and close all forms. 

 

Expected Results/Actions:  Will be back at the IM Inventory AMM Menu 
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Step Description:  Change responsibilities to the OM USER Responsibility 

 

Expected Results/Actions:  The OM USER main menu will appear 
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Step Description:  Select Price Lists> Price List  from the menu and click on open 

 

Expected Results/Actions:   A blank Price List screen will appear 
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Step Description:  On your keyboard hit the F11 button to send Oracle into query mode, 

then hold down the Ctrl button and hit F11 again to initiate the query.   

 

Expected Results/Actions:  The Goddard Price List will appear 
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Step Description:  At the bottom of the Goddard Price List, in the List Line section, click 

on an occupied line then click on the green plus sign (+) on the tool bar to add a  new 

line, make sure you are at the bottom of the screen. 

 

Expected Results/Actions:  A blank line will appear and the Item field will be yellow 
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Step Description:  In the Item field click on the LOV and select Item from the list, tab to 

the Product Attribute field and click on the LOV and select Item Number from the list.  In 

the Product Value field enter the Item number you just loaded. 

 

Expected Results/ Actions:  All fields will be populated 
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Step Description:  Tab over to the value field and enter the cost for the item.  Example:  

1.55 

 

Expected Results/ Actions:  Field will be populated with cost. 
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Step Description:  Save your work and close all forms,  Repeat the same process for the 

Wallops Price List. 

 

Expected Results/Actions:  Transactions Complete and Applies message at the bottom of 

screen, and will return to OM USER main menu. 

 

 

This stock number is now loaded and on the Price List.  

 

 

 

Notes:  Expense item are not Inventory items, they can not be transacted against like 

other item numbers.   

 

All Expense items must be added to both Price Lists.  The sales order can not be created 

until the items are on the price lists.   
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AMMS TRAINING SCRIPT 

ADDING A NEW  ITEM WITH DIRECT 

RECEIPT TO ORACLE 

 
  

 

Purpose 

The purpose of this training script is to demonstrate how a Material Coordinators and 

Supply Technician Lead  will add a new  stock number, and set it up for Direct Receipt,  

to the Oracle data base.  After the item has been added to the system you also have to add 

it to BOTH Mater Price Lists (GSF and WFF).  

 

Audience 

Material Coordinator and Supply Technician Leads 

 

 

Prepared By Theresa Coulson 

Creation Date: 11/05/2004 

Document Name Create Purchased Item with Direct 
Receipt.doc 

Version 2 

Last Updated: 11/23/2008 

The most current version of this training script can be found at 
GSFC-FileSRVC\270Public\279 IT\Training\AMMS Customer Training 
Docs\Published\Inventory. 
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Step Description:  Sign on to Oracle Applications and Select User Responsibility “IM 

Inventory AMMS” 

 

Expected Results/Actions:  Oracle Displays the Inventory main Menu 

 

 

Step Description:  Select “Items” then “Master Items” 

 

Expected Results/Actions:  Organization form opens. 
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Step Description:  Select “AMS” as the Organization and Click OK 

 

Expected Results/Actions:  Blank Master form opens. 
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Step Description:  Enter the New Item Number 

 

Expected Results/Actions: Field is Populated. 
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Step Description:  Click on the Description Field 

 

Expected Results/Actions:  Cursor moves. 
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Step Description:  Enter an Abbreviated Description (noun) for the item 

 

Expected Results/Actions:  Field is Populated. 
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Step Description:  Click on the Long Description field at the bottom of the screen 

 

Expected Results/Actions:  Cursor moves 
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Step Description:  Enter the Entire Item Description. 

Expected Results/Actions:  Field is Populated. 
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Step Description:  Click on the Primary Unit of Measure field and change if necessary 

from List of Values (LOV) then Click OK  Please remember to select the correct 

Primary UOM as to this field can never be changed. 

 

Expected Results/Actions:  U/I is updated 
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Step Description:  Navigate to the Purchasing Tab, go to the Unit of Issue field and select 

the Unit of Issue from the LOV, this should match the Primary UOM. 

 

Expected Results/Actions:  Purchasing Unit of Issue is changed 
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Step Description:  Save Information Entered 

 

Expected Results/Actions:  Transaction Complete Message at the bottom of the form. 
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Step Description:  Navigate to “Tools” and choose “Categories 

 

Expected Results:  Category form opens. 
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Step Description:  At the Category Set field click on the LOV choose “Inventory”  

 

Expected Results/Actions:  Field is Populated. 
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Step Description:  Tab to Category and Enter the Correct Category, NASA 

INVENTORY ACCOUNT CODE (NIAC) for that new item number, SAVE and CLOSE 

form.  A list of NIAC is included.  

 

Expected Results/Actions:  Transaction Complete Message at the bottom of the form. 
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Step Description:  Navigate to “Tools” and choose “Copy From” 

 

Expected Results/Actions:  Copy From form opens 
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Step Description:  Click on the LOV and select item type that you are loading.  To copy 

an Item Template. Click “Apply” then click “Done” 

Expected Results/Actions:  Note Message will appear 
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Step Description:  Note Window will appear with message “The following attributes of 

the Purchased Item Template were not copied: Include in Roll UP.  Click OK to this 

Note. 

 

Expected Results/Actions:  Window will close, Returns to the Master Items form with 

“Template Implemented” message at the bottom of the form. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



Page: 848 of 1264  

Step Description:  Navigate to the “Purchasing” Tab and verify the  UN code it will 

default to CO3 if different change UN code. 

 

Expected Results/Actions:  Field is Populated. 
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Step Description: At the “Purchasing” Tab enter the “List and Market Price” of the item 

 

Expected Results/Actions:  Fields are Populated 
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Step Description: Still at the Purchasing Tab, in the Invoice Matching area, change 

Inspection Required to NO 

 

Expected Results:  Field will change 
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Step Description:  At the Receiving Tab, in the bottom right hand corner, Receipt 

Routing, change this to Direct 

 

Expected Results:  Field will change 
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Step Description:  Navigate to “Tools” and choose “Manufacturer Part Number” 

 

Expected Results/Actions:  Manufacturer Form is opened 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



Page: 853 of 1264  

Step Description:  Choose the Manufacture from the LOV and enter the part number. 

Click on “Save” then close the form. 

 

Expected Results/Actions:  Manufacture information is populated 
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Step Description:  Navigate to “Tools” and choose “Organization Assignment” 

 

Expected Results/Actions:  Organization Assignment form is opened. 
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Step Description:  Click on the white box next to GSF and WFF, click Save.   

 

Expected Results/Actions:  AMS, GSF and WFF have check marks next to them. 
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Step Description:  From the Organization Assignments screen click on the GSF and then 

click on the Org Attributes button at the bottom of the screen 

 

Expected Results/Actions:  Organization Item window appears 
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Step Description:  Verify that all of the information at the Organization Level is the same 

as the information you entered at the Master Level.  Check the Purchasing tab to make 

sure the Inspection Required is set to NO, also check the Receiving tab and make sure the 

Receipt Routing is set to Direct.  If fields are different update at the organization level 

 

Expected Results:  Field will reflect correct data 
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Step Description:  Navigate to “Tools” and choose “Item Sub inventory” 

 

Expected Results/Actions:  Item Sub inventory Form opens 
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Step Description:  Choose the correct primary sub-inventory from the LOV then click 

“OK”. While on the primary sub-inventory, check the box for Min Max Planning.  Click 

on the Locator field at the bottom of the screen and enter Receiving as the Locator.   All 

items MUST also be assigned to the Staging sub-inventory.    

 

Expected Results/Actions:  Sub-inventory and Locator Information is Populated 

 

 

 
Close the Item Sub Inventory window. 
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Step Description:  At the Organization Items (GSF) window, select the “Receiving” Tab 

 

Expected Results/Actions:  You will be at the Receiving Tab 
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Step Description:  In the Receiving Sub Inventory field click on the LOV and enter the 

same primary sub inventory as you did for the sub-inventory screen. 

 

Expected Results/Actions:  Field will be populated  

 

 
 

 

 

Step Description:  Click on “Save” and close form 

 

Expected Results/Actions:  Transaction Complete Message. 

 

Note:  You need to add sub-inventories to both Organizations GSF and WFF. 
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Step Description:  Close the GSF Organization Item screen and select the WFF Wallops 

Organization assignment click on the Organization Attributes button at the bottom of the 

screen 

 

Expected Results:  The Wallops Organization Item window will appear. 
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Step Description:  Verify all data is the same as the Master Item Record and add the 

appropriate sub inventories following the same steps for the GSF Organization. 

 

Expected Results/Actions:  Sub inventories will be assigned. 

 

 

 

Step Description:  Save your work and close all forms. 

 

Expected Results/Actions:  Will be back at the IM Inventory AMMS Menu 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



Page: 864 of 1264  

 Step Description:  Change responsibilities to the OM USER Responsibility 

 

Expected Results/Actions:  The OM USER main menu will appear 
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Step Description:  Select Price Lists> Price List from the menu and click on open 

 

Expected Results/Actions:   A blank Price List screen will appear 
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Step Description:  On your keyboard hit the F11 button to send Oracle into query mode, 

then hold down the Ctrl button and hit F11 again to end the query.   

 

Expected Results/Actions:  The Goddard Price List will appear 
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Step Description:  At the bottom of the Goddard Price List window, in the List Line 

section, click on an occupied line then click on the green plus sign (+) on the tool bar to 

add a new line, make sure you are at the bottom of the screen. 

 

Expected Results/Actions:  A blank line will appear and the Item field will be yellow 
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Step Description:  In the Item field click on the LOV and select Item from the list, tab to 

the Product Attribute field and click on the LOV and select Item Number from the list.  In 

the Product Value field enter the Item number you just loaded. 

 

Expected Results/ Actions:  All fields will be populated 
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Step Description:  Tab over to the value field and enter the cost for the item.  Example:  

1.55 

 

Expected Results/ Actions:  Field will be populated with cost. 
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Step Description:  Save your work and close all forms, Repeat the same process for the 

Wallops Price List. 

 

Expected Results/Actions:  Transactions Complete and Applies message at the bottom of 

screen, and will return to OM USER main menu. 

 

 

This stock number is now loaded and on the Price List.  
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AMMS TRAINING SCRIPT 

Cycle Count Entries 
  

 

 

 

Purpose 

The purpose of this training script is to give instruction on how to enter counts for items 

being cycle counted.   

 

Audience 

Material Coordinators and Supply Technician Team Leads 

 

 

 

Prepared By Theresa Coulson 

Creation Date: 09/29/2004 

Document Name Cycle Count Entries.doc 

Version 3 

Last Updated: 11/23/2008 

The most current version of this training script can be found at 
GSFC-FileSRVC\270Public\279 IT\Training\AMMS Customer Training 
Docs\Published\Inventory. 
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Step Description:  Sign onto Oracle and choose the IM Inventory AMMS 

responsibility 

 

Expected Results:  You will be at the IM Inventory AMMS main menu 

 

Step Description:  From the IM Inventory AMMS main menu select 

Counting > Cycle Counting > Cycle Count Entries 

 

Expected Results:  The Organization window will appear 
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Step Description:  From the Organizations window select the appropriate 

organization, GSF for Goddard or WFF for Wallops. 

 

Expected Results:  Cycle Count Entries window will open 
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Step Description:  In the Cycle Count field click on the LOV and select the 

name of the Cycle Count that you are performing.  Then click on the Find 

Button.  The name of the cycle count will be on the count card report. 

 

Expected Results:  A decision window will appear 
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Step Description:  At the Decision window, “Find all open count requests?” 

click on Yes 

 

Expected Results: Cycle Count Entries form is populated with count card 

information 
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Step Description:  Identify the items that you need to enter counts for.  You 

can do this by Count Sequence number and by Item Number.  Tab over to 

the Quantity field, enter the first count quantity.  For Recounts, the quantity 

will already be populated in the field, you must type the quantity again, or 

the count will not be registered.   

 

Expected Results:  Quantity field will be populated 
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Step Description:  Tab to the Reference field, this is a free formed field, in 

this field enter the name of the person that conducted the counting.  Do this 

for first counts and recounts. 

 

Expected Results:  Field will be populated with person‟s name 
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Step Description:  For Reference only if you continue to tab you will see 

what the count quantity, verse the System quantity, and be able to see the 

difference.  This is just a reference tool, there is no data to be entered. 

 

Expected Results:  You will see data 
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Step Description:  Save your work. 

 

Expected Results:  Transactions complete. 

 

 

 

Notes:  When entering Cycle Counts, you will do this multiple times for 

items depending on the number of recounts requested.  Once you have 

entered the “Final” count for an item the items that the balances need to 

be adjusted will require you to “Approve” the counts. 
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AMMS TRAINING SCRIPT 

Finding Cost for Miscellaneous 
Transactions 

  

 

 

Purpose 

The purpose of this training script is to will identify what the cost needs to be 
when doing any Miscellaneous transaction (including Excess) 

 

Audience 

Material Coordinator 

 

 

 

Prepared By Theresa Coulson 

Creation Date: 05/22/2008 

Document Name Find Cost of Item to do Miscellaneous 
Transactions.doc 

Version x 

Last Updated: 11/23/2008 

The most current version of this training script can be found at 
GSFC-FileSRVC\270Public\279 IT\Training\AMMS Customer Training 
Docs\Published\Inventory. 
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Step Description:  Sign onto Oracle and select IM Inventory AMMS responsibility 

 

Expected Results:  IM Inventory AMMS main menu will appear 
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Step Description:  From the IM Inventory AMMS main menu select Costs > Item Costs 

 

Expected Results:  Organization window will appear 
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Step Description:  Select the appropriate organization 

 

Expected Results:  Find Item/Cost Type window will appear 
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Step Description:  In the Find Item/Cost Type window in the Item field enter the item 

number you want to do the adjustment for, click on Find 

 

Expected Results: Item Cost Summary Window will appear 
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Step Description:  At the Item Cost Summary window click on Open 

 

Expected Results:  Item Cost Details window will appear 
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Step Description:  In the Cost Information section of the Item Cost Details window you 

will see the Material field this is the cost that should be used when doing any 

miscellaneous transactions. 

 

Expected Results:  You will now have the correct cost for the item 

 

 
 

 

 

Note:  The cost in the Material field will be the cost that 

you enter when doing any Miscellaneous Transactions, 

including Excess transactions.   
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AMMS TRAINING SCRIPT 

Inquiry by Part Number 
  

 

 

 

Purpose 

The purpose of this training script is to walk you though doing a query in AMMS 
to see of a Part Number has an existing Item Number. 

 

Audience 

Supply Team Lead and Material Coordinator 

 

 

 

Prepared By Theresa Coulson 

Creation Date: 03/28/2005 

Document Name Inquiry on Part Numbers.doc 

Version 2 

Last Updated: 11/23/2008 

The most current version of this training script can be found at 
GSFC-FileSRVC\270Public\279 IT\Training\AMMS Customer Training 
Docs\Published\Inventory. 
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Step Description:  Sign onto Oracle and select your IM Inventory AMMS responsibility 

 

Expected Results:  You will be at the IM Inventory AMMS main menu 
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Step Description:  From the main menu of the IM Inventory AMMS responsibility select 

Items > Manufactures Part Numbers> By Item, click on the open button 

 

Expected Result:  Organization window will appear 
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Step Description:  From the Organization window select the appropriate organization, 

GSF is Goddard, WFF is Wallops, click OK 

 

Expected Results:  Find Manufacture Part Number window will open 
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Step Description:  Tab to the Part field and enter a part number, click on the Find button 

 

Expected Results:  The Manufactures Part Number window will appear with data 
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Step Description:  If an item number is loaded for the part number the fields will be 

populated.  This screen tells you who the manufacture is, what the part number is, what 

the item number is that is assigned to that part number, and what the name of the item is. 

 

Expected Results:  Review data 
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Step Description:  Once you are in this screen if you need to look up addition part 

numbers, hit the F11 button on your keyboard, this will put Oracle into query mode, place 

the cursor in the Part field and enter the new part number. 

 

Expected Results:  Oracle will be in query mode and part field will be populated 
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Step Description:  Hold down the Control (CTRL) button on your keyboard, then hit the 

F11 button again this will end the query mode in Oracle.   

 

Expected Results:  If an item is available for the part number you added data will 

populate 
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AMMS TRAINING SCRIPT 

title 
  

 

 

 

Purpose 

The purpose of this training script is to give instruction on how to run the Item Demand 

History report, to find out usage on items. 

 

Audience 

Material Coordinator 

 

 

 

Prepared By Theresa Coulson 

Creation Date: 06/16/2006 

Document Name Item Demand History Report.doc 

Version 2 

Last Updated: 11/23/2008 

The most current version of this training script can be found at 
GSFC-FileSRVC\270Public\279 IT\Training\AMMS Customer Training 
Docs\Published\Inventory. 
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Step Description:  Sign onto Oracle and select IM Inventory responsibility 

 

Expected Results:  IM Inventory main menu will appear 
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Step Description:  From the IM Inventory main menu select Reports > All click on the 

Open button 

 

Expected Results:  Organization window will appear 
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Step Description:  In the Organization window select GSF for Goddard or WFF for 

Wallops 

 

Expected Results:  Submit New Request window will appear 
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Step Description:  From the Submit New Request window select Single Request, click 

OK 

 

Expected Results:  All Reports window will appear 
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Step Description:  In the All Reports window at the Name field click on the List of 

Values (LOV). 

 

Expected Results:  List of all reports will appear 
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Step Description:  Find the Item Demand History Report, the reports are in alphabetical 

order, once you find the correct report click OK to the Reports window 

 

Expected Results:  Parameters window will appear 
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Step Description:  In the parameters window, click in the Item From field, AMMS 

System Items window will appear, put the item number you want the report for in the 

Low and High fields, click OK to the AMMS System Items window 

 

Expected Results: Both field will be populated with the same information, return to the 

Parameters window 
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Step Description:  In the Bucket Type window click on the LOV and select Periods, in 

the History Start Date field, enter the data that you want the history to go back to, if you 

want the history back to April 2004 you would enter 01-APR-2004 (this is the start date 

of our current version of Oracle), click OK to the parameters window 

 

Expected Results:  Return to the All Reports window 
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Step Description:  To print the report, click on the Options button 

 

Expected Results:  Upon Completion window will appear 
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Step Description:  In the Printer field click on the LOV and select the correct printer 

 

Expected Results:  List of Printers will appear 
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Step Description:  From the list of printer select what printer you want the report to print 

to, the GSF_HP_S60 printer is the one at the back of the S60 office area, once you have 

selected the printer, select the number of copies you want, click in the Copies field and 

enter the number of copies that you want, click OK to the window 

 

Expected Results:  Return to the All Reports window 
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Step Description:  Now click the Submit button 

 

Expected Results:  Decisions window will appear 
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Step Description:  The Decision window has your Oracle Report Request ID number take 

note of this number, Click No to the Decision window 

 

Expected Results:  Return to the IM Inventory Main Menu 

 

 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



Page: 909 of 1264  

 

Step Description:  To review the status of you report request, from the toolbar select 

View > Requests 

 

Expected Results:  Find Request window will appear 
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Step Description:  Click on the Find button 

 

Expected Results:  Request window will appear 
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Step Description:  Find your request and click on the Refresh button until the status is 

Completed Normal 

 

Expected Results:  Report should print on the above indicated printer 
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AMMS TRAINING SCRIPT 

Navigate on Item Number 
  

 

 

 

Purpose 

The purpose of this training script is to walk you though the different attributes of an Item 

Number and how it is set up in Oracle. 

 

Audience 

Supply Team Lead and Material Coordinator 

 

 

 

Prepared By Theresa Coulson 

Creation Date: 03/28/2005 

Document Name Navigate in Item Number.doc 

Version 2 

Last Updated: 11/23/2008 

The most current version of this training script can be found at 
GSFC-FileSRVC\270Public\279 IT\Training\AMMS Customer Training 
Docs\Published\Inventory. 
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Step Description:  Sign onto Oracle and select the IM Inventory AMMS responsibility, 

click on OK 

 

Expected Results:  IM Inventory AMMS main menu will appear 
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Step Description:  From the IM Inventory AMMS main menu select, Items > Master 

Items, click on the open button 

 

Expected Results:  Organization window will appear 
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Step Description:  Select the appropriate organization, AMS is the Master Organization, 

GSF is for Goddard, and WFF is for Wallops, click OK 

 

Expected Results:  Blank Master Item window will appear 
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Step Description:  Press the F11 button on your keyboard to send Oracle into a query 

mode, enter the Item Number in the Item field, then hold down the Control (Ctrl) button 

and press the F11 button again, this will end the query mode. 

 

Expected Results:  Data will populate the window 
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Step Description:  This is the Main tab, this tells you the Item Number, Description 

(Noun), Primary Unit of Measure, User Item Type, Item Status, and long description. 

 

Click on the Inventory Tab. 

 

Expected Results:  Window view will change 
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Step Description:  The Inventory tab tell you if the item is Shelf Life, if it is an Inventory, 

or Expense item, Stockable, Transactable, or Reserveable. 

 

Click on the Bills of Material Tab 

 

Expected Results:  Window view will change 
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Step Description:  Bill of Material tab just tells you that this is a Standard Pay Item 

 

Click on the Costing Tab 

 

Expected Results:  Window view will change 
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Step Description:  The Costing tab will tell you that this item is Cost Enabled, has an 

Inventory Asset value, and what the Master General Ledger number is. 

 

Click on the Purchasing Tab 

 

Expected Results:  Window view will change 
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Step Description:  The Purchasing tab tell you if the item is Purchase, Purchasable, the 

Default Buyer, Unit of Issue, UN Number, Hazardous Class, List Price, Market Price, 

Price Tolerance, Rounding Factor, and the Expense Account GL number. 

 

Click on the Receiving tab 

 

Expected Results:  Window view will change 
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Step Description:  The Receiving tab tells you if the item allow substitutes, and the 

Receipt Routing.  

 

Click on the arrow for a drop down of more tabs 

 

Expected Results:  Window view will change 
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Step Description:  From the list of tabs select General Planning 

 

Expected Results:  Window view will change 
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Step Description:  The General Planning tab tells you the Inventory Planning method, at 

the Organization Level it will also tell you if there are any Min Max Levels. 

 

Click on the arrows again 

 

Expected Results:  A list of addition tabs will appear 
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Step Description:  From the list select Order Management 

 

Expected Results:  Window view will change 
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Step Description:  The Order Management tab will tell you if this is an item that customer 

can order, is the item Shippable, Transactable, Returnable, and RMA Inspection Required 

 

Expected Results:  Window view will change 
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Step Description:  From the tool bar select Tools > Manufactures Part Number 

 

Expected Results:  Manufactures Part Number window will appear 
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Step Description:  This window will tell you who the Manufacture is, and what the Part 

Number is 

 

Expected Results:  Window will have data 

 

 
 

 

 

 

Close the Manufactures Part Number window 
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Step Description:  At the Organization level, from the tool bar select Tools > Item Sub 

Inventories 

 

Expected Results:  Item Sub Inventory window will open 
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Step Description:  This window tells you what sub inventory the item belongs to, and if 

there are any Min Max levels this will be on this screen also, at the bottom of the screen, 

it will also tell you the warehouse locator if there is one assigned.   

 

Expected Results:  Window will have data 
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AMMS TRAINING SCRIPT 

Perform Miscellaneous Transaction 
  

 

 

 

Purpose 

The purpose of this training script is to give instructions on how to perform a 
Miscellaneous Transaction to adjust the on hand balance for an item 

 

Audience 

Supply Team Lead and Material Coordinators 

 

 

 

Prepared By Theresa Coulson 

Creation Date: 03/30/2006 

Document Name Perform Miscellaneous 
Transaction.doc 

Version 2 

Last Updated: 11/23/2008 

The most current version of this training script can be found at 
GSFC-FileSRVC\270Public\279 IT\Training\AMMS Customer Training 
Docs\Published\Inventory. 
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Step Description:  Sign onto Oracle and select IM Inventory AMMS Responsibility 

 

Expected Results:  IM Inventory AMMS main menu will appear 
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Step Description:  From the IM Inventory AMMS main menu select Transactions > 

Miscellaneous Transactions, click on the Open button 

 

Expected Results:  Organization Window will appear 
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Step Description:  Select the appropriate Organization, GSF for Goddard or WFF for 

Wallops, click OK 

 

Expected Results:  Miscellaneous Transaction window will appear 
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Step Description:  Place your curser in the Type field and click on the List of Values 

(LOV) 

 

Expected Results:  Transaction Type window will appear 
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Step Description:  Select the appropriate transaction type, if you are doing an adjustment 

to the on hand balance you must select GD QOH In or Out, this will update the 

appropriate General Ledger accounts, once you have selected the appropriate transaction 

type click OK 

 

Expected Results:  Return to the Miscellaneous Transactions window 
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Step Description:  Your curser is now in the Source field, click on the LOV  

 

Expected Results:  AMMS Account Aliases window will appear 
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Step Description:  Select the AMMS Account Alias that matches the Transactions Type, 

if you selected GD QOH OUT for transaction type, you must select GD QOH OUT for 

the AMMS Account Alias, click OK 

 

Expected Results:  Return to Miscellaneous Transactions window, Transactions Type and 

Source field will be populated 
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Step Description:  Click on the Transaction Lines button 

 

Expected Results:  GD QOH OUT window will appear 
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Step Description:  Enter the Item number tab, enter the Sub Inventory tab, enter the 

locator tab. 

 

Expected Results:  Field will be populated 
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Step Description:  Verify the Unit of Issue tab, enter the quantity to be adjusted.  Verify 

at the bottom of the screen that the quantity to be adjusted is Available. 

 

Expected Results:  Fields will be populated 
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Step Description:  In the Unit Cost field, enter the cost for the item you are adjusting, tab 

to the Reason field 

 

Expected Results:  Field will be populated 
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Step Description:  In the Reason field click on the LOV 

 

Expected Results:  Transaction Reasons window will appear 
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Step Description:  Select the appropriate reason for your adjustment, click OK 

 

Expected Results:  Reason field will be populated 
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Step Description:  Click on the Save icon 

 

Expected Results:  Transactions Saved and Applied message 
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Step Description:  Transaction Complete 

 

Expected Results:  Blank Screen 
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AMMS TRAINING SCRIPT 

Printing Receipt Traveler 

(reprint receipts for PO) 
  

 

 

Purpose 

The purpose of this training script is to give instruction on how to reprint a 
Receipt Traveler, receipt of item in Oracle 

 

Audience 

Buyers 

 

 

 

Prepared By Theresa Coulson 

Creation Date: 10/24/2006 

Document Name Print Receipt Traveler Report.doc 

Version 2 

Last Updated: 11/23/2008 

The most current version of this training script can be found at 
GSFC-FileSRVC\270Public\279 IT\Training\AMMS Customer Training 
Docs\Published\Inventory. 
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Step Description:  Sign onto Oracle and select Purchasing Inventory AMMS 

responsibility 

 

Expected Results:  Purchasing Inventory AMMS main menu will appear 
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Step Description:  From the Purchasing Inventory AMMS main menu select View 

Receiving Transactions, click on the open button 

 

Expected Results:  Organizations window will appear 

 

 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



Page: 950 of 1264  

 

Step Description:  From the Organizations window select the appropriate organization, 

GSF for Goddard, WFF for Wallops 

 

Expected Results:  Find Receiving Transactions window will open 
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Step Description:  In the Purchase Order field enter the purchase order number, if able 

enter the item number in the Item/Rev field, click on the Find button 

 

Expected Results:  Receipt Header Summary window will open 
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Step Description:  Write down the Receipt Number, this is the first column, you will need 

this number to run the report.  Close the Receipt Header Summary window 

 

Expected Results:  Return to Purchasing Inventory AMMS main menu 
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Step Description:  From the Purchasing Inventory AMMS main menu select Reports, 

click on the Open button 

 

Expected Results:  Submit a New Request window will appear 
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Step Description:  In the Submit a New Request window select Single Request, click OK 

 

Expected Results:  All Reports window will open 
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Step Description:  In the Name field click on the List of Values (LOV) and find Receipt 

Traveler, highlight Receipt Traveler and click OK to Reports window 

 

Expected Results:  Parameters window will appear 
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Step Description:  At the Parameters window, in the Organization Name enter the 

appropriate organization name, in the Receipt Number From field enter the receipt 

number, enter the same number in the Receipt Number To field, click OK to the 

Parameters window 

 

Expected Results:  Return to All Reports window 
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Step Description:  Click on the Options button 

 

Expected Results:  Upon Completion window will appear 
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Step Description:  In the Printer field click on the LOV and select a printer, in the copies 

field indicate the number of copies wanted.  Click OK to the Upon Completion window 

 

Expected Results:  Return to All Reports window 
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Step Description:  Click on Submit 

 

Expected Results:  Decision window will appear 
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Step Description: The Decision window will give the Request ID number, and ask if you 

want to submit a new request.  If you click Yes, you can submit a new report request, if 

you click no you will return to the Purchasing Inventory AMMS main menu 

 

No was selected 

 

Expected Results:  Return to Purchasing Inventory AMMS main menu 
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Step Description:  To see submitted tasks, from the Toolbar select View > Requests 

 

Expected Results:   Find Request window will appear 
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Step Description:  At the Find Request window click Find 

 

Expected Results:  Request window will appear 
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Step Description:  This will show you all of your tasks submitted.  If status is anything 

other than Completed Normal, click the Refresh Data button to update the status 

 

Expected Results:  All tasks completed normal, report should print 
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AMMS TRAINING SCRIPT 

PROCESSING A JIT RMA  

“CUSTOMER RETURN” 
 

 

 

Purpose 

The purpose of this training script is to give instructions on how to process a 
return of material by the customer for a JIT item 

 

Audience 

Material Coordinators and Supply Technician Leads 

 

 

 

Prepared By Theresa Coulson 

Creation Date: 09/24/2004 

Document Name Processing a JIT RMA.doc 

Version 3 

Last Updated: 11/23/2008 

The most current version of this training script can be found at 
GSFC-FileSRVC\270Public\279 IT\Training\AMMS Customer Training 
Docs\Published\Inventory. 
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Step Description:  Sign onto Oracle applications and select the OM User 

responsibility 

 

Expected Results:  The OM User main menu will appear. 

 

Step Description:  From the OM User Main Menu select Order Returns > 

Order Organizer 

 

Expected Results:  The Find Orders screen will appear. 
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Step Description:  Enter the sales order number or any other numbers you 

have to find the sales order.  Click on the Find button. 

 

Expected Results:  The Order Organizer screen will appear. 
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Step Description:  Click on the Open button at the bottom right of the screen 

 

Expected Results:  The Sales Order screen will appear. 

 

 
 

 

 

 

 

 

 

Step Description:  Verify that this is the correct sales order by looking at the 

customers name. 
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Step Description:  Click on the Line Items Tab  

 

Expected Results:  The Line Item tab will appear with an Availability Box 

 

 
 

 

 

Step Description:  Close the Availability Box 
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Step Description:  Select the line on the sales order for which you are doing 

the RMA.  Use the scroll bar at the bottom, slide to the right and verify that 

the line is Closed.  Write down the Unit Selling Price and the Line Total 

on the sales order.  

 

Expected Results:  You will see a status of Closed in the status field 

 

 
 

 

 

If the line for which you need to do that RMA is not closed, you must 

close the line before proceeding. 
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Step Description:  At the bottom left of the screen select the Actions Button. 

 

Expected Results/Actions:  An Actions menu will appear 
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Step Description:  From the Action menu select Copy and click OK 

 

Expected Results/Actions:  A Copy window will appear 
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Step Description:  In the Copy window, at the Quick Copy tab, select the 

Create New Order, then click in the “Change Order Type Field To” field and 

click on the LOV and select the appropriate RMA type.  (RMA GSF or 

RMA WFF) 

 

Expected Results/Actions:  Field will populated with New Order type. 
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Step Description:  At the bottom of the Copy window in the Get Order Level 

Information from field you MUST enter the original sales order number. 

 

Expected Results/Action:  Field will be populated 
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Step Description:  Click on the Copy Lines tab on the Copy window, and 

enter a Return Reason click on the LOV for a list of the Reasons. 

 

Expected Results:   The Return Reasons window will appear. 
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Step Description:  Select the appropriate reason for the return and click OK 

to the Return Reason window 

 

Expected Results:  Window will disappear and field will be populated 
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Step Description:  Click OK on the Copy window 

 

Expected Results:  The Process Message window will appear 
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Step Description:  The Process Message screen will tell you that your order 

was created and give you an RMA # write this # down for future reference.  

Click the Continue button on the Process Message window.   

 

Expected Results:   You will be back at the original sales order information 

on the Sales Order form. 
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Step Description:  Select  the “flashlight” from the toolbar this will allow 

you to query up the RMA you just created.  When the Find Orders screen 

appears, click on the Clear button, then enter the RMA # in the Order 

Number field and click on the Find button.   

 

Expected Results:  The Order Organizer window will appear with the RMA 

information 
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Step Description:  Click on the Open button at the bottom right of the 

window 

 

Expected Results:  Sales Order window opens.   
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Step Description:  Click on the Line Items tab 

 

Expected Results/Actions:  The line information for the RMA will appear 
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Step Description:  At the Line Item Main tab scroll all the way to the right 

until you see [] take your curser and click in that field. 

 

Expected Results:  Additional Line Attribute Information window will open 
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Step Description:  Enter the CORRECT Object Class for the item.  This is 

determined by the first 2 digits of the item number.  A list of the Object 

Classes was provided.  Enter the 4 digit number in the Object Class field.  

Click OK to the Additional Line Attribute Information window. 

 

Expected Results/Actions:  Field will be populated and window will close 
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Step Description:  Go to the Pricing Tab scroll over to Calculate Price Flag 

field and change it to Freeze Price. Save your work.  Then verify the 

information, the item number, qty and unit selling price is the same as was 

on the original sales order.  If the unit selling price is different than the 

original sales order change to correct cost, and verify the Line Total is the 

same as on the original sales order line.  Save your work.   

 

Expected Results:  Field will be populated and unit selling price will be 

frozen 
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Step Description:  If the qty that you are doing the RMA is different then the 

qty that is displayed, click in the qty field the qty and enter the qty that is 

being returned.  Verify that the cost matches the cost from the original order 

 

Expected Results:  The qty will change  
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Step Description:  Click on the Book Order button at the bottom right of the 

window. 

 

Expected Results:  You will get a Note that the order has been booked.   
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Step Description:  Click OK to the Note, and close all forms 

 

Expected Results:  Note will disappear and you will return to the OM User 

Main Menu. 

 

Step Description:  Change responsibilities to the IM Inventory AMMS 

responsibility.   

 

Expected Results:  The IM Inventory AMMS main menu will appear 
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Step Description:  From the IM Inventory AMMS main menu select 

Transactions > Receiving > Receipts and select the appropriate organization.   

 

Expected Results:  The Find Expected Receipts window will open 
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Step Description:  Click on the Customer Tab on the Find Expected Receipts 

window and enter the RMA # you just processed and click on the Find 

button 

 

Expected Results:  The Receipt Header and Receipt window will open 
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Step Description:  Close the Receipt Header form. 

 

Expected Results:  The Receipt Header form will close and the Receipt 

window will appear 
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Step Description:  Select the line, place a “check mark” in the box, then go 

to the [] field and click in that field with  your cursor.  The Receiving 

Transactions window will open, and you need to enter a Dock Date and click 

OK. 

 

Expected Results:  The field will be populated 
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Step Description:  Go to the Location field and click on the LOV and select 

NASA GSFC (NASA WFF for Wallops) from the menu. 

 

Expected Results:  Field will be populated  
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Step Description:  Select the yellow diskette from the tool bar and Save your 

work. 

 

Expected Results:  You will get a message that says Transactions completed, 

2 transactions saved and applied.   

 

 
 

 

Step Description:  Close all forms  

 

Expected Results/Actions:  Return to the IM Inventory Main Menu  
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Step Description:  Still in the IM Inventory Main Menu select Transactions 

> Receipts> Receiving Transactions 

 

Expected Results:  The Find Receiving Transactions window will open 
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Step Description:  At the Find Receiving Transactions window click on the 

Customer tab and enter the RMA # in the RMA Num field.  Click on the 

Find Button 

 

Expected Results:  Receiving Transactions Screen opens 
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Step Description:  Click on the Inspect button at the bottom right of the 

window.   

 

Expected Results:  The Inspection Details window will open 
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Step Description:  At the Inspection Details window make sure that the 

status is Accept,  click on the OK button. 

 

Expected Results:  You will return to the Receiving Transactions window 
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Step Description:  You will see that the Destination Type has changed from 

Receiving to Inspect.  Select the Save icon from the toolbar and save your 

work.   

 

Expected Results:  You will get a message at the bottom of the screen, 

Transaction Complete 1 record applied and saved 
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Step Description:  Select from the toolbar the “flashlight” (find)  

 

Expected Results/Actions:  This will return you to the Find Receiving 

Transactions Window 
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Step Description:  Again click on the Customer tab and enter the RMA # in 

the RMA # field and click on the Find button. 

 

Expected Results:  You will return to the Receiving Transactions window 
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Step Description:  This is where you will Deliver the material to Inventory.  

Using the scroll bar, slide to the right until you see the Sub Inventory field, 

click in that field and select the LOV.  Select the appropriate sub inventory 

from the list and click OK. 

 

Expected Results:  Field will be populated. 
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Step Description:  From the toolbar select the Save icon and Save your work 

 

Expected Results:  Message at the bottom of the screen, Transactions 

Complete, 1 record applied and saved. 

 

 
 

 

 

Step Description:  Close all forms and return to the IM Inventory Main 

Menu. 

 

You have just delivered the RMA to inventory and now a balance is on 

hand, for JIT items there should NEVER be a balance on hand.  You now 

need to return the material to the vendor in Oracle.   
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Step Description:  From the IM Inventory Main Menu select Transactions > 

Receipts >Returns 

 

Expected Results:  The Find Returns window will open. 
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Step Description:  For JIT returns you will need to know the release number 

that the original sales order was on.  At the Find Returns screen enter the PO 

#, Release # and the Item Number, click on the Find button. 

 

Expected Results:  Field will be populated and the Receiving Returns 

window will open. 
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Step Description:  You will need to select the correct line for the return, you 

do this by selecting the line that was for the original qty that was on the 

original sales order.  Scroll to the right and you will see the Parent Qty field, 

select the correct line.   

 

Expected Results:  The curser will be on the correct line to perform the 

Return to Vendor transactions. 
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Step Description:  Place your curser in the qty field and enter the qty that 

was returned by the customer, then tab to the Return To field and click on 

the LOV and select Supplier,  then tab to the RMA number field and enter 

Office Depot order number for the return.   

 

Expected Results:  Fields will be populated.   
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Step Description:  Select the Details tab and place your curser in the Reasons 

field and click on the LOV and select 10-Return to Vendor from the list.  

THE REASON CODE MUST BE ENTERED.   

 

Step Description:  Field will be populated 

 

 
 

 

 

 

Step Description:  From the toolbar select the Save icon and Save your 

work. 

 

Expected Results:  Message at bottom of screen Transactions Complete, 1 

record saved and applied. 

 

The on hand balance has now been removed and made to look like the 

purchase order is “due in” again.   
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Step Description:  Close all forms. 

 

Expected Results: Return to the IM Inventory Main Menu 

 

 

 

 

 

Step Description:  Change responsibilities select the IM Purchasing 

responsibility. 

 

Expected Results:  The IM Purchasing main menu window will appear. 
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Step Description:  From the IM Purchasing main menu select Purchase 

Orders > Purchase Order Summary click on the Open button 

 

Expected Results:  The Find Purchase Orders window will open. 
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Step Description:  In the Number field enter the PO #, in the Release field 

enter the release #, in the Item, Rev field enter the item #, click on the Find 

Button 

 

Expected Results:  The fields will be populated and the Purchase Orders 

Shipments window will open. 
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Step Description:  Use the scroll bar and move to the right and find the 

appropriate line that you need to cancel, you will need to match up the 

original qty ordered and find the line that now has a qty due. 

 

Expected Results:  You will move to the right and see qty data. 
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Step Description:  Once you have selected the correct line, place your curser 

on that line, and from the toolbar select Tools > Control 

 

Expected Results:  The Control Documents window will appear 
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Step Description:  From the Control Documents window select Cancel 

Release Shipments, then also check the Cancel Requisitions box, click OK. 

 

Expected Results:  You will get a Caution Note 
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Step Description:  Click OK to the Caution Note. 

 

Expected Results:  You will receive another Note. 

 

 

 

 

 

Step Description:  You will receive another Note saying Control Actions 

Complete.  Click OK to this Note. 

 

Expected Results:  You will return to the Purchase Orders Shipments 

window. 

 

 

Step Description:  Close all forms. 

 

Expected Results:  Return to the IM Purchasing Main Menu 

 

 

 

The process for the JIT RMA is complete. 

 

 

 

 

Notes:   

 

The JIT RMA process needs to be completed all in the same day, DO 

NOT do half of the steps on day and complete the transaction the next 

day, this will mess up the daily reconciliation.  The ENTIRE process 

must be done on the same day. 
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AMMS TRAINING SCRIPT 

Return to Supplier 
  

 

 

 

Purpose 

The purpose of this training script is to instruct users how to perform a return to 
supplier transaction for purchase order 

 

Audience 

Material Coordinator and Supply Technician Team Lead 

 

 

 

Prepared By Theresa Coulson 

Creation Date: 06/21/2005 

Document Name Return to Supplier.doc 

Version 2 

Last Updated: 11/23/2008 

The most current version of this training script can be found at 
GSFC-FileSRVC\270Public\279 IT\Training\AMMS Customer Training 
Docs\Published\Inventory. 
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Step Description:  Sign onto Oracle and select your IM Inventory AMMS responsibility 

 

Expected Results:  IM Inventory AMMS main menu will appear 
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Step Description:  From the IM Inventory AMMS main menu select Transactions > 

Receiving > Returns click on the open button 

 

Expected Results:  Organization window will appear 
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Step Description:  Choose the appropriate organization GSF for Goddard or WFF for 

Wallops click the OK button 

 

Expected Results:  Find Returns window will appear 
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Step Description:  In the Purchase Order field enter the purchase order number for the 

material that was rejected.  You can also enter the item number, this will make the search 

more specific.  Click on the Find button 

 

Expected Results:  Receiving Returns window will appear 
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Step Description:  Select the line that you want to do the Return for, if your scroll to the 

right you will see the Parent Qty.  Place a check mark in the box at the beginning of the 

line, go to the qty field and enter the qty that is to be transacted against, tab to Return To 

field and click on the List of Values, Supplier will default.  

 

Expected Results:  Fields will be populated 
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Step Description:  Save your work 

 

Expected Results:  Transaction Saved and Applied message 

 

 
 

 

 

The Purchase Order is now “due in” again, and all appropriate paperwork, receiving 

discrepancy form must be forwarded to the inspectors to process the material. 
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AMMS TRAINING SCRIPT 

Sub Inventory Transfer 
  

 

 

 

Purpose 

The purpose of this training script is to transfer between sub-inventories. 

 

Audience 

Material Coordinators, Supply Technician Leads, Warehousemen, and Inspectors 

 

 

 

Prepared By Theresa Coulson 

Creation Date: 02/01/2005 

Document Name Sub Inventory Transfer.doc 

Version 2 

Last Updated: 11/23/2008 

The most current version of this training script can be found at 
GSFC-FileSRVC\270Public\279 IT\Training\AMMS Customer Training 
Docs\Published\Inventory. 

     



Page: 1022 of 1264  

AMMS Training Script:   

 

When doing a Sub Inventory Transfer you first need to make sure that all of the locators involved with the 

item are loaded at the Organization level. 

 

 

 

 

 

 

 

 

 

 

 

Step Description:  Sign onto Oracle and select your IM Inventory AMMS responsibility.   Select Items> 

Organization Items. 

 

Expected Results:  You will be at the IM Inventory AMMS main menu 

 

 

 

 
 

 

 

 

 

 



Page: 1023 of 1264  

 

Step Description:  Select the GSF Organization. 

 

Expected Results:  You will be at the Find Organization Item window 
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Step Description:  In the Item field enter the Stock Number and then click on the Find button. 

 

Expected Results:  You will be at the Organization Item window 
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Step Description:  From the toolbar Select Tools, Item Sub Inventories 

 

Expected Results:  The Item Sub Inventory window will appear 
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Step Description:  Click on the appropriate Sub Inventory, so that the blue cursor is next to Stores.  Move 

to the bottom of the screen and you will see the locators that are assigned to this item for this sub inventory.  

Click on the next available line. 

 

Expected Results:  Curser will move to bottom of the screen 

 

 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



Page: 1027 of 1264  

Step Description:  In the next available line enter the new locators for the items, if there are multiple 

locators, just keep selecting the next available line and enter all locators.  Once you have entered all of the 

locators for the items Save your work. 

 

Expected Results:  Locators will be added, Transaction Complete note. 

 

 

 
 

 

 

 

NOTE:  This completes adding locators to items.  Close all screens. 
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Step Description:  From the IM Inventory AMMS responsibility main menu:  Select Transactions > 

Subinventory Transfer 

 

Expected Results:  Sub Inventory Transfer window will appear. 
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Step Description:  In the Type field click on the LOV Sub Inventory Transfer will default 

 

Expected Results:  Field will be populated 
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Step Description:  Click on the Transaction Lines button 

 

Expected Results:  Sub Inventory Transfer window will open 
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Step Description:  Enter the information for the transfer:  the item number, the sub inventory, the locator 

that the material was in, then enter the sub inventory again, and the locator that the material is now in.    

 

Expected Results:  Field will be populated 
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Step Description:  You will see at the bottom of the screen Available and On Hand quantities.  This is the 

only amount that can be transferred.  You can not do a transfer for more than you have in the available box.  

If the material is going to multiple locators, then only do partial quantities.   

 

Expected Results:  Fields are populated 
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Step Description:  Save your work: 

 

Expected Results:  Screen will go blank, Transactions complete message 

 

 
 

 

 

 

 

 

 

NOTE:   If you have an item that is being put in multiple locators then you need to do multiple transactions.  

Where ever the material is in the warehouse is where it needs to be identified in Oracle.  Example, if you 

had 20 boxes in the ROOM, and moved them so that there are 10 boxes in 916A01010 and 10 boxes in 

916B01010 then you have to do 2 separate transactions.   
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AMMS TRAINING SCRIPT 

Updating Shelf Life Lot Numbers 
  

 

 

 

Purpose 

The purpose of this training script is to demonstrate how to update the 
expiration date on a shelf life item. 

 

Audience 

Warehousemen, Material Coordinators, and Team Leads 

 

 

 

Prepared By Theresa Coulson 

Creation Date: 02/10/2005 

Document Name Update Shelf Life Lots and Expiration 
dates.doc 

Version 2 

Last Updated: 11/23/2008 

The most current version of this training script can be found at 
GSFC-FileSRVC\270Public\279 IT\Training\AMMS Customer Training 
Docs\Published\Inventory. 
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Step Description:  Sign onto Oracle and select your Inventory responsibility. 

 

Expected Results:  You will be at the Inventory main menu. 
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Step Description:  From the Inventory main menu select On hand Availability > Lots, 

click on the Open button 

 

Expected Results:  Organization window will appear. 
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Step Description:  Select the appropriate organization GSF for Goddard. 

 

Expected Results:  Find Lots/Job window will appear. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



Page: 1038 of 1264  

 

Step Description:  Enter the item number in the Item field and click on the Find button. 

 

Expected Results:  Item Lot window will appear with information. 
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Step Description:  Select the line that you want to update the expiration date, place the 

curser on that line. 

 

Expected Results:  You will be at the appropriate field. 
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Step Description:  Click on the List of Values (LOV) in the Expires On field. 

 

Expected Results:  A Calendar will appear. 
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Step Description:  Select the new expiration date, you can use the arrows to go back 

month or years.  Once you have selected the new expiration date click the OK button.   

 

Expected Results:  Date in Expires On field will update. 
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Step Description:  Save your work. 

 

Expected Results:  Transaction Saved and Applied message. 

 

 

 

 

 

 

Note:  You should make the expiration date the same as the expiration date from the 

manufacture. 
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AMMS TRAINING SCRIPT 

View On Hand Qty 
  

 

 

Purpose 

The purpose of this training script is to walk you though looking to see if an item has an 

available on hand quantity. 

 

Audience 

Material Coordinators and Supply Team Lead 

 

 

 

Prepared By Theresa Coulson 

Creation Date: 03/28/2005 

Document Name View On Hand Qty.doc 

Version 2 

Last Updated: 11/23/2008 

The most current version of this training script can be found at 
GSFC-FileSRVC\270Public\279 IT\Training\AMMS Customer Training 
Docs\Published\Inventory. 
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Step Description:  Sign onto Oracle and select your IM Inventory AMMS responsibility 

 

Expected Results:  IM Inventory main menu will appear 
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Step Description:  From the IM Inventory AMMS main menu select On Hand 

Availability, On-Hand Quantities, click on the open button 

 

Expected Results:  Organization window will appear 
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Step Description:  At the Organization window select the appropriate organization, GSF 

if Goddard and WFF is Wallops, click OK 

 

Expected Results:  Query Material window will appear 
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Step Description:  In the Item/Revision field enter your Item Number, click on the Find 

button 

 

Expected Result:  Material Workbench window will appear 
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Step Description:  At the left hand section of the screen, at Organizations, single click on 

the + sign, this will open up the organization GSF, single click on the + sign next to GSF, 

this will open the sub inventories that have a balance associated, single click on the + 

sign next to the main sub inventory, this will bring up the locators, single click on the + 

sign next to the locator, this will display the item number, click on the Item Number and 

all of the field in the window will be populated.   

 

Expected Results:  Window will populate with data 
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Step Description:  Use the scroll bar at the bottom of the screen to see the quantity on 

hand. 

 

Expected Results:  Window view will change 
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Step Description:  Click on the Availability button at the bottom right of the screen 

 

Expected Results:  Availability window will open 
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Step Description:  This window will tell you, Organization, Item Number, Sub Inventory, 

Locator, Lot Number (if applicable), Cost Group, On Hand, Available to Reserve, 

Available to Transact.   

 

Expected Results:  Window will have data 

 

 
 

 
 

 
 



Page: 1052 of 1264  

 

 

 

AMMS MISCELLANEOUS 

TRAINING SCRIPTS 
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How to add a new Ship To 

address in AMMS: 

 
When using the financial string in AMMS for the first time you will receive 

this message 

 

 
 

Please verify that you entered all of the correct funding information, click 

Yes if all the information is correct.   
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The Ship To fields will be blank, enter your shipping information; 

 

 
 

Enter the following Ship to Information.  

 

 First Name – Enter your first name in this field 

 Last Name – Enter your last name in this field 

 Bldg – Enter you building number in this field 

 Room – Enter your room number in this field 

 Code – Enter your Code in this field 

 Facility/Center – Enter you facility in this field 

 City  - Enter your city 

 State – Enter your State 

 Zip Code – Enter your five-digit Zip Code in this field 
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Ship To address entered,  

 

 
 

 

You can now proceed with entering your items. 
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AMMS TRAINING SCRIPT 

Printing AMMS Orders 
  

 

 

 

Purpose 

The purpose of this training script is to explain how AMMS users can use the 
PRINT function to create a PDF copy of their order. 

 

Audience 

AMMS Users 

 

 

Prepared By Theresa Coulson 

Creation Date: 06/26/2006 

Document Name Printing AMMS Orders.doc 

Version 2 

Last Updated: 11/23/2008 

The most current version of this training script can be found at 
GSFC-FileSRVC\270Public\279 IT\Training\AMMS Customer Training 
Docs\Published\Misc\. 
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System Requirements: 

 

1. To print AMMS orders, you must have Adobe Acrobat 

Reader 6.0 or later installed on your workstation.  This 

will allow you to view you printed order, print the order or 

save the order to your workstation for future reference or 

printing. 
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Saving Your Order 
 

1. Once you have entered all of your lines on the order click on the Yellow Diskette  on the tool 

bar, this is the Save button.  This will save your order, give you an order number and ask if you 

would like to print your order.   
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2. You will receive an OE Print Alert window, telling you your order has been submitted to AMMS, 

the number of line items, your Order Number, and asking “Would you like to print this order?” 

 

A. If you click “Yes, Print my Order”, you will receive another OE Alert 

 

 

B. If you click “No, Don‟t Print my Order”, you order will still be submitted for processing but not 

be printed. You will have to contact the AMMS Help Desk at 6-2525 to print your order. 
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3. If you click “Yes, Print my Order” you will receive an OE Save and Print Alert,    telling you your 

order has been printed, and to go to View My Requests to view your order. 
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4. Click OK to the OE Save and Print Alert, the form will go blank.  From the Toolbar select View, 

then select Requests 
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5. The Find Requests window will appear, make sure the “All My Requests” is selected, click on the 

Find Button 
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6. You are looking for the AMMS Customer Order Report. To the right on each line, you will see your 

Customer Number, AMMS Number and your name. Make sure that the line indicator is on the line you 

want to print, if not, click on the order you want to print, click on the View Output button 
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7. Adobe Acrobat will open with the AMMS Customer Order Report for the selected order. 
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8. From this page you can either print your order, or save it to your desktop.  To print the order click 

on the “Print”, to Save the order click “Save a Copy”, and save to your documents.  You can open the 

saved order at anytime to print it. 
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AMMS TRAINING SCRIPT 

Entering Customer Orders  
Using Existing Customer Numbers 

  

 

 

Purpose 

The purpose of this training script is to explain how to place orders in AMMS 
using a Customer Number. 

 

Audience 

AMMS Users 

 

 

Prepared By Theresa Coulson, Rob Amos, Mike 
Hopper 

Creation Date: 10/11/2005 

Document Name TS01_Customer Number.doc 

Version 2 

Last Updated: 11/23/2008 

The most current version of this training script can be found at 
GSFC-FileSRVC\270Public\279 IT\Training\AMMS Customer Training 
Docs\Published\Misc\. 
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Summary of Changes 
 

This training document will walk you through the process of entering an order in the AMMS Order Entry 

form when using your existing customer number as Customer Search criteria. 

 

For the 2006 Fiscal Year, several changes were required for the AMMS Order Entry System. These 

changes include: 

 

 Financial string input fields Fund, WBS, Cost Center, and Internal Order were re-arranged on the 

Order Entry form. 

 The JON input field was removed; you may no longer lookup customers using a JON number. 

 Searches may be done by existing customer numbers or by specifying the complete Fund, WBS, 

Cost Center, and Internal Order financial string.  

 Financial string input fields Reservation Document Number and Reservation Document Line were 

added. These financial string fields are required when using reimbursable or working capital 

financial strings 

 Financial string fields Network Address (Network) and Network Activity (Activity) were added 

for future use. These fields are not active on the form. 

 The existing Work Order field (WON) was increased from 7 characters to 20 characters. This 

change allows a user to specify longer project identifiers. 

 Most financial string field values can be searched using “Lists of Values” (LOV) pull-down lists 

 Inactive customer numbers are now flagged preventing orders from being placed using out-dated 

financial strings. 

 New and enhanced informational alerts and error messages for fields and functions. 
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Task 1: Accessing the AMMS Order Entry System 
 

This section will describe how to access the AMMS Oracle system and log in using your AMMS userid 

and password. If you are not currently enrolled as an AMMS user, you must contact AMMS Helpdesk at 

301-286-2525 or send an e-mail to Tabatha Luskey at Tabatha.L.Luskey.1@gsfc nasa.gov. 

 

More information on the AMMS System is available on the AMMS web site http://amms/ 

Step 1A: Access the AMMS System Web Site 
 

 

1. From your web browser, enter the following URL to access the AMMS system: 

 

http://ammsmain.gsfc nasa.gov:8001/OA HTML/US/ICXINDEX htm 

 

The following screen should appear: 
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2. Enter your AMMS userid and password in the fields on the screen and then click on the Connect 
button. Note, your password will not display in text but will display as asterisks (*). 
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3. The AMMS Function menu will appear: 
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Step 1B: Navigating to the AMMS Order Entry Screen 
 

Once you have successfully accessed the AMMS system and the list of available functions are displayed, 

you are ready to navigate to the AMMS Order Entry screen. 

 

1. The AMMS function menu should appear: 
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2. Click on Orders to highlight it and then press Open to go to the AMMS Order Entry screen. The 

following screen should appear: 

 

 
 

3. You are now ready to begin placing orders in the AMMS Order Entry form 
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Task 2: Entering AMMS Orders Using an Existing Customer Number   
 

There are two methods of entering orders for a customer in the AMMS Order Entry form: 

 

1. Enter a active Customer Number  

2. Enter in the full SAP financial string 

 

This section discusses how to enter an order for an existing active customer using the customer number.  If 

you know the specific Customer Number, then see Step 2A: Entering a Specific Customer Number. If you 

do not know the Customer Number, you can search the AMMS system for that customer. To do this, see 

Step 2B: Querying All Existing Customer Numbers. 

 

Note: An “active customer” is an AMMS defined customer who is assigned a valid FY05 or FY06 SAP 

financial string. Customers from previous years or who no longer have funding are marked “inactive” in 

the AMMS system and may not order additional supplies. 
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Step 2A: Entering a Specific Customer Number 
 

If you know the specific Customer Number, then you can enter it directly in the AMMS Order Entry form 

and begin ordering items. To do so: 

 

1. Enter the Customer Number in Customer Number field and click on the Customer Search 

button.  
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2. The Fund, WBS, Cost Center and Internal Order financial fields will be populated with data and 

the default “Ship To” information should be displayed.  

 

Note: If a reimbursable fund is associated with your Customer Number, this data 

will not load but an Order Entry Alert window will pop-up. To specify the 

reimbursable fund information, proceed to Step 2c. 
 

 
 

3. Verify that the “Ship To” information is correct.  If it is not, then proceed to the section Task 3 

Updating the Ship To Information. If no address information is displayed, you will see an alert 

advising of this. See section Task 3 Updating the Ship To Information on how to add a address for 

this customer 

. 

4. If the “Ship To” information is correct, proceed to section Task 4 Item Search. 
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Step 2B: Querying All Existing Customer Numbers 
 

If you do not remember the specific customer number, you can have the AMMS system display all of the 

active customer numbers. This allows you to choose the correct Customer Number from a list of values.  

 

Note: Using this Query-All method will not allow you to change the Reservation Document or Reservation 

Line values. This is applicable only when a reimbursable fund is associated with the customer number 

selected. 

 

To search for a Customer Number, you must: 

 

1. Without entering any information in the Customer Number field (or any other field in the 

Customer Search region), click the Customer Search button. The Customer Search (Query 

All Active) List of Values window will display.  
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2. Click Yes to display the list of all Customer Numbers 
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3. Scroll through the list until you find the customer you are looking for then click the OK button. 

The fund string data will load into the form and “Ship To information” will display. 

 

 
 

4. Verify that the “Ship To” information is correct.  If it is not, then proceed to the section Task 3 

Updating the Ship To Information. If no address information is displayed, you will see an alert 

advising of this. See section Task 3 Updating the Ship To Information on how to add a address for 

this customer 

. 

5. If the “Ship To” information is correct, proceed to section Task 4 Item Search. 
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Step 2C: Entering Reservation Information 
 

If the Fund associated with your customer number is a reimbursable or working capital fund, AMMS 

requires you to enter a Reservation Document and Line Number. Only Reservation Document and Line 

information that is valid for the Fund and WBS values associated with your Customer Number can be 

entered into the Res Doc and Res Line fields. 

 

1. If a Customer Number requires a Reservation Document and Line Number, the following alert 

will appear after you enter the Customer Number: 
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2. Click OK to acknowledge this Order Entry Alert. 

 

3.  The Financial String values will load into the Fund, WBS, Cost Center and Internal Order fields 

and the Reservation Document (Res Doc) field will highlight in yellow. 

 

 
 

 

4. If you know the correct Reservation Document Number, you can enter a value directly in the Res 

Doc field or click on the List of Values (LOV) button  on the right side of the field to get a List 

of Values valid for that Customer Number. 

 

5. If you use the List of Values button, highlight the Reservation Document Number you want and 

click the OK button. 

 

If a value automatically loaded into the field when you clicked the LOV button, it means there is 

only one valid Reservation Document Number in the List of Values. 
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6. The selected Reservation Document number will load into the field and the Reservation Line 

(Res Line) field will highlight in yellow. 

 

 
 

7. If you know the correct Reservation Line Number, you can enter a value directly in the Res Line 

field or click on the List of Values (LOV) button  on the right side of the field to get a List of 

Values valid for that Customer Number. 

 

8. If you use the List of Values button, highlight the Reservation Line Number you want and click 

the OK button. 

 

If a value automatically loaded into the field when you clicked the LOV button, it means there is 

only one valid Reservation Line Number in the List of Values. 

 

9. The selected Reservation Line Number will load into the field. 

 

10. Once you have a valid Reservation Line accepted, click the Customer Search button. 
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11. After clicking the Customer Search button, the Fund, WBS, Cost Center, Internal Order, Res Doc 

and Res Line fields will be populated with data and “Ship To” information should be displayed. 

 

 
 

 

6. Verify that the “Ship To” information is correct.  If it is not, then proceed to the section Task 3 

Updating the Ship To Information. If no address information is displayed, you will see an alert 

advising of this. See section Task 3 Updating the Ship To Information on how to add a address for 

this customer 

. 

7. If the “Ship To” information is correct, proceed to section Task 4 Item Search. 
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No Matching Reservation Document  

 

1. If you entered a Reservation Document Number directly into the Res Doc field, but it is not 

valid, this Order Entry Alert will appear.  

 

 
 

2. If you mistyped the entry, click OK to the alert and the Res Doc field will clear.  You can then 

re-enter a Reservation Document Number or click on the List of Values button to get valid 

document numbers.  If none of the valid document numbers are correct, contact your Resource 

Analyst to resolve the problem. 
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Invalid Reservation Line Number 

 

1. If you entered a Reservation Line directly into the Res Line field, but it is not valid, this Order 

Entry Alert will appear:  

 

 
 

2. If you mistyped the entry, click the No button in the alert window and the Res Line field will 

clear.  You can then re-enter a Res Line value or click on the List of Values button to get valid 

document numbers.  If none of the valid reservation line numbers are correct, click the Yes button 

which will clear all fields of the form and contact your Resource Analyst to resolve. 
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Task 3: Updating the Ship To Information  

Step 3A: Changing the Ship To Information 
 

1. If you need to change the Ship To information, click on the Ship To button. 

 

2. A Ship To Addresses List of Values display will appear, scroll through the list to find the 

address you want.  You can shorten the list by typing a portion of the value before the „%‟ in the 

Find line of the List of Values.  

 

3. Once you find the address you need, click on the line and it will highlight in blue. 

 

4. Click the OK button to close the List of Values window and the selected address information will 

load into the form. 

 

 

 

5. If the address you need is not in the List of Values, click the Cancel button and proceed Step 3B: 

Adding New Ship To Information. 

 

Step 3B: Adding New Ship To Information 
 

If the correct customer shipping information is not displayed or you need to add a new shipping contact for 

this Customer Number, then: 
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1. Fill in the blanks, customers first and last name, building, room, code, facility/center, city, state 

and zip code. Once you have completed this click in the Stock Number field and the address 

field will become gray. 

 

WARNING: When specifying your building, room and code, do not add the words “building”, “room” or 

“code” in front of the number. For example, Building 16W should only be specified as 16W in the 

Building field. Adding any additional words to the address field may cause AMMS to not process your 

order delaying the receipt of materials to your customer. 
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Task 4: Item Search 

Step 4A: Selecting Your Organization 
 

In order to begin adding stock items to your order, you first select your organization. 

 

1. Click the „Radio Button‟ beside your NASA Organization ID 
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Step 4B: Enter Item Number 
 

To begin ordering items for your customer, you must now specify the item stock number. 

 

1. In the Item Search area, enter the Item Number in the Stock Number field, and then click on the 

Item/Part/Desc button. 
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Task 5: Entering Line Item Information 

Step 5A:  Updating the Line Item Quantity  
 

By default, the quantity will of each line item ordered defaults to 1. If you want to order more than one of 

this item, you can you can change the quantity. 

 

1. Click in the Quantity field for the line item. 
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2. It will turn yellow. 
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3. Update the quantity for that item and then click back in the Stock Number field to add a new line 

item. 
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Saving Your Order 

3. Once you have entered all of your lines on the order click on the Yellow Diskette  on the tool 

bar, this is the Save button.  This will save your order, give you an order number and ask if you 

would like to print your order.   
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4. You will receive an OE Print Alert window, telling you your order has been submitted to AMMS, 

the number of line items, your Order Number, and asking “Would you like to print this order?” 

 

A. If you click “Yes, Print my Order”, you will receive another OE Alert 

 

 

B. If you click “No, Don‟t Print my Order”, you order will still be submitted for processing but not 

be printed. You will have to contact the AMMS Help Desk at 6-2525 to print your order. 
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3. If you click “Yes, Print my Order” you will receive an OE Save and Print Alert,    telling you your 

order has been printed, and to go to View Requests to view your order. 
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4. Click OK to the OE Save and Print Alert, your form will go blank.  From the Toolbar select View, 

then select Requests 
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5. The Find Requests window will appear, make sure the “All my Requests” is selected, click on the 

Find Button 
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6. You are looking for the AMMS Customer Order Report. To the right on each line, you will see your 

Customer Number, AMMS Number and your name. Make sure that the line indicator is on the line you 

want to print, if not, click on the order you want to print, click on the View Output button 
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7. Adobe Acrobat will open with the AMMS Customer Order Report for the selected order. 
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8. From this page you can either print your order, or save it to your desktop.  To print the order click 

on the “Print”, to Save the order click “Save a Copy”, and save to your documents.  You can open the 

saved order at anytime to print it. 
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Summary of Changes 
 

This training document will walk you through the process of entering an order in the AMMS Order Entry 

form when using the SAP Financial String information (Fund, WBS, Cost Center, Internal Order, 

Reservation Document, and Reservation Line Number). 

 

For the 2006 Fiscal Year, several changes were required for the AMMS Order Entry System. These 

changes include: 

 

 Financial string input fields Fund, WBS, Cost Center, and Internal Order were re-arranged on the 

Order Entry form. 

 The JON input field was removed; you may no longer lookup customers using a JON number. 

 Searches may be done by existing customer numbers or by specifying the complete Fund, WBS, 

Cost Center, and Internal Order financial string.  

 Financial string input fields Reservation Document Number and Reservation Document Line were 

added. These financial string fields are required when using reimbursable or working capital 

financial strings 

 Financial string fields Network Address (Network) and Network Activity (Activity) were added 

for future use. These fields are not active on the form. 

 The existing Work Order field (WON) was increased from 7 characters to 20 characters. This 

change allows a user to specify longer project identifiers. 

 Most financial string field values can be searched using “Lists of Values” (LOV) pull-down lists 

 Inactive customer numbers are now flagged preventing orders from being placed using out-dated 

financial strings. 

 New and enhanced informational alerts and error messages for fields and functions. 
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Task 1: Accessing the AMMS Order Entry System 
 

This section will describe how to access the AMMS Oracle system and log in using your AMMS userid 

and password. If you are not currently enrolled as an AMMS user, you must contact AMMS Helpdesk at 

301-286-2525 or send an e-mail to Tabatha Luskey at Tabatha.L.Luskey.1@gsfc nasa.gov. 

 

More information on the AMMS System is available on the AMMS web site http://amms/ 

Step 1A: Access the AMMS System Web Site 
 

 

4. From your web browser, enter the following URL to access the AMMS system: 

 

http://ammsmain.gsfc nasa.gov:8001/OA HTML/US/ICXINDEX htm 

 

The following screen should appear: 
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5. Enter your AMMS userid and password in the fields on the screen and then click on the Connect 
button. Note, your password will not display in text but will display as asterisks (*). 
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6. The AMMS Function menu will appear: 
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Step 1B: Navigating to the AMMS Order Entry Screen 
 

Once you have successfully accessed the AMMS system and the list of available functions are displayed, 

you are ready to navigate to the AMMS Order Entry screen. 

 

4. The AMMS function menu should appear: 
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5. Click on Orders to highlight it and then press Open to go to the AMMS Order Entry screen. The 

following screen should appear: 

 

 
 

6. You are now ready to begin placing orders in the AMMS Order Entry form 
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Task 2: Entering AMMS Orders Using the SAP Financial String 
 

There are two methods of entering orders for a customer in the AMMS Order Entry form: 

 

3. Enter a active Customer Number  

4. Enter in the full SAP financial string 

 

This section discusses how to enter an order for a new customer by specifying the SAP Financial String 

information. The SAP Financial String consists of the Fund, WBS, Cost Center, Internal Order, and 

optionally the Reservation Document and Reservation Line Number. The Reservation Document and 

Reservation Line Number are required when using a reimbursable or working capital fund. 

 

Note: An “active customer” is an AMMS defined customer who is assigned a valid FY05 or FY06 SAP 

financial string. Customers from previous years or who no longer have funding are marked “inactive” in 

the AMMS system and may not order additional supplies. 
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Step 2A: Entering a Fund 
 

Specifying the Fund 

 

If you know the specific Fund for the customer, then you can enter it directly in the AMMS Order Entry 

form: 

 

5. Enter the specific Fund in Fund field. 

 

 
 

6. If you don‟t know the specific Fund number, click on the drop down button  on the right side of 

the field and a listing of Funds will appear.  
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7. If using the List of Values, scroll down until you see your fund and click on the line to select it.  

To shorten the List of Values, type the first few characters in the Find line before the „%‟. 

 

 
 

8. Click Ok. 

 

9. The Fund number will be accepted and the cursor will move to the WBS field, which is now 

highlighted in yellow.  
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Common Error Messages For Fund Entry 

Invalid Fund Number 
 

1. If the Fund number is not valid, this Order Entry Alert will appear: 

 

 
 

2. Click the OK button and you will be returned to a blank form. 

 

3. If your entry was a typographical error, try again or use the List of Values button as described on 

the previously. 
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Entering the WBS First 
 

1. Trying to enter a WBS without entering a Fund first: 

 

 
 

2. Click OK to clear the alert window and you are returned to the Fund field. 



Page: 1120 of 1264  

Step 2B: Entering the WBS 
 

Not all financial strings require a WBS. If you are using Pool Money from FY2005, a WBS is not required; 

otherwise you will have a WBS as part of your financial string. 

 

If you do not need to enter a WBS number (Pool money and FY2005 or before), proceed to Step 2C 

Entering the Cost Center. 

 

Specifying the WBS 

 

1. Enter the specific WBS in the WBS field. 
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2. If you don‟t know the specific WBS number, click on the drop down button  on the right side 

of the field and a listing of WBSs will appear.  

 

  
 

3. If using the List of Values, scroll down until you see the WBS and click on the line to select it.  To 

shorten the List of Values, type the first few characters in the Find line before the „%‟. 

 

Note: this can be a very long list, it is best to enter at least a part of the WBS number to shorten the 

list. 

 

 
 

4. Click Ok. 
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5. The WBS number will be accepted and the cursor will move to the Cost Center field, which is 

now highlighted in yellow.  
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Common Error Messages for WBS Entry 

 

Invalid WBS Number 
 

1. If you enter a WBS number without using the List of Values and it is not valid, this Order Entry 

Alert will appear:  

 

 

 

2. If you mistyped the WBS number, click the No button in the alert window.  You will be returned 

to a blank WBS field.  You can try re-entering your number or select one from the List of Values. 

 

3. If the you believe you entered a valid WBS, click the Yes button in the alert window and all the 

fields in the form will be cleared.  You will need to resolve this entry with your Resource Analyst. 
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Required WBS Not Specified 
 

1. You did not enter a WBS after entering a 2006 (and beyond) Fund and tried to move the cursor to 

the Cost Center field: 

 

 

 

2. If you skipped past the WBS field by mistake, click the No button in the alert window and you 

will be returned to the WBS field so that you can enter a value. 

 

3. If you meant to enter a Fund for 2005 or before, or believe there is some other problem, click Yes 

and all fields of the form will be cleared.  If it is some other problem, you will need to work with 

your Resource Analyst to resolve it. 
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Step 2C: Entering Cost Center 

Specifying the Cost Center 

 

1. Enter the specific Cost Center in the Cost Center field: 

 

 

 

2. If you don‟t know the specific Cost Center number, click on the drop down button  on the right 

side of the field and a listing of Cost Centers will appear.  
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3. If using the List of Values, scroll down until you see the Cost Center and click on the line to select 

it.  To shorten the List of Values, type the first few characters in the Find line before the „%‟. 

 

Note: this can be a very long list, it is best to enter at least a part of the Cost Center number to shorten 

the list. 

 

 
 

4. Click Ok. 

 

5. The Cost Center number will be accepted and the cursor will move to the Internal Order field, 

which is now highlighted in yellow.  
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Common Error Messages for Cost Center Entry 

 

Invalid Cost Center 
 

1. If you entered a Cost Center value with using the List of Values and it is not valid, this Order 

Entry Alert will appear:  

 

 

 

2. Click the OK button in the alert window and you will be returned to a blank Cost Center field.  If 

you believe the Cost Center you entered is valid, contact your Resource Analyst to resolve. 
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No Cost Center Specified 
 

1. You moved the cursor to the Internal Order field without entering a Cost Center value: 

 

 

 

2. If you skipped the field by mistake, click the No button in the alert window.  You will be returned 

to the Cost Center field and you can enter a value. 

 

3. If there is some other problem, click the Yes button in the alert window.  Contact your Resource 

Analyst to resolve the matter. 
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Step 2D: Enter Internal Order 
 

Specify an Internal Order 

 

1. Enter the specific Internal Order in the Internal Order field: 

 

 

 

2. If you don‟t know the specific Internal Order number, click on the drop down button  on the 

right side of the field and a listing of Internal Orders will appear.  
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3. If using the List of Values, scroll down until you see your Internal Order and click on the line to 

select it, then click the OK button.  To shorten the List of Values, type the first few characters in 

the Find line before the „%‟.  

 

 
 

4. Click Ok. 

 



Page: 1131 of 1264  

5. The Internal Order number will be accepted. 

 

If a non-reimbursable fund has been entered in this string, the Customer Search button will 

become active.  For non-reimbursable funds proceed to Step 2G. 

 

If a reimbursable fund has been entered, the cursor will move to the Res Doc field.   

For reimbursable funds, proceed to Step 2E Enter Reservation Document 
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Common Errors for Internal Order Entry 

Internal Order Not Specified 
 

1. You moved the cursor to the Res Doc field without entering an Internal Order value: 

 

 
 

2. If you skipped the field by mistake, click the No button in the alert window and you will be 

returned to the Internal Order field. 

 

3. Otherwise, click the Yes button and all of the form fields will be cleared. 
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Step 2E: Entering Reservation Document Number 
 

If the Fund associated with your Financial String is a reimbursable or working capital fund, AMMS 

requires you to enter a Reservation Document and Line Number. Only Reservation Document and Line 

information that is valid for the Fund and WBS values associated with that Financial String can be entered 

into the Res Doc and Res Line fields. 

 

If the Fund number you entered is not reimbursable, see Task 3: Specifying the Ship To Information. 

 

Specifying the Reservation Document Number 

 

12. If you know the correct Reservation Document Number, you can enter a value directly in the Res 

Doc field or click on the List of Values (LOV) button  on the right side of the field to get a List 

of Values valid for that Financial String. 

 

 
 

13. If you use the List of Values button, highlight the Reservation Document Number you want and 

click the OK button. 

 

If a value automatically loaded into the field when you clicked the LOV button, it means there is 

only one valid Reservation Document Number in the List of Values. 
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14. The selected Reservation Document number will load into the field and the Reservation Line 

(Res Line) field will highlight in yellow 
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Common Error Messages for Reservation Document Entry 

 

Invalid Reservation Document Number Entered 
 

1. If the Reservation Document is not valid, this Order Entry Alert will appear: 

 

 

 

2. Click the OK button in the alert window and you will be returned to the Res Doc field. If you 

mistyped the Reservation Document number can enter the value again or click on the List of 

Values button. 
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Skipped the Reservation Document Field 
 

1. If you moved the cursor to the Res Line field without entering a value in the Res Doc field, this 

alert will appear: 

 

 
 

Click the OK button in the alert window and you will be returned to the Res Doc field.  You can enter a 

value or select one using the List of Values button. 
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Step 2F: Entering Reservation Line Number 
 

Specifying The Reservation Line Number 

 

1. If you know the correct Reservation Line Number, you can enter a value directly in the Res Line 

field or click on the List of Values (LOV) button  on the right side of the field to get a List of 

Values valid for that Customer Number. 

 

 
 

2. If you use the List of Values button, highlight the Reservation Line Number you want and click 

the OK button. 

 

 
 

If a value automatically loaded into the field when you clicked the LOV button, it means there is 

only one valid Reservation Line Number in the List of Values. 
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3. The selected Reservation Line Number will load into the field. 
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Common Error Messages for Reservation Line Entry 

 

Invalid Reservation Line Number Entered 
 

1. You entered a value in the field that does not match a valid Reservation Line number: 

 

 
 

2. Click the OK button in the alert window and you will be returned to the Res Line field.  You can 

re-enter a value or select on from the List of Values. 
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Invalid Reservation Line Number 
 

1. You entered three-digit value for RES LINE and get this error: 

 

 
 

2. If you mistyped, click the No button in the alert window and you will be returned to the Res Line 

field to re-enter a value or select a one from the List of Values. 

 

3. If you click the Yes button in the alert window, all fields of the form will be cleared.  If you 

believe the value you entered is correct, contact your Resource Analyst to resolve. 
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No Reservation Document Number Specified 
 

1. You moved the cursor to the WON field or clicked the Customer Search button before entering a 

value in Res Line: 

 

 
 

2. Click the OK button in the alert window, and you will be returned to the Res Line field. Enter a 

value or select one from the List of Values. 
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Step 2G: Processing the Financial String Selection 
 

1. At this point you have entered all required fund string data. Click the Customer Search button.  

If this is the first time this customer financial information is being used in AMMS, you will need 

to “create” a customer. Oracle will ask if the entered information is correct and whether to create a 

customer. Select Yes if correct or No if incorrect.  

 

WARNING: If you select No, this will clear the form. 

 

2. The Order Entry Alert window will open asking if the information entered is correct. 

 

 
 

3. Click the Yes button in the alert window if the information you entered is correct.  Behind the 

scenes Oracle will create a customer. 

 

If the information you entered is not correct, click the No button in the alert window.  This will 

clear all fields in the form and you can start over. 
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4. If you selected Yes, you will be prompted to enter an address. See section Task 3 Updating the 

Ship To Information on how to add a address for this customer 
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Task 3: Adding the Ship To Information  
 

Since you are adding a new customer to AMMS, you will need to add a new shipping contact for this 

Customer Number: 

 

2. Fill in the blanks, customers first and last name, building, room, code, facility/center, city, state 

and zip code. Once you have completed this click in the Stock Number field and the address 

field will become gray. 

 

WARNING: When specifying your building, room and code, do not add the words “building”, “room” or 

“code” in front of the number. For example, Building 16W should only be specified as 16W in the 

Building field. Adding any additional words to the address field may cause AMMS to not process your 

order delaying the receipt of materials to your customer. 
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Task 4: Item Search 

Step 4A: Selecting Your Organization 
 

In order to begin adding stock items to your order, you first select your organization. 

 

3. Click the „Radio Button‟ beside your NASA Organization ID 
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Step 4B: Enter Item Number 
 

To begin ordering items for your customer, you must now specify the item stock number. 

 

3. In the Item Search area, enter the Item Number in the Stock Number field, and then click on the 

Item/Part/Desc button. 
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Task 5: Entering Line Item Information 

Step 5A:  Updating the Line Item Quantity  
 

By default, the quantity will of each line item ordered defaults to 1. If you want to order more than one of 

this item, you can you can change the quantity. 

 

4. Click in the Quantity field for the line item. 
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5. It will turn yellow. 
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6. Update the quantity for that item and then click back in the Stock Number field to add a new line 

item. 
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Task 6: Saving Your Order 

5. Once you have entered all of your lines on the order click on the Yellow Diskette  on the tool 

bar, this is the Save button.  This will save your order, give you an order number and ask if you 

would like to print your order.   
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6. You will receive an OE Print Alert window, telling you your order has been submitted to AMMS, 

the number of line items, your Order Number, and asking “Would you like to print this order?” 

 

A. If you click “Yes, Print my Order”, you will receive another OE Alert 

 

 

B. If you click “No, Don‟t Print my Order”, you order will still be submitted for processing but not 

be printed. You will have to contact the AMMS Help Desk at 6-2525 to print your order. 
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3. If you click “Yes, Print my Order” you will receive an OE Save and Print Alert,    telling you your 

order has been printed, and to go to View Requests to view your order. 
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4. Click OK to the OE Save and Print Alert, your form will go blank.  From the Toolbar select View, 

then select Requests 
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5. The Find Requests window will appear, make sure the “All my Requests” is selected, click on the 

Find Button 
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6. You are looking for the AMMS Customer Order Report. To the right on each line, you will see your 

Customer Number, AMMS Number and your name. Make sure that the line indicator is on the line you 

want to print, if not, click on the order you want to print, click on the View Output button 
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7. Adobe Acrobat will open with the AMMS Customer Order Report for the selected order. 
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8. From this page you can either print your order, or save it to your desktop.  To print the order click 

on the “Print”, to Save the order click “Save a Copy”, and save to your documents.  You can open the 

saved order at anytime to print it. 
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Summary of Changes 
 

This training document will walk you through the process of entering an order in the AMMS Order Entry 

form when using the SAP Financial String information (Fund, WBS, Cost Center and Internal Order) 

 

For the 2008 Fiscal Year, several changes were required for the AMMS Order Entry System. These 

changes include: 

 

 All orders now require funds validation at the Funded Program level to ensure funds are in the 

Inventory Pool before orders are placed in AMMS, and to ensure there are sufficient funds 

available when the order is submitted.   

 In order to check funds availability, the Customer Number field is no longer available. Users must 

input the financial string fields (Fund, WBS, Cost Center, and Internal Order) for each order. 

 A Save function allows users to start an order, save the order, modify the order, and submit the 

order at a different time.  

 All users of AMMS are required to have the AMMS authorization form on file before being able 

to use AMMS in FY 2008. This form provides the AMMS user with authorization to use the 

AMMS application and to use the specified Funded Programs. 

 The new “Requested For” field, allows AMMS users to specify who they are placing the order for. 

 New and enhanced informational alerts and error messages for fields and functions have been 

added to AMMS. 
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Task 1: Accessing the AMMS Order Entry System 
 

This section will describe how to access the AMMS Oracle system and log in using your AMMS userid 

and password. If you are not currently enrolled as an AMMS user, you must contact AMMS Helpdesk at 

301-286-2525 or send an e-mail to Tabatha Luskey at Tabatha.L.Luskey.1@gsfc nasa.gov. 

 

More information on the AMMS System is available on the AMMS web site http://amms/ 

Step 1A: Access the AMMS System Web Site 
 

 

7. From your web browser, enter the following URL to access the AMMS system: 

 

http://amms.gsfc nasa.gov 

 

Click on “AMMS Order Entry Login”, click OK on the government warning box then 

following screen should appear: 
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8. Enter your AMMS userid and password in the fields on the screen and then click on the Connect 
button. Note, your password will not display in text but will display as asterisks (*). 
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9. The AMMS Function menu will appear: 
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Step 1B: Navigating to the AMMS Order Entry Screen 
 

Once you have successfully accessed the AMMS system and the list of available functions are displayed, 

you are ready to navigate to the AMMS Order Entry screen. 

 

7. The AMMS function menu should appear: 
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8. Click on Orders to highlight it and then press Open to go to the AMMS Order Entry screen. The 

following screen should appear: 

 

 
 

9. You are now ready to begin placing orders in the AMMS Order Entry form 
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Task 2: Entering AMMS Orders Using the SAP Financial String 
 

The SAP Financial String consists of the Fund, WBS, Cost Center and Internal Order.   

 

 

Note: An “active customer” is an AMMS defined customer who is assigned a valid FY07 or FY08 SAP 

financial string. Customers from previous years or who no longer have funding are marked “inactive” in 

the AMMS system and may not order additional supplies. 
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Step 2A: Entering a Fund 
 

Specifying the Fund 

 

If you know the specific Fund for the customer, then you can enter it directly in the AMMS Order Entry 

form: 

 

10. Enter the specific Fund in Fund field. 

 

 
 

11. If you don‟t know the specific Fund number, click on the drop down button  on the right side of 

the field and a listing of Funds will appear.  
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12. If using the List of Values, scroll down until you see your fund and click on the line to select it.  

To shorten the List of Values, type the first few characters in the Find line before the „%‟. 

 

 
 

13. Click Ok. 

 

14. The Fund number will be accepted and the cursor will move to the WBS field, which is now 

highlighted in yellow.  
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Common Error Messages For Fund Entry 

Invalid Fund Number 
 

4. If the Fund number is not valid, this Order Entry Alert will appear: 

 

 
 

5. Click the OK button and you will be returned to a blank form. 

 

6. If your entry was a typographical error, try again or use the List of Values button as described on 

the previously. 
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Entering the WBS First 
 

3. Trying to enter a WBS without entering a Fund first: 

 

 
 

4. Click OK to clear the alert window and you are returned to the Fund field. 
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Step 2B: Entering the WBS 
 

Not all financial strings require a WBS. If you are using Pool Money from FY2005, a WBS is not required; 

otherwise you will have a WBS as part of your financial string. 

 

If you do not need to enter a WBS number (Pool money and FY2005 or before), proceed to Step 2C 

Entering the Cost Center. 

 

Specifying the WBS 

 

6. Enter the specific WBS in the WBS field. 
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7. If you don‟t know the specific WBS number, click on the drop down button  on the right side 

of the field and a listing of WBSs will appear.  

 

  
 

8. If using the List of Values, scroll down until you see the WBS and click on the line to select it.  To 

shorten the List of Values, type the first few characters in the Find line before the „%‟. 

 

Note: this can be a very long list, it is best to enter at least a part of the WBS number to shorten the 

list. 

 

 
 

9. Click Ok. 
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10. The WBS number will be accepted and the cursor will move to the Cost Center field, which is 

now highlighted in yellow.  

 

 

 



AMMS Order Entry User Training 

 Page: 1181 of 1264   

  

Common Error Messages for WBS Entry 

 

Invalid WBS Number 
 

4. If you enter a WBS number without using the List of Values and it is not valid, this Order Entry 

Alert will appear:  

 

 

 

5. If you mistyped the WBS number, click the No button in the alert window.  You will be returned 

to a blank WBS field.  You can try re-entering your number or select one from the List of Values. 

 

6. If the you believe you entered a valid WBS, click the Yes button in the alert window and all the 

fields in the form will be cleared.  You will need to resolve this entry with your Resource Analyst. 
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Required WBS Not Specified 
 

4. You did not enter a WBS after entering a 2006 (and beyond) Fund and tried to move the cursor to 

the Cost Center field: 

 

 
 

5. If you skipped past the WBS field by mistake, click the No button in the alert window and you 

will be returned to the WBS field so that you can enter a value. 

 

6. If you meant to enter a Fund for 2005 or before, or believe there is some other problem, click Yes 

and all fields of the form will be cleared.  If it is some other problem, you will need to work with 

your Resource Analyst to resolve it. 
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Step 2C: Entering Cost Center 

Specifying the Cost Center 

 

6. Enter the specific Cost Center in the Cost Center field: 

 

 
 

7. If you don‟t know the specific Cost Center number, click on the drop down button  on the right 

side of the field and a listing of Cost Centers will appear.  
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8. If using the List of Values, scroll down until you see the Cost Center and click on the line to select 

it.  To shorten the List of Values, type the first few characters in the Find line before the „%‟. 

 

Note: this can be a very long list, it is best to enter at least a part of the Cost Center number to shorten 

the list. 

 

 
 

9. Click Ok. 
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10. The Cost Center number will be accepted and the cursor will move to the Internal Order field, 

which is now highlighted in yellow.  
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Common Error Messages for Cost Center Entry 

 

Invalid Cost Center 
 

3. If you entered a Cost Center value with using the List of Values and it is not valid, this Order 

Entry Alert will appear:  

 

 

 

4. Click the OK button in the alert window and you will be returned to a blank Cost Center field.  If 

you believe the Cost Center you entered is valid, contact your Resource Analyst to resolve. 
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No Cost Center Specified 
 

4. You moved the cursor to the Internal Order field without entering a Cost Center value: 

 

 

 

5. If you skipped the field by mistake, click the No button in the alert window.  You will be returned 

to the Cost Center field and you can enter a value. 

 

6. If there is some other problem, click the Yes button in the alert window.  Contact your Resource 

Analyst to resolve the matter. 
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Step 2D: Enter Internal Order 
 

Specify an Internal Order 

 

6. Enter the specific Internal Order in the Internal Order field: 

 

 
 

7. If you don‟t know the specific Internal Order number, click on the drop down button  on the 

right side of the field and a listing of Internal Orders will appear.  
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8. If using the List of Values, scroll down until you see your Internal Order and click on the line to 

select it, then click the OK button.  To shorten the List of Values, type the first few characters in 

the Find line before the „%‟.  

 

 
 

9. Click Ok. The Internal Order number will be accepted. 
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Common Errors for Internal Order Entry 

Internal Order Not Specified 
 

4. You moved the cursor to the Requested For field without entering an Internal Order value: 

 

 
 

5. If you skipped the field by mistake, click the No button in the alert window and you will be 

returned to the Internal Order field. 

 

6. Otherwise, click the Yes button and all of the form fields will be cleared. 

 

7. At this point you can enter information in the Requested For field.  This will allow you to know 

who the original requestor was for the items being ordered.  
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  Step 2E: Processing the Financial String Selection 
 

5. At this point you have entered all required fund string data. Click the Verify Funds button.  This 

is where the first funds verification will occur.  If sufficient funds are available and  this is the first 

time this customer financial information is being used in AMMS, you will need to “create” a 

customer. Oracle will ask if the entered information is correct and whether to create a customer. 

Select Yes if correct or No if incorrect.  

 

WARNING: If you select No, this will clear the form. 

 

6. The Order Entry Alert window will open asking if the information entered is correct. 

 

 
 

7. Click the Yes button in the alert window if the information you entered is correct.  Behind the 

scenes Oracle will create a customer. 

 

If the information you entered is not correct, click the No button in the alert window.  This will 

clear all fields in the form and you can start over. 
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8. If you selected Yes, you will be prompted to enter an address. See section Task 3 Updating the 

Ship To Information on how to add a address for this customer 
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Step 2F: Insufficient Funds Message 
 
After you have entered all of the financial information and click on the Verify Funds button, if there are no 

funds available in the Inventory Pool for the specific Funded Program the following message will appear: 

 

 
 

You will have to contact your Resource Analyst for resolution.  The Resource Analyst will have to do a 

funds transfer into the Inventory Pool in Funds Control. 
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Task 3: Adding the Ship To Information  
 

Since you are adding a new customer to AMMS, you will need to add a new shipping contact for this 

financial string. Click Yes to the message “do you want to enter an new address for this customer” 
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3. Fill in the blanks, customers first and last name, building, room, code, facility/center, city, state 

and zip code. Once you have completed this click in the Stock Number field and the address 

field will become gray. 

 

WARNING: When specifying your building, room and code, do not add the words “building”, “room” or 

“code” in front of the number. For example, Building 16W should only be specified as 16W in the 

Building field. Adding any additional words to the address field may cause AMMS to not process your 

order delaying the receipt of materials to your customer. 
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Task 4: Item Search 

Step 4A: Selecting Your Organization 
 

In order to begin adding stock items to your order, you first select your organization. 

 

5. Click the „Radio Button‟ beside your NASA Organization ID 
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6. The selected NASA Organization ID will be selected and all other options are inactivated. 

 

 



AMMS Order Entry User Training 

 Page: 1198 of 1264   

  

Step 4B: Enter Item Number 
 

To begin ordering items for your customer, you must now specify the item stock number. 

 

5. In the Item Search area, enter the Item Number in the Stock Number field, and then click on the 

Item/Part/Desc button. 
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6. Data will appear in the Line Item Information section. 
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Task 5: Entering Line Item Information 

Step 5A:  Updating the Line Item Quantity  
 

By default, the quantity will of each line item ordered defaults to 1. If you want to order more than one of 

this item, you can you can change the quantity. 

 

7. Click in the Quantity field for the line item. 
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8. It will turn yellow. 
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9. Update the quantity for that item and then click back in the Stock Number field to add a new line 

item. 
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Step 5B: Entering Additional Order Lines  
 

You can add up to 99 lines to one order just repeat the steps where you enter the item number, remember to 

update the quantities if needed.  

 

All items will be in the Line Item Information section, verify that your quantities are correct. 
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TASK 6: Submitting Your Order 

Step 6A: Submitting Your Order with Sufficient Funds 
7. Once you have entered all of your lines on the order click on the Submit Order button this is will 

be the second funds validation to make sure sufficient funds are available to cover the order.  If 

sufficient funds are available submit your order, give you an order number and ask if you would 

like to print your order.   
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8. You will receive an OE Print Alert window, telling you your order has been submitted to AMMS, 

the number of line items.  

 

 
 

Click OK to for the print function. 
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3. Printing your order: 

 

A. If you click “Yes, Print my Order”, you will receive another OE Alert 

 

 

B. If you click “No, Don‟t Print my Order”, you order will still be submitted for processing but not 

be printed. You will have to contact the AMMS Help Desk at 6-2525 to print your order. 
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3. If you click “Yes, Print my Order” you will receive an OE Save and Print Alert,    telling you your 

order has been printed, and to go to View Requests to view your order. 
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4. Click OK to the OE Save and Print Alert, your form will go blank.  From the Toolbar select View, 

and then select Requests 
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5. The Find Requests window will appear, make sure the “All my Requests” is selected, and click on 

the Find Button 
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6. You are looking for the AMMS Customer Order Report. To the right on each line, you will see your 

Customer Number, AMMS Number and your name. Make sure that the line indicator is on the line you 

want to print, if not, click on the order you want to print, click on the View Output button 
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7. Adobe Acrobat will open with the AMMS Customer Order Report for the selected order. 
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8. From this page you can either print your order, or save it to your desktop.  To print the order click 

on the “Print”, to Save the order click “Save a Copy”, and save to your documents.  You can open the 

saved order at anytime to print it. 
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Step 6B: Submitting Your Order with insufficient funds 
 

 

  

1. If after you have entered all of your items you want to order and you click on   

Submit button and you receive this message: 
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There is not enough money in the Inventory Pool to cover your order.  You need to contact 

your Resource Analyst.  You now have the ability to Save your order to refer back to once the 

funds transfer has been completed.  Click Yes to the “Save this Order?” 
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2. Your order is now saved and can be queried at a later date.  You will need to know your 

AMMS Order Number to query your saved orders. 
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3. You also have the ability to print your saved orders: 

 

 
 

Follow the printing instructions from above. 
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Task 7: Query a Saved Order 
 
Once your Resource Analyst resolves the funds issue you can query your saved order and submit it.   

 

1. Open AMMS and click on the Query Order button: 

 

 
 



AMMS Order Entry User Training 

 Page: 1218 of 1264   

  

2. In the Enter Order Number field enter the number of the order that was saved: 
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3. Click on Find: 
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Your original order will appear.  At this time if sufficient funds are available click on the Submit 

Order button, you will receive your Order Number and be able to print your order: 

 

 
 



AMMS Order Entry User Training 

 Page: 1221 of 1264   

  

AMMS TRAINING SCRIPT 

How HQ Users Use AMMS 

To Place Store Stock Orders 
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The purpose of this training script is to explain how HQ Users are to place orders 
in AMMS 
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HQ Users of AMMS 
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Document Name AMMS HQ Order Entry.doc 
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Task 1: Accessing the HQ AMMS Order Entry System 

 
This section will describe how to access the Advanced Material 

Management System (AMMS) Oracle system and log in using your AMMS 

userid and password.  If you are not currently enrolled as an AMMS user, 

you must contact the AMMS Help Desk at 301-286-2525 or send an e-mail 

to Tabatha Luskey at Tabatha.L.Luskey@nasa.gov. 

 

More information on the AMMS System is available on the AMMS web site 

http://amms.gsfc.nasa.gov 

 

Step 1A: Access the AMMS System Web Site 

 
1. From your web browser, enter the following URL to access the 

AMMS system:  
 

http://amms.gsfc.nasa.gov 
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The following screen should appear: 
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2. Enter your AMMS userid and password in the fields on the screen  

and then click the Connect button. Note, your password will not 

display in text but will display as asterisks (*). 
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3. The AMMS HQ Order Entry Form function menu will appear: 
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Step 1B: Navigating to the AMMS HQ Order Entry Screen 

 
Once you have successfully accessed the AMMS HQ system and the list of 

available functions are displayed, you are ready to navigate to the AMMS HQ 

Order Entry screen. 

 

1. The AMMS HQ Order Entry Form function menu should appear: 
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2. Click on AMMS HQ Order Entry to highlight it and then press the Open 

to go to the AMMS HQ Order Entry screen. The following screen 

should appear: 

 

 
3. You are now ready to begin placing order in the AMMS HQ Order 

Entry form. 
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Task 2: Entering AMMS HQ Orders Using Your Financial 
String 

 
All NASA HQ orders must now be entered into the system using your SAP 

Financial String. The SAP financial string consists of the SAP Fund, WBS, 

Cost Center, and Internal Order numbers assigned to your organization. 

Each year, aspects of the financial string will change and you will be 

notified of the new financial string. 

 

Step 2A: Entering the Financial Information 

 
Each year, you will be given the financial information [Fund, WBS, Cost 

Center and Internal Order] to use for HQ AMMS orders. You will enter 

these numbers directly in the AMMS HQ Order Entry form: 
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Step 2B: Entering Requested For information 

 
You are required to enter information in the Requested For field. This is a 

free-form field that you should use to document who this order is for or any 

other pertinent information you want to remember about the order. 
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Step 2C: Verifying the Financial Information 
 

After you enter the data in the Requested For field, press the Tab key on your 

keyboard to move the cursor to the Verify Funds button (which will then 

become active). Click on the Verify Funds button to validate that you have 

entered the correct financial information for HQ, if there are funds available 

you can proceed with your order 
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Step 2D: If there are insufficient funds 

If there are no funds available for the HQ financial information you will see 

this message.  Please contact the person indicated for assistance. 
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Step 2E: Entering the Shipping Information 

 

Once the Financial Information and it has been verified that there are funds 

available, the Ship To Information block will be populated with the default 

shipping address for this customer number. You must change this address to 

have the material shipped to the correct location.  

 

To do this click on the Ship To button: 
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A list of addresses will appear in the new Ship To Addresses window. In the 

Find field on the Ship To Addresses window, enter your last name with the % 

sign and click on Find, all of the addresses assigned to your name will 

appear. 
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Select the address that you want the material shipped to and then click OK on 

the Ship To Addresses window. 
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If you do not see the correct address, you can add a new shipping address.  

In the Ship To Addresses window click on the Cancel button. You will be asked: 

Do you want to enter a new ship to address for this customer?  Click Yes. 
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The Ship to Fields will be highlighted and will allow you to enter a new 

shipping address for this order. Enter the new Ship To address in these 

fields. 

 

Note: For each new shipping address, you will only have to enter it once; it 

remains in the Ship to database for orders you may place in AMMS. 
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Enter the following Ship to Information.  

 

 First Name – Enter your first name in this field 

 Last Name – Enter your last name in this field 

 Bldg – Enter “HQ” for your building in this field 

 Room – Enter your room number at HQ in this field 

 Code – Enter your HQ Code in this field 

 Facility/Center – Enter “NASA Headquarters” in this field 

 City  - Enter “Washington” for the city 

 State – Enter “DC” as the State 

 Zip Code – Enter your HQ five-digit Zip Code in this field 

 

 
 

Once you have entered the new shipping address, you are ready to begin 

entering the actual store stock items for this order. If you are satisfied with 

the shipping address, tab to or click your mouse in the first field under Stock 

Number. 
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Step 2E: Entering Stock Numbers for Your Order 
 

In the Item Search area, enter the four parts of the Item Number in the Stock 

Number field, and then click on the Item/Part/Desc button. 

 

 
 



AMMS Order Entry User Training 

 Page: 1241 of 1264   

  

Information about item entered will appear in the Line Item Information section. 
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Step 2F: Updating the Line Item Quantity 

 

By default the quantity will for each line item ordered default to 1.  If you 

want to order more than one of this item, you can change the quantity.   

 

Click in the Quantity field for the line item. 
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The Quantity field will turn yellow and allow you to make changes in that 

field. 
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Change the quantity for that item and then click back in the Stock Number 

field in the Item Search area to add another line item. 
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Step 2G: Entering Additional Order lines 

 

You can add up to 99 lines to one order just repeat the steps where you enter 

the item number, remember to update the quantities if needed. 

 

All items will be in the Line Item Information section, verify that your quantities 

are correct. 
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Step 2H: Completing Your Order 

 

One you have entered all of the items for order, you are now ready to begin 

completing your order. At this point you have two choices: 

 

 You can save your order (worksheet) so you can add more line items 

to the order at a later time 

 You can send your order (worksheet) to the Analyst for review and 

actual submission for processing. 

 

 

Note: 

 

Your order is not processed by AMMS until you send your order 
to the Analyst.  

At that time, the AMMS Analyst will be notified that your order is 
ready for review; they will review and approve the order, and 
then submit it to AMMS for processing. Once the order is 
submitted for processing, then it is considered “placed” and will 
be delivered to your desk when Office Depot fulfills the order 
(usually the next day) 
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Saving Your Order 
 

To save your order so that you can go back and add more lines (or to modify 

an existing line item), click on the Save Worksheet button 

 

If there are enough funds to cover the cost of the items you are ordering  

You will receive an alert message saying your order has been saved, the 

order number and the number of lines in your order, and that your order has 

not yet been submitted to AMMS.  

 

Please take note of this order number because you will need it to add future 

lines to the order or to send the order to the analyst. 

 

 
 

 

Click OK to the OE Save Alert box. 

 

You will now receive another AMMS Alert box asking you if you want to 

print your order. To print your order, see Step 2I: Printing Your Order.
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Saving order with Insufficient Funds: 

To save your order so that you can go back and add more lines (or to modify 

an existing line item), click on the Save Worksheet button 

 

If there are not enough funds to cover the cost of the items you are ordering  

You will receive an alert message saying there are insufficient funds with 

contact information, you will still be able to save your order, the order 

number and the number of lines in your order 
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Take note of the order number: 
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Sending the Order to the Analyst 
 
Your other choice is to send the order to the Analyst for review and approval. 

 

To send your order for approval click the Send to Analyst button. This will 

check to make sure there are funds available and if so send the order to one 

of the AMMS Analysts at HQ for review and approval in AMMS so that you 

will receive your suppliers. 

 

You will receive an Order Entry Alert: “Proceeding will LOCK this 

worksheet and send to the Analyst. No re-query or updates will be allowed”.  

 

You can either respond “Yes” to lock this order and send it to the Analyst for 

review or “No” to only save the order. If you respond “No” then, your order 

is only saved and you can modify the order at a later time. If you are sure 

that you do not want to add any more items to the order, click “Yes”  
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When you Click Yes to send the order to the Analyst for approval, you will 

receive an OE Save Alert with your AMMS order number, the number of 

lines saved, and that your order has not yet been submitted to AMMS for 

processing. However, the order has been sent to the Analyst for review. 

 

 
 

You will now receive another AMMS Alert box asking you if you want to 

print your order. To print your order, see Step 2I: Printing Your Order. 
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Sending the Order to the Analyst with Insufficient Funds 

 
Your other choice is to send the order to the Analyst for review and approval. 

 

To send your order for approval click the Send to Analyst button. This will 

check to make sure there are funds available and if there are not funds 

available you will get an alert message with who to contact. 

You will still have the option to save the order requery and submit when 

funds are made available: 
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Saving order with Insufficient Funds, click yes and take note of your order 

number 
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Step 2I: Printing Your Order 

 

After you have either decided to save your order or to submit your order to 

the Analyst, you will be provided another alert box asking if you want to 

print your order. Although the alert box says “print”, AMMS is actually 

making an Adobe Acrobat PDF copy of your order so that you can either 

print your order on your workstation‟s printer or you can save the PDF file 

for later reference. 

 

 
 

If you click “Yes Print My Order” your order will be made available for you as 

an Adobe Acrobat PDF file. If you click „No Don’t Print my order” your order 

will still be saved but will not be printed. 

 

 

Note: It is strongly suggested that you print your order for later reference. It 

contains your order number as well as a listing of every item that you placed 

on this order. 
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If you click “Yes, Print my Order” you will receive an OE Save and Print Alert, 

telling you your order has been printed, and to go to View Requests to view 

your order 
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Click OK to the OE Save and Print Alert, the HQ AMMS Order Entry form will clear.  

Close the HQ AMMS Order Entry Form, then from the toolbar select View and 

then select Requests 
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The Find Requests window will appear, make sure that All My Requests is 

selected, and click on the Find Button. 
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A list of all of your requests will now display.  

 

 
 

You are looking for the AMMS Customer Order Report.  To the right on each line 

(under the Parameters column), you will see your Customer Number and the 

AMMS Order Number. Make sure that the line indicator (far left column is 

blue) is on the line you want to print; if not click on the order you want to 

print. To view the PDF version of your order, click on the View Output button. 
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A new window will appear and Adobe Acrobat will open with the AMMS 

Customer Order Report for your order. 
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From this window, you can either print your order or save it to your workstation as a PDF 

file..  

 

 To print the order click on the printer icon on the toolbar.  

 

 To save the order to your workstation, click on the floppy disk icon on 

the toolbar and save your document. Once the document has been 

saved to your workstation, you can open the order at anytime to 

review it or to print it. 
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Step 2J: Querying A Saved Order  

 

Once you are ready to add more lines to your order and send the order to the 

analyst for review, you will need to query your saved order and complete the 

order processing. 

 

Open HQ AMMS Order Entry Form and click the Query Worksheet Button 
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In the Enter Order Number field, enter the number of the order that was saved. 
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Click on Find 
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You original order will appear. At this time you can add more items to the 

order or make changes to the existing items on the order. 

 

 
 

To add a new line item to the order, you need to enter a new stock number in 

the Item Search fields like you did to add the original line items in section 
Step 2E: Entering Stock Numbers for Your Order 
 

To change the quantity of an item in your order, follow the instructions 

outlined in the section. Step 2F: Updating the Line Item Quantity 

 

To delete a line item from your order, click in the quantity field of the line 

you want to remove from the order. Then click on the Delete icon  on the 

toolbar.  
 




